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Введение 
 

Об этой книге 

За последнее десятилетие рынок издательских, печатных и дизайнерских услуг 

претерпел существенные изменения. Они связаны, в первую очередь, с совершен-

ствованием систем хранения, отображения и передачи данных, развитием сложных 

цифровых технологий. Однако стоит понимать, что данный скачок не был беспри-

чинным, а явился лишь реакцией на все возрастающие потребности людей в ско-

рейшем получении качественной и проверенной информации в различных фор-

мах — текстовой, звуковой, анимационной и пр. Различные виды данной информа-

ции, объединенные в один поток, стало принято называть контентом. Именно это 

структурное изменение формы представления информации, трансформация про-

стого текста, как основы передачи данных, в целый спектр мультимедийных  

возможностей в настоящее время формирует новый рынок цифровых публи- 

каций. 

Программный пакет Adobe InDesign CS6 занимает на сегодняшний день лидирую-

щие позиции на рынке дизайнерских продуктов, предназначенных для разработки 

макетов печатной и электронной продукции для нужд издательского бизнеса. На-

бор базовых функций данного пакета обеспечивает дизайнера не только всеми не-

обходимыми инструментами для обработки больших массивов текста и внедрения 

в него иллюстраций, но и, в последних версиях, поддерживает возможности ис-

пользования в работе таких новых типов данных, как аудио- и видеофайлы, анима-

ция, панорамные изображения и многие другие. Это делает его незаменимым инст-

рументом при разработке макетов интерактивных публикаций. 

В данной книге простым и доступным способом с помощью большого количества 

примеров и иллюстраций описывается процесс разработки макетов электронных 

публикаций (от момента создания файла до процесса распространения готового 

проекта в сети Интернет либо его использования на специализированных устрой- 

ствах). 

ПРИМЕЧАНИЕ 

В приложении приводится описание электронного архива тех дополнительных мате-
риалов, которые потребуются для работы с книгой. 

Вы познакомитесь с целым спектром возможных процессов, включающим подго-

товку материалов для экспорта в интерактивный PDF-документ, Flash-фильм, ePub, 

DPS (о DPS читайте далее), и сможете в дальнейшем выбирать, какую из техноло-
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гий и для каких целей применять. Ряд практических заданий для выполнения по-

зволит вам в дальнейшем самостоятельно генерировать электронные публикации 

любой сложности, в том числе для мобильных устройств (на основе операционных 

систем iOS, Android и Blackberry PlayBook OS). 

ПРИМЕЧАНИЕ 

ePub (Electronic Publication) — открытый формат электронных версий книг, разрабо-
танный Международным форумом по цифровым публикациям IDPF (International 
Digital Publishing Forum). 

Теоретические основы подготовки макетов 
электронных публикаций 

Развитие основ передачи информации происходило у человечества постепенно и 
плавно. Сначала мифы и легенды передавались из поколения в поколение в вер-

бальной, т. е. словесной форме. С ростом количества накопленной и необходимой 
для передачи информации, методы и средства, конечно, требовали развития, и че-

ловечество постепенно изобретало живопись, письмо, скульптуру; одновременно 
совершенствовались материалы, на которые данная информация переносилась: от 

стен древних пещер через папирус и бересту к изобретению бумаги и т. д. Одним 
из краеугольных камней развития систем сохранения и трансляции человеческих 

знаний стало изобретение Гуттенбергом в 1440 году процесса книгопечатания, ко-
торый стал на пять с лишним веков основным методом хранения и распростране-

ния информации среди людей, а чтение — основным средством получения данных 

знаний. Книги стали не только инструментом тиражирования информации, но и 
сформировали новый пласт культуры, стали источником духовного и морального 

обогащения человека. Дальнейшее развитие типографских и полиграфических тех-
нологий позволило создавать и прочие средства информатизации — газеты, журна-

лы, альманахи и др. 

Следующим шагом в развитии этого процесса стало изобретение возможности 
цветной печати, что открыло новые горизонты — передачу полноцветных фото-

графий, рисунков, схем, картин. Это дало возможность существенно расширить 
виды представления данных и упростить процесс восприятия человеческим мозгом 

информации. 

В начале XX века появились радио и телевидение, кинематограф. Для хранения 
информации этих типов позже начали использоваться магнитные и оптические но-

сители. Модель передачи информации вновь претерпела революцию. Тем не менее, 
книги остались все так же актуальны, да к тому же приобрели несколько новейших 

областей, о которых появилась необходимость хранить и передавать информацию. 
Одновременно с этим, стремительно шел процесс развития журнальной и газетной 

публицистики, создавалось все больше и больше специализированных и общеин-
формационных изданий. 

С появлением в конце 80-х годов персональных компьютеров и широким их рас-
пространением, а также постепенным внедрением Интернета и связанных с ним 
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технологий, вновь произошла информационная революция. На этот раз, одна из 
самых масштабных. Техника хранения и передачи информации, как в текстовом, 
так и во многих других форматах, стала более универсальной и позволила получить 
доступ к информации огромному количеству людей одновременно. 

В тот период многие начинали пророчить книжной индустрии скорый закат. Спе-
циалисты приводили доводы о том, что изобретение сети Интернет сделает произ-
водство книг ненужным и, как любая рудиментарная технология, она скоро завер-
шит свое существование, оставаясь лишь уделом узкого круга коллекционеров или 
любителей. Однако рынок и в этот раз повел себя по-другому. Скептики не учли 
один немаловажный нюанс. Книга чаще всего используется человеком в моменты 
времени, когда он параллельно производит какое-либо действие, не требующее его 
внимания. Скажем, в дороге либо на отдыхе. Чтение информации с экрана компью-
тера в данном случае либо невозможно, либо связано с огромным количеством 
сложностей. Даже в случае с использованием ноутбука, заряда батареи хватит,  
в большинстве случаев, максимум на 3 часа чтения. Немаловажное значение сыгра-
ло также приятное тактильное ощущение, которое человек испытывает при чтении. 
Эти особенности стали причиной того, что книги и другие публикации на бумаж-
ных носителях вновь пережили очередной информационный "переворот" и укрепи-
ли свои позиции, продолжая развиваться в новых областях. То же произошло и 
с журналами, газетами и прочими видами изданий. 

Сегодня мы можем наблюдать новую революцию в развитии способов хранения и 
передачи информации. Она связана с появлением новых планшетных цифровых 
устройств и персональных цифровых книг на основе электронных чернил. Давайте 
остановимся на этом моменте немного подробней, исследуем историю появления 
данного вида устройств, попытаемся заглянуть в будущее и понять, каким образом 
эта тихая революция, разворачивающаяся у нас на глазах, повлияет на ход инфор-
мационной истории человечества. 

История развития мобильных электронных устройств 

Если обратиться к истории, первые попытки создать подобие современных план-
шетных компьютеров были предприняты в 1960-х годах после появления в сериале 
"Звездный путь" концепта устройства PADD (Personal Access Display Device). Через 
некоторое время после этого, в 1968 году, в киноромане Стенли Кубрика "2001: 
Космическая одиссея" появилось устройство newspad, описанное им как будущее 
развитие и альтернатива привычным телевидению и газетам. В том же году Аланом 
Кеем была предложена концепция устройства для обучения Dynabook, в котором 
были воплощены идеи графического интерфейса взаимодействия с пользователем. 
В 1987 году компания Apple представляет концепцию электронного секретаря в 
виде планшетного компьютера Knowledge Navigator. 

Одновременно с этим, некоторыми компаниями были проведены попытки создания 
не просто планшетных устройств, а специализированных устройств для чтения. Так 
компанией DEC в 1996 году было представлено устройство Lectrice. Это был не-
большой планшетный компьютер с сенсорным черно-белым дисплеем. Большой 
популярности данное устройство не нашло в силу его завышенной стоимости. Поз-
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же, в 1998 году, компании NuvoMedia и Softbook попытались вновь внедрить по-
добные устройства, и вновь безуспешно, и снова по той же причине — слишком 
высокая стоимость. Их устройства, как и предшественник, не нашли популярности 
у клиентов, хотя продолжали выпускаться вплоть до 2006 года. 

Рывком для развития обеих ветвей планшетных технологий стал 2007 год, когда 
были представлены сразу же две удивительных технологии от двух крупных игро-
ков компьютерного рынка — компании Sony и Apple. Первая стала катализатором 
резкого подъема рынка электронных книг в связи с появлением экранов с техноло-
гией электронной бумаги. Вторая же представила на конференции MacWorld Expo 
9 января 2007 года карманный компьютер или смартфон iPhone. Позже, в 2010 году 
важно отметить два события, ставшие некоей эволюцией прошлых — презентация 
27 января компанией Apple интернет-планшета iPad и факт опережения продаж 
электронных книг над их бумажными аналогами. Дальнейшее развитие технологий 
на сегодняшний день представляет собой постоянное укрепление позиций план-
шетных устройств, т. е. количественный рост после качественного скачка, произве-
денного в 2007 году. 

В истории развития данных технологий четко прослеживается две принципиальные 
тенденции. Первая заключается в том, что с каждым новым этапом эволюции мо-
бильных устройств основной упор делался на облегчение восприятия и прирост 
различных форм представления информации, что являлось удовлетворением соот-
ветствующих требований рынка. Вторая основная тенденция сводится к тому, что с 
момента начала истории происходит экспоненциальное ускорение процесса ин-
форматизации человечества. Что это значит? С момента начала развития техноло-
гий в XV веке после книгопечатания, следующий знаковый этап в развитии настал 
только лишь в начале XX века, после чего скорость развития начала стремительно 
увеличиваться, и в XX веке мы можем проследить как минимум 3 революционных 
момента, а за первое десятилетие XXI века уже произошла как минимум одна ин-
формационная революция! Что ждет нас в ближайшие годы, предположить доста-
точно трудно, как и то, переживут ли классические бумажные книги текущий пере-
ворот в мобильной индустрии. Последние показатели крупнейших книжных про-
давцов показывают, что издательский мир, каким мы его привыкли видеть, скоро 
прекратит свое существование. Продажи электронных книг и изданий уже превы-
шают бумажные носители в полтора раза. Подрастает поколение, с рождения при-
выкшее черпать информацию из электронных источников. Возможно, мы с вами 
наблюдаем закат великой эпохи бумажных книг, и в ближайшие десятилетия они 
станут только предметом коллекций или будут выпускаться лишь как произведение 
искусства, перестав быть обыденным предметом в нашем обиходе. Кто знает... 

Все эти факторы вынуждают издательский рынок подстраиваться и создавать но-
вейшие бизнес-стратегии, основанные на электронных публикациях. 

Сравнение электронных публикаций  
и бумажных изданий 

Проводить сравнение бумажных и электронных изданий достаточно неблагодарное 

занятие. Оно напоминает рассуждения об отличии театра и кинематографа или ав-
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томобилей и лошадей. В этих ситуациях из прошлого люди тоже пытались сравни-

вать данные вещи как новые и старые технологии. Скажем, автомобиль гораздо бы-

стрее лошади, но при этом существуют места и ситуации, куда и когда автомобилю 

будет просто невозможно попасть. Точно так же и с электронными изданиями и  

бумажными книгами. В электронном виде ряд книг просто не сможет быть издан 

из-за некоторых особенностей, скажем детские книжки-игрушки, либо книги для 

людей с ограниченными способностями, написанные шрифтом Брайля. 

ПРИМЕЧАНИЕ 

Шрифт Брайля — рельефно-точечный тактильный шрифт, предназначенный для 

письма и чтения слепыми людьми. Он был разработан в 1821 году французом Луи 

Брайлем. 

Сравнение кино и театров также является абсолютно бессмысленным. В театраль-

ных спектаклях куда большее значение придается чувствам и эмоциям, испыты-

ваемым человеком, в то время как кинематограф передает больше действий и сю-

жетных линий, может гораздо глубже погрузить человека в атмосферу показывае-

мого за счет многообразия декораций. Та же ситуация происходит и с книгами, 

когда пользователи электронных книг не могут получить от них те кинестетические 

ощущения, как при чтении бумажных вариантов, не могут ощутить запахи и непе-

редаваемое чувство старины при взаимодействии с раритетными изданиями. В це-

лом, в этом и заключается основное отличие данных миров, а более детальный ана-

лиз мы проведем уже в следующих главах этой книги. 
 

Определение  
и особенности электронных публикаций 

Итак, что же такое электронная публикация? По сути, это версия бумажной книги 

либо любого другого произведения, хранение которой осуществляется в электрон-

ном виде, т. е. с помощью цифровых данных. Электронная публикация может быть 

создана несколькими способами. Во-первых, с помощью сканирования готового 

бумажного издания. Во-вторых, с нуля с помощью компьютера. Для электронных 

публикаций свойственны такие признаки, как интерактивность, масштабируемость, 

высокий уровень медианаполненности и пр. Они могут быть представлены в раз-

личных форматах. 
 

Методика сравнения  
форматов электронных публикаций 

Чтобы разобраться в их особенностях электронных публикаций и оценить преиму-

щества и недостатки каждого из форматов, в которых они могут храниться, сфор-

мулируем ряд требований, которые необходимо к ним предъявлять. 

 Читабельность, т. е. легкость и удобство при чтении текста. Так как это качест-

во, в большинстве случаев, обеспечивается на аппаратном уровне, т. е. с по- 
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мощью устройств чтения, к самому файлу будут предъявляться еще два требо-

вания. 

 Масштабируемость, т. е. возможность читать и изучать информацию при 

различных разрешающих способностях и размерах экрана устройства. 

 Полиграфичность, т. е. способность файлового формата к хранению инфор-

мации о форматировании, внедренных иллюстрациях, оглавлении и т. д. 

 Кроссплатформенность, т. е. свойство документа корректно отображаться на 

любых устройствах, от экрана персонального компьютера до специализирован-

ных устройств. Чем больше устройств способны отобразить без изменений ори-

гинальный макет, тем выше, соответственно, показатель кроссплатформенности. 

 Конвертируемость — очень важный параметр, обеспечивающий возможность 

сохранения документа без изменения его внешнего представления. В силу при-

роды стремительного развития информационных технологий и устройств, свя-

занных с этой областью, очень важно всегда сохранять возможность перевода 

информации в другой формат файла. 

 Интерактивность, что предоставляет пользователю функции обратной связи  

с публикацией и позволяет сделать взаимодействие гораздо более интересным, а 

представление информации интуитивно понятным. К этому же свойству отно-

сятся такие немаловажные моменты, как внедрение перекрестных- и гиперссы-

лок. 

 Поддержка мультимедийности, включающая в себя функции добавления  

в публикацию фото, аудио- и видеозаписей, анимации и других возможностей. 

 Возможность редактирования, что подразумевает под собой способность фай-
ла к внесению пользователем изменений. Это может быть полезно в двух слу- 

чаях. Во-первых, когда бывает необходимо внести в текст коррективы и,  

во-вторых, когда пользователю дается возможность оставлять в тексте свои по-
метки либо комментарии. В большинстве случаев, они могут ограничиваться за-

кладками. 

Сравнительная характеристика  
различных форматов электронных публикаций 

Итак, разобравшись с методикой, приступим к анализу популярных на сегодняш-
ний день форматов электронных публикаций с учетом вышеупомянутых пара- 

метров. 

Формат TXT (обычный текст) 

Это простейший формат хранения 8-битных значений, каждое из которых соответ-

ствует либо символу, либо управляющему коду. 

Масштабируемость данного формата сильно зависит от того, каким образом свер-

стан текст. Если присутствуют переносы на новые строки, абзацы, принудительное 

форматирование с выравниванием, то масштабируемость можно оценить как очень 



Введение 13 

низкую. В случае если текст идет одной непрерывной строкой без внедрения спе-

циальных не печатаемых символов, то масштабируемость можно характеризовать 

как высокую. 

Свойство полиграфичности у обычного текстового формата практически отсутст-

вует из-за скупого набора средств разметки и практической невозможности их 

расширить. 

Кроссплатформенность можно характеризовать как практически абсолютную, т. к. 

текстовые документы воспринимаются большинством существующих устройств. 

Конвертируемость также абсолютна, в связи с тем, что из файла с расширением txt 
элементарно получить любой другой файл с полным сохранением внешнего вида 

документа. 

Функции интерактивности, как и мультимедийности, отсутствуют — не поддержи-

вается даже внедрение гиперссылок. 

Возможность редактирования почти абсолютная на любом устройстве и на всех 

этапах жизненного цикла документа. 

В качестве рецензии относительно параметров данного формата файлов для хране-

ния электронных публикаций можно отметить следующее: данный формат исполь-

зовался повсеместно на заре эпохи формирования электронных библиотек. Однако 

сейчас, с появлением новых потребностей человека и, соответственно, форматов 

хранения разнородных данных, формат TXT потерял свою актуальность и его мож-

но обнаружить только в редких местах, и то, чаще всего, конвертированный в фор-

мат HTML перед выводом конечному пользователю. 

Формат RTF 

Формат RTF (Rich Text Format) был стандартизирован и введен в 1987 году компа-

нией Microsoft для возможности переноса текста с различным форматированием из 

одной программы в другую. Для этого он и используется по сей день. Данный фор-

мат адекватно воспринимается большинством современных текстовых редакторов 

и, чаще всего, корректно передает внедренные стили и форматирование текста. 

Масштабируемость для него можно определить как почти абсолютную из-за под-

держки плавающего текста, автоматического переноса строк, автопереносов слов и 

параметрических отступов в тексте. 

Полиграфичность можно охарактеризовать на уровне выше среднего. Это обуслав-

ливается наличием большого количество функций форматирования, внедрения 

изображений и т. д. 

Кроссплатформенность и конвертируемость у данного формата почти абсолютная, 

и это вполне очевидно. Он создавался именно для того, чтобы стать универсальным 

текстовым форматом и прекрасно с этой функцией справляется. 

Интерактивность находится на низком уровне. Поддерживаются только лишь ги-

перссылки и, в некоторых случаях, кнопки. Внедрение анимации возможно только 

на уровне изображений в формате GIF. 



14 Введение 

Поддержка мультимедиафайлов ограничивается только графическими картинками. 

Функция внедрения музыкальных и видеофайлов отсутствует. 

Уровень редактируемости у данного формата почти абсолютный, т. к. он разрабо-

тан именно для создания файлов со сложной версткой. 

В заключение отметим, что формат RTF до сих пор широко используется для хра-

нения электронных документов в русскоязычных онлайн-библиотеках главным об-

разом из-за его широкой поддержки различными программами и устройствами. 

Однако с развитием специализированных устройств для чтения и необходимостью 

применять универсальные форматы, использование формата RTF с каждым годом 

существенно снижается. 
 

Формат DOC 

Формат DOC — это внутренний формат файлов программы Microsoft Word, пред-

назначенный для хранения текстовых документов, созданных в этой программе. 

Масштабируемость, конвертируемость и полиграфичность у данного формата 

весьма высоки по тем же причинам, что и предыдущего формата. 

Кроссплатформенность, несмотря на поддержку многими специализированными 

пакетами, можно охарактеризовать все же как достаточно низкую по причине того, 

что данный формат является закрытым и права на его использование и модифика-

цию принадлежат компании Microsoft. 

Интерактивность в формате DOC существует несколько в более расширенном ва-

рианте, нежели чем в RTF, однако все равно ограничена только поддержкой гипер-

текста и некоторых видов кнопок, хотя в новом формате DOCX имеется возмож-

ность внедрения еще нескольких типов мультимедийных вложений, таких как  

музыка и видеофайлы. 

Редактируемость данного формата определяется как абсолютная, т. к. он предна-

значен как раз для создания и редактирования больших массивов текста. 

Как резюме по данному формату, отметим лишь, что он приобрел такую популяр-

ность лишь благодаря широкому распространению программного пакета Microsoft 

Office и рассматривать его как полноценный формат хранения электронных, а в 

особенности интерактивных документов, не стоит. Кроме того, последние версии 

пакетов Office используют уже обновленный формат DOCX, основанный на языке 

XML, о котором мы поговорим немного позднее. 
 

Форматы документов HTML (HTML, HTM, MHT, CHM) 

Язык HTML (Hypertext Markup Language) изначально был создан для верстки тек-

ста при необходимости его отображения в сети Интернет. На сегодняшний день он 

повсеместно используется для этих целей на всех онлайн-ресурсах. 

Если рассмотреть данный формат в рамках нашей системы сравнения, мы увидим 

следующий результат. Полиграфичность и масштабируемость можно оценить 

очень высоко, т. к. данный язык поддерживает абсолютно все виды верстки, суще-
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ствующие в настоящее время, хотя это происходит не всегда очевидным и прямым 

способом, и для некоторых видов отображения информации приходится придумы-

вать достаточно изощренные способы. 

Кроссплатформенность, как и конвертируемость у данного формата абсолютная. 

Из-за специфики данного языка и повсеместного использования данного формата 

для хранения web-данных, все без исключения устройства, в той или иной степени, 

но всегда корректно, отображают HTML-файлы. Маленькая ремарка — "в той или 

иной степени" — относится, скорей, даже не к самому формату, а к сопутствую-

щим интерактивным и мультимедийным элементам, о которых мы поговорим да-

лее, но которые могут не поддерживаться уже самим устройством. 

Что касается поддержки мультимедийных и интерактивных элементов, несомнен-

но, язык HTML снабжен всеми необходимыми средствами для этого. Более того, 

важно отметить, что именно этот язык сильно способствовал становлению и разви-

тию спектра данных элементов. Необходимость расширения возможных видов 

представляемой информации в сети Интернет увеличивала со временем и возмож-

ности языка в этой области. А вновь появляющиеся возможности, в свою очередь, 

порождали огромный поток той самой информации или контента. Это цикличное 

взаимодействие и сделало язык HTML столь универсальным инструментом верстки 

электронных публикаций. 

Несмотря на все плюсы формата HTML, он не нашел своего повсеместного приме-

нения при создании макетов таких видов публикаций, как электронные книги.  

Далеко не всем нравится воспринимать большой объем информации при чтении  

в браузере. При использовании же специализированной программы чтения или же 

электронного устройства HTML, как правило, конвертируется в обычный текст и 

теряет большинство своих преимуществ. 

Однако не стоит забывать еще об одном формате, основанном на языке HTML. Это 

формат CHM, изначально предназначавшийся для подготовки файлов справки к 

программному обеспечению. Компактность и высокий уровень интерактивности 

делают его весьма удобным для разного вида электронных справочников и руко-

водств. Как пример, можно рассмотреть компьютерные пособия одного из круп-

нейших издательств O'Reilly, в которых наличие интерактивного глоссария и кон-

текстного поиска значительно улучшает процесс восприятия информации. Ряд этих 

достоинств перечеркивает один важнейший недостаток. Этот формат жестко при-

вязан к операционной системе Windows, что делает его не кроссплатформенным. 

Формат Adobe Acrobat — PDF 

Программный пакет Adobe Acrobat и соответствующий ему формат PDF изначаль-

но разрабатывались для нужд полиграфии и предназначались для платформенно-

независимого переноса макетов печатных изданий. В последнее время данный 

формат активно развивается компанией Adobe также для создания интерактивных 

публикаций. Рассмотрим формат PDF подробней относительно наших типичных 

параметров. 
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Полиграфичность у данного формата абсолютная, и это не удивительно. Он был 
создан разработчиками именно для этих целей. Прекрасно распознаются различные 
виды текста, растровая и даже векторная графика. PDF-файлы обеспечивают 
управление версткой даже в сложных типографских вариантах, как-то: текст в не-
сколько столбцов и альтернативные стили для лицевой и обратной сторон. Это, 
кстати, делает файлы данного формата достаточно объемными, что, конечно, труд-
но назвать преимуществом. 

Еще одной проблемной областью этого формата является низкий уровень масшта-
бируемости. Нельзя сказать, что он полностью отсутствует. Верстка изданий в 
формате PDF жесткая, т. е. не существует плавающих переносов и абзацев, изобра-
жения привязаны к конкретному месту в тексте, а текст, в свою очередь, к опреде-
ленной верстке на странице. Изменить эту особенность, к сожалению, нельзя. Так 
как формат изначально настраивался на вывод документов на печать, жесткая при-
вязка каждого элемента к конкретному месту страницы является обязательным ус-
ловием. Таким образом, в связи с тем, что PDF-документы являются сложно пере-
форматируемыми, их трудно адаптировать к малогабаритным экранам многих мо-
бильных устройств, поэтому разработчикам, верстальщикам и дизайнерам 
приходится создавать параллельно несколько версий одного и того же документа 
для разных размеров экранов конечных устройств. 

Кроссплатформенность у PDF выше среднего, но для чтения файлов данного фор-
мата нужно установить специальную программу. Благо, сейчас подобных программ 
огромное множество и они созданы практически для всех известных платформ, как 
компьютерных, так и мобильных. 

Что касается интерактивности и мультимедийности, здесь они присутствуют в пол-
ном объеме. Есть возможность внедрения музыкальных файлов, видеоматериала, 
интерактивных кнопок, гиперссылок, оглавления и системы закладок, перекрест-
ных ссылок и многого другого. Отсутствует, разве что, способность использования 
анимации внутри документа. 

С другой стороны, редактируемость и конвертируемость находятся на крайне низ-
ком уровне. Хотя PDF и стал стандартом международной организации по стандар-
тизации (ISO 32000-1:2008), традиционно его контролирует одна корпорация — 
Adobe Systems. В связи с этим, возможность редактирования конечного PDF-файла 
реализована лишь в специализированных (и весьма дорогостоящих) пакетах данной 
компании. 

Несмотря на то, что PDF-файлы можно генерировать с помощью широкого спектра 
инструментов с графическим интерфейсом, даже таких как Microsoft Word, он ос-
тается весьма сложным для изучения стандартом, следовательно, разработчикам 
стороннего программного обеспечения достаточно трудно создавать собственный 
код для генерации PDF-файлов. Кроме того, хоть и имеется возможность извлечь 
текст из PDF-документа программно, не все документы размечены таким образом, 
чтобы это стало возможным. Это и делает параметр конвертируемости крайне  
низким. 

Как результат, формат PDF имеет ряд ограничений и особенностей, но, несмотря на 
это, благодаря огромному количеству возможностей, зачастую подходит для созда-
ния и хранения электронных публикаций. 
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Формат DjVu 

Формат DjVu (DejaVu от франц. déjà vu — "уже виденное") создан компанией 

AT&T специально для хранения компактно представленной информации с сети 

Интернет. Подобно форматам mp3 и dixv, в момент своего появления и быстрого 

развития, он произвел небольшую революцию в процессах свободного распростра-

нения информации. По существу, файлы в формате DjVu трудно назвать докумен-

тами, т. к., формально, это многостраничный растровый графический файл. При его 

генерации особые алгоритмы как бы отделяют текст от фона и иллюстраций и 

сжимают их после этого с различными разрешениями, что позволяет довести ком-

прессию в документе вплоть до 500 раз при сохранении весьма приемлемого ка- 

чества. 

Таким образом, в случае если публикация содержит большое количество исходного 

кода программ, схем, сложных таблиц, формул, то формат DjVu представляется 

крайне интересным, т. к. содержит книгу в неизменном виде. Кроме того, в качест-

ве преимущества нельзя не отметить, что последние версии данного формата при-

обрели способность хранить текст в отдельном слое, что дает возможность его вы-

делять и копировать. Однако, как и во всех прочих форматах, у него есть свои не-

достатки. Прекрасно справляющийся с обработкой и отображением большого 

массива текста, схем и прочей графической информации, формат DjVu абсолютно 

бессилен перед изданиями, содержащими цветные фотографии или рисунки. Они в 

нем выглядят крайне непрезентабельно. Кроме того, размер файла при внедрении в 

него полноцветных изображений начинает расти в геометрической прогрессии. 

Исходя из всего вышесказанного, можно судить о том, что параметр полиграфич-

ности у данного формата находится на достаточно высоком уровне при низком 

уровне масштабируемости (зависит от того, насколько хорошо программа или уст-

ройство для просмотра поддерживает сглаживание) и практически полном отсутст-

вии возможности редактирования и перевода в другой формат. 

Что касается кроссплатформенности, данный параметр также весьма слаб, т. к. 

формат требует специализированных программ для просмотра, коих на сегодняш-

ний день не так уж и мало, но созданы они не для всех систем и платформ. В за-

ключении, интерактивность ограничивается неким подобием гиперссылок, в то 

время как возможность внедрения мультимедийных файлов полностью отсутст- 

вует. 

Форматы на основе языка XML 

Для начала рассмотрим все наши параметры применительно к данным форматам, а 

потом подробней разберемся в их особенностях. Итак, высокая полиграфичность, 

абсолютная масштабируемость, практически абсолютная кроссплатформенность и 

конвертируемость, полная поддержка интерактивных элементов и мультимедийных 

данных и, как правило, практически абсолютная редактируемость. На первый 

взгляд похоже на идеальный формат для хранения электронных публикаций. Но 

прежде чем ответить на этот вопрос, давайте разберемся поподробней, что же это 

за волшебные форматы. 
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XML (eXtensible Markup Language) — расширяемый язык разметки, созданный для 

структурированных данных в текстовом формате. Теоретически, он задумывался 

таким образом, чтобы быть удобочитаемым как на программном уровне, так и че-

ловеком. С помощью данного языка можно записывать и обрабатывать практиче-

ски любые данные, вне зависимости от их объема, структуры и сложности. На базе 

XML создано большое количество структурированных подмножеств для решения 

конкретных задач, например язык для записи математических формул (MathML), 

химических элементов, хранения медицинской документации. Даже новые форма-

ты, созданные компанией Microsoft для хранения файлов пакета Office (Word, 

Excel), являются, по сути, файлами на языке XML, запакованными в один архив 

с соответствующим расширением. 

Кроме того, поскольку файлы XML — это обыкновенный текст, не требуется ка-

ких-либо специфических инструментов для его обработки и при потере какой-либо 

части данных, остальные не просто сохраняются, но и остаются доступны для рабо-

ты. Скажем, можно создать XML-документ любой сложности в Блокноте и после 

этого переслать коллеге просто скопированный из него фрагмент кода, который он 

с легкостью сможет использовать и редактировать так же в Блокноте. 

В отличие от HTML, в XML не существует фиксированных элементов разметки 

текста, как, к примеру, теги <body>, <header> и т. д., и набор средств разметки может 

быть произвольным. Разумеется, для упорядочивания данных есть набор описаний 

и требований к данному формату, называемый "спецификация" или DTD (Document 

Type Definition — описание типа документа). 

Для лучшего понимания того, как это реализуется, рассмотрим простейший пример 

реализации адресной книги на языке XML (листинг В1). 

Листинг В1. Пример содержимого, представленного языком XML 

<?xml version="1.0" encoding="UTF-8"?> 

<AddressBook> 

<contact> 

<person> 

<name>Петр</name> 

<subname>Аркадьевич<subname> 

<surname>Степанов</surname> 

<address>Липовая аллея, дом 2, квартира 43</address> 

<phone type="home">111-22-33</phone> 

<phone type="mobile">999-55-66</phone> 

<e-mail>StepanovPA@email.com</e-mail> 

</person> 

</contact> 

<contact> 

<org> 

<type-org>Закрытое акционерное общество</type-org> 

<name-org>Московская кирпичная фабрика</name-org> 

<address>ул. Большая Пушкарская, 1</address> 
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<phone type="work">333-33-20</phone> 

<phone type="work">222-32-00</phone> 

<site>http://www.moscowbricks.spb.ru</site> 

<e-mail>mail@moscowbricks.spb.ru</e-mail> 

</org> 

</contact> 

</AddressBook> 

 

Как мы видим, документ имеет четкую структуру и состоит из набора вложенных 

друг в друга элементов, включающих данные, ограниченные парой тегов <tag>  

и </tag>. Кроме данных, элементы содержат некоторые атрибуты, которые могут 

принимать фиксированные значения, как <phone type="work">333-33-20</phone>, 

где work — атрибут типа type элемента phone. Как видно из всего вышеизложенно-

го, документ в формате XML легко читается и редактируется, а при желании и кон-

вертируется в любой доступный формат. Давая такую свободу, XML одновременно 

предъявляет документу более жесткие требования, чем многие из рассмотренных 

форматов. Скажем, все элементы должны быть правильно "закрыты", т. е. каждому 

открывающему тегу должен соответствовать закрывающий в правильном порядке 

и т. д. 

Приблизительно разобравшись с тем, что такое XML, рассмотрим форматы, по-

строенные на его основе. Их достаточно много: OEB (Open e-book), DocBok, 

FictioBook и др. Но наибольшую популярность на сегодняшний день приобрел 

формат ePub. 

Формат ePub 

Формат ePub (Electronic Publication) — это формат переформатируемых цифровых 

книг и документов, стандартизированный ассоциацией IDPF (International Digital 

Publishing Forum) для индустрии цифровых изданий. Хотя первыми данный формат 

освоили традиционные издатели книг, ничто в этом формате не ограничивает его 

использование исключительно книгами. С помощью свободно распространяемых и 

коммерческих инструментов можно легко конвертировать в данный формат доку-

менты, электронные издания, HTML-страницы и прочие публикации, в том числе 

содержащие графику, иллюстрации и другое мультимедийное наполнение. Проана-

лизируем данный формат с точки зрения наших характеристик. Так как он основан 

на языке XML, к нему применимы практически все значения наших параметров из 

предыдущего раздела. Полиграфичность высока и зависит, в основном, от про-

граммы или устройства, на котором пользователь планирует производить чтение 

(ридеры). Масштабируемость в случае ePub практически абсолютная, во всех риде-

рах, будь то программные или системные устройства, реализована функция изме-

нения размера шрифта, а это не что иное, как реализованный потенциал заложен-

ной в формате масштабируемости. 

Кроссплатформенность у данного формата практически абсолютная и, как и пре-

дыдущие два параметра, непосредственно зависит от программно-аппаратной сре-

ды, которая, в свою очередь, на сегодняшний день, бурно развивается. Уже сейчас 
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можно сказать, что данный формат, благодаря использованию крупнейшими про-

давцами электронных книг на рынке, такими как Amazon (в данном магазине ис-

пользуется формат MOBI, ничем кроме расширения не отличающийся от ePub) и 

iBooks, получил повсеместную поддержку на большинстве современных устройств 

чтения. Параметры конвертируемости и редактируемости можно оценить как сред-

ние, т. к. для осуществления и одной и другой операции не требуется специальных 

знаний, и они не представляют никаких сложностей, однако для их реализации, 

чаще всего, требуется специальное программное обеспечение. 

Что касается возможностей внедрения интерактивной и мультимедийной состав-
ляющей при использовании формата ePub, то они практически безграничны. Име-
ется возможность добавления гиперссылок и изображений. Так в новых версиях 
iBooks, к примеру, появились опции присоединения таких сложных элементов, как 
интерактивные схемы и даже, в некоторой степени, 3d-модели. 

Именно по этим причинам, широко растущая на сегодняшний день индустрия циф-
ровых книг избрала для себя и в настоящее время активно внедряет и использует в 
качестве основного стандарта хранения данных формат ePub. Ассоциация IDPF 
приняла ePub в качестве стандарта в октябре 2007 года, а уже в начале 2008 года 
произошел значительный скачок в количестве устройств и программ, поддержи-
вающих данный стандарт. Среди них и устройства на основе электронных чернил, 
о которых мы говорили ранее, такие как Sony PRS и карманные планшеты, к при-
меру, Apple iPhone. Про данные устройства и особенности применения в них фор-
мата ePub мы поговорим позже в этой книге. Пока же обсудим еще один формат, 
который, в отличие от остальных, изначально не был предназначен для создания и 
хранения электронных публикаций, но, обладая рядом явных преимуществ, такое 
свойство со временем приобрел — формат Flash-графики. 

Форматы Flash-графики — SWF и FLA 

Как уже было сказано, Flash-графика весьма условно относится к данной области, 
но в последние несколько лет, благодаря активному внедрению компанией Adobe 
новейших разработок в развитие flash-технологий, база возможностей рассматри-
ваемых форматов существенно расширилась и на равных конкурирует с более тра-
диционными форматами, о которых мы говорили ранее. 

Adobe Flash (ранее Macromedia Flash) — это программный комплекс для создания и 
воспроизведения мультимедийных публикаций и web-графики. Эта платформа ши-
роко используется для создания анимации, баннеров в сети Интернет, презентаций 
и прочих решений, требующих максимального использования мультимедийных 
возможностей. Кроме всего прочего, данный стандарт поддерживает воспроизведе-
ние аудио- и видеозаписей, позволяет работать как с растровой, так и с векторной 
графикой, и даже поддерживает потоковую трансляцию аудио- и видеоматериалов 
и, в какой-то степени, трехмерную графику. 

Как мы уже делали ранее, пройдемся по нашим параметрам и проанализируем Flash 
и технологию с их точки зрения; хотя в данном случае сделать это будет несколько 
проблематично, т. к., еще раз повторяясь, рассматриваемый формат изначально не 
предназначался для решения разбираемых нами задач. 
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Рассмотрим в первую очередь параметры масштабируемости, редактируемости и 
полиграфичности. Их можно характеризовать как относительные. В связи с тем, 
что данная технология является программной платформой с собственными стан-
дартами, для ее воспроизведения требуется специальное программное обеспече-
ние — Adobe Flash Player. Он представляет собой виртуальную машину, на которой 
выполняется код программы. Что касается собственно языка, на котором создается 
вся итоговая среда, это Action Script — достаточно сложный и многогранный объ-
ектно-ориентированный язык программирования, дающий очень широкие возмож-
ности для выполнения поставленных задач. Таким образом, если автору необходи-
мо реализовать в той или иной степени масштабируемость, он программным спо-
собом закладывает в свою публикацию этот функционал; если необходимо дать 
возможность пользователю в каком-либо месте редактировать материал внутри 
публикации, такая функция закладывается на этапе создания; если же необходимо 
зафиксировать верстку, внедрить функции печати, то это также делается создате-
лем на этапе программной разработки. В этом, собственно, и заключается относи-
тельность этих параметров. Кстати, именно благодаря заложенному в этой техноло-
гии расширяемому программному потенциалу, параметр интерактивность можно 
определить как абсолютный из всех рассматриваемых нами форматов. Параметр 
кроссплатформенности до 2007 года был почти абсолютным, но, при презентации 
устройства iPhone компанией Apple, данная ситуация резко изменилась. По эконо-
мическим и политическим мотивам создатель знаменитых устройств, по сегодняш-
ний день, отказывается внедрять в свои устройства поддержку Flash, объясняя это 
своей политикой воспрепятствования свободному распространению пиратских ма-
териалов через сеть Интернет. Поэтому, на настоящий момент, кроссплатформен-
ность формата Flash является средней. 

Как уже было сказано ранее, мультимедийность находится на высочайшем уровне, 
т. к. именно для хранения мультимедийных данных, в основном, Flash и был соз-
дан. Конвертируемость, однако, практически отсутствует, и, в связи с тем, что это 
закрытый формат, ее реализация внешними средствами также весьма затрудни-
тельна. 

Итак, мы рассмотрели все параметры, по которым проводилась сравнительная ха-
рактеристика. Теперь остановимся на очевидных недостатках данной платформы. 
Во-первых, неэффективность виртуальной машины Flash Player приводит к чрез-
мерным нагрузкам на центральный процессор устройства, на котором производится 
просмотр. Во-вторых, в данной технологии заложен недостаточный функционал по 
контролю за возникновением ошибок, что зачастую приводит к отказам как самих 
приложений, так и к "зависанию" всего устройства. Наконец, небольшой недоста-
ток заключается в том, что в приложениях и публикациях на основе Flash нет воз-
можности использовать правую кнопку мыши — она зарезервирована разработчи-
ками для сервисных функций настройки виртуальной машины Flash Player. 

Adobe Digital Publishing Suite. Формат FOLIO 

Заключительная в нашем списке, но далеко не последняя по значимости техноло-
гия — цифровые публикации DPS (Digital Publishing Suite), представленная компа-
нией Adobe в 2011 году, является самой молодой из рассматриваемых нами.  
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Несмотря на это, данная технология явилась своеобразным тихим технологическим 
прорывом, вобрав в себя все необходимые для цифровой издательской деятельно-
сти функции. 

Adobe Digital Publishing Suite — это набор программных средств, позволяющий 

пользователям создавать и работать с интерактивным содержимым в хорошо зна-
комом журнальном или книжном формате. Данная среда позволяет дизайнерам, 

работающим над привычными изданиями в программе InDesign, настраивать и,  
в последующем, экспортировать полученные документы для просмотра на устрой-

ствах с платформами iOS, Android, Blackberry Playbook. Что примечательно, для 
просмотра итоговых публикаций не требуется устанавливать какие-либо специаль-

ные программы, а само издание можно скачать непосредственно в профильном ма-
газине (Apple App Store, Android Market, Blackberry App World), как приложение. 

Пакет дает возможность для издателей расширять свои публикации новыми воз-
можностями, такими как манипуляция пальцами (в том числе MultiTouch) для про-

смотра, интерактивное перелистывание, изменения масштаба просмотра, внедрение 
панорамных изображений, 3d-просмотр и многие другие. 

Исходя из наших параметров, масштабируемость можно оценить как среднюю, т. к. 

для реализации данной особенности технология предписывает создавать для каж-
дого конкретного устройства макет своего размера, как для горизонтального, так и 

для вертикального расположения устройства. Таким образом, если автор захочет 
получить издание, приспособленное для просмотра на iPad, Android-планшете и 

PlayBook, ему потребуется создать 6 макетов для своей публикации. Причем, что 
немаловажно, для горизонтальной и вертикальной верстки, чаще всего, приходится 

кардинально изменять дизайн-решение. Полиграфичность у данного формата очень 
высока — за счет фиксированной верстки доступны все возможные средства фор-

матирования. Кроссплатформенность выше среднего — как уже было сказано, 

формат поддерживается основными мобильными платформами. На основные ком-
пьютерные платформы (PC и Mac) создано специализированное бесплатное про-

граммное обеспечение. Вместе с тем, из-за закрытости формата, параметр кросс-
платформенности относителен и может со временем меняться как в сторону рас-

ширения, так и в сторону узкой сегментированности на определенных устройствах, 
что, конечно, маловероятно и, несомненно, находится вне интересов компании 

Adobe. 

По причине вышеизложенных моментов, параметры конвертируемости и редакти-
руемости абсолютно не реализованы. Более того, компания-разработчик техноло-

гии никогда не станет внедрять данные параметры, т. к. это разрушило бы коммер-
ческую составляющую новейшего программного комплекса, коим является Digital 

Publishing Suite. Об этом мы еще поговорим в следующих главах этой книги. 

С другой стороны, параметры интерактивности и мультимедийности реализованы 
здесь во всем своем многообразии и с применением большинства необходимых 

форм представления информации (фото, звук, видео, гиперссылки, интерактивные 
элементы и т. д.). 

Итак, мы провели детальный обзор технологий, используемых на сегодняшний 

день при разработке макетов электронных публикаций. Мы сравнили достоинства и 
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недостатки этих платформ. Исходя из этого, в этой книге мы будем работать, как 

уже не сложно догадаться, с форматами PDF, Flash, ePub и DPS. 

Исходя из рассматриваемых форматов, данная книга состоит из трех глав, первая из 

которых описывает процесс создания и методики работы с интерактивными доку-

ментами в пакете Adobe InDesign CS6 (с сохранением в форматах Flash и PDF), да-

вая исчерпывающую информацию и полный обзор функций программы в этой об-

ласти; вторая обучает процессу подготовки макетов и конвертации файлов в один 

из самых популярных форматов электронных изданий ePub, отражая при этом ос-

новные особенности структуры данных документов для соответствия стандарту 

IDPF (International Digital Publication Forum) и предлагая максимум доступных ме-

тодов форматирования текста, иллюстраций, таблиц и схем; в третьей приводятся 

алгоритмы дизайна и верстки документов в формате FOLIO с помощью новейшей 

разработки корпорации Adobe — пакета Digital Publishing Suite, позволяющего ди-

зайнерам создавать уникальные интерактивные публикации для мобильных уст-

ройств, используя для этого средства комплекса Adobe InDesign CS6. 

Обзор основных инструментов для работы 

Для создания, изменения, настройки, сохранения и многих других задач мы будем 

использовать достаточно большое количество инструментов в программном пакете 

Adobe InDesign. В данном разделе мы определимся с терминологией, чтобы по ходу 

книги вам было понятно, о каких именно элементах идет речь, а также определим 

местоположение большинства из них в интерфейсе программы. 

Все управляющие элементы в InDesign можно разделить на несколько принципи-

альных групп. 

 Панели — это стационарные области в рабочем пространстве. Чаще всего, гово-

ря о панелях, мы будем иметь в виду панель инструментов в левой части рабо-
чей области и управляющую панель в верхней ее части. Панелями, однако, в кон-

тексте могут также называться области в том или ином окне, в которых сгруп-
пирован ряд однородных функций. 

 Диалоговые окна — это окна, всплывающие по нажатию на те или иные кнопки 

в программе. Чтобы точно определить для себя, что это, вы можете выбрать ин-
струмент "прямоугольник" и щелкнуть один раз мышью в любом месте вашего 

документа. При этом откроется диалоговое окно создания прямоугольника. 
Именно об управляющих элементах такого типа мы будем говорить, называя их 

диалоговые окна. 

 Палитры — это симбиоз диалогового окна и панели. Вызываются они, чаще 

всего, с помощью команды главного меню Window... и содержат в себе группу 

функций, направленных на реализацию какой-то одной задачи. В нашей работе 

мы будем использовать, в основном, палитры из группы Interactive, а также не-

которые, не входящие ни в одну из групп. 

Остальные виды управляющих элементов, такие как инструменты, раскрывающие-

ся списки, несомненно, уже знакомы вам. 
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Для каждой из глав данной книги мы будем использовать свой набор инструмен-

тов, в значительной степени отличающийся друг от друга. При этом для каждой из 

функций обязательно дается обзор действий, которые необходимо совершить для 

того, чтобы она стала доступна для работы. 

Последний момент, на который хотелось бы обратить внимание в связи с обзором 

интерфейса, — это удивительная возможность InDesign, да и большинства других 

продуктов компании Adobe, сохранять внешний вид своей рабочей области при 

помощи Workspace. Чтобы сделать это, после того как вами будут вызваны все не-

обходимые панели и выстроено их положение на экране, выберите пункт меню 

Window > Workspace > New Workspace. В открывшемся окне вы сможете задать 

имя для своего рабочего пространства и сохранить его. Теперь, после открытия 

программы, даже если какие-то из панелей исчезли, вы с легкостью сможете вер-

нуться к сохраненному виду вашей рабочей области. 

Теперь, когда мы разобрались с нашим инструментарием, можно приступать к ра-

боте. 

 

 



  

 

 

ГЛАВ А 1 
 
 
 
 

Работа  
с интерактивными документами 

Теоретические сведения  
об интерактивных документах 

Давайте приступим к работе и начнем с того, что разберемся, что же такое интерак-
тивный документ. Интерактивный документ представляет собой файл, предназна-
ченный не для печати, а для просмотра на экране электронного устройства. В этом 
и заключается его главное отличие. В Adobe InDesign CS6 у нас есть возможность 
создавать интерактивные публикации двух видов — для экспорта в Interactive PDF 
и для Adobe Flash. По сути, интерактивность внутри самого проекта InDesign инте-
ресует нас в меньшей степени, т. к. у большинства пользователей просто не уста-
новлен пакет InDesign, поэтому у них нет возможности просматривать файлы  
с расширением indd. Альтернативные же форматы, предложенные нам для экспорта 
публикаций, являются массовыми и доступными для любого пользователя. 

Когда мы будем работать уже непосредственно с инструментами для создания ин-
терактивных элементов, вы обратите внимание, что они бывают трех видов — либо 
универсальные, либо созданные для PDF, либо предназначенные для Flash. Данное 
разделение обусловлено только тем, что стандарты, используемые для экспор- 
та, слишком разные, и каждый по отдельности не поддерживает все возможные 
функции. 

В принципе, это, пожалуй, и вся теоретическая информация, которую пока что 
нужно понимать. А теперь давайте приступать к практике. 

Создание  
нового интерактивного документа 

Каким же образом InDesign "понимает", что ведется работа не над простым печат-

ным, а именно над интерактивным документом? Здесь все предельно просто и оп-

ределяется уже на этапе создания нового документа. Давайте разберемся с этим 

процессом подробней. 
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Итак, для того чтобы создать новый интерактивный документ, выберите в главном 

меню InDesign пункт File > New > Document. 

Как вы видите, по умолчанию в раскрывающемся списке Intent (назначение доку-

мента) указано Print (рис. 1.1). При этом все единицы измерения в полях для 

управления шириной, высотой, отступами, полями и прочими параметрами задают-

ся в пунктах или миллиметрах, в зависимости от того, как настроен ваш интерфейс. 

Если же мы в раскрывающемся списке Intent выберем режим Web (рис. 1.2), то все 

значения автоматически будут переведены в пикселы. Здесь также присутствует 

другое назначение документа — Digital Publishing, но о нем мы поговорим в главе 3. 

 

Рис. 1.1. Диалоговое окно New Document 

 

Рис. 1.2. Выбор режима Web в диалоговом окне New Document 
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Кроме того, в раскрывающемся списке Page Size появились совершенно иные ва-

рианты предустановок (рис. 1.3). Это происходит из-за того, что в случае с инте-

рактивными публикациями размеры дисплея конечного устройства в связке с его 

разрешающими способностями измеряются в пикселах, следовательно, и макет и 

все элементы внутри него должны быть описаны в данных единицах. 
 

 

Рис. 1.3. Варианты установок в раскрывающемся списке Page Size  
при выборе режима Web 

Еще одно важное изменение, которое происходит при создании нового документа 

при установленном назначении Web, — это наборы параметров в палитре Swatches 

(Window > Color > Swatches). Как вы наверняка знаете, они представлены в режи-

ме работы с печатными документами в цветовой модели CMYK (рис. 1.4, слева). 

При выбранном же значении Web в раскрывающемся списке Intent в палитре 

Swatches все цвета будут преобразованы в цветовую модель RGB (см. рис. 1.4, 

справа). 
 

 

Рис. 1.4. Вид палитры Swatches при выборе режима Print (слева) и Web (справа) 
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Это происходит по той же причине, что и в предыдущем случае — экраны всех 
устройств излучают свет и в своей работе регулируются моделью RGB. Именно  
из-за этого макет и создается в этой модели. 

В продолжение нашего разговора, если мы вернемся к диалоговому окну создания 
нового документа, здесь осталось еще два момента, на которые обязательно стоит 
обратить внимание. Во-первых, при создании интерактивных документов не стоит 
выбирать опцию Facing Pages. Она отвечает за отображение страниц в виде разво-
ротов. Немного позже вы увидите, что в случае с интерактивными документами это 
не имеет значения, т. к. экран в один момент может отображать только одну стра-
ницу заданного размера. Следовательно, верстка разворотами нецелесообразна. 

Второй важный элемент — наличие или отсутствие полей у интерактивного доку-
мента. Если вернуться к тому, для чего изначально создавались обязательные поля 
в мире печати, то мы должны вспомнить о том, что это было вызвано технологиче-
скими особенностями печати и погрешностями при резке. В мире электронных 
публикаций данных ограничений нет, и мы можем задать точное положение объек-
та на листе вплоть до пиксела и, соответственно, на экране конечного устройства. 
При этом, как вы понимаете, всякая необходимость в специальном определении 
полей и вылетов пропадает. Однако вы вполне можете использовать эти направ-
ляющие для реализации собственных дизайнерских задумок. 

Наконец, самое важное, что нужно знать при создании нового документа, — это 
размеры и разрешение экрана конечного устройства, на котором будет просматри-
ваться электронная публикация. Она должна быть создана именно в этих размерах 
и для этого разрешения, на то есть ряд причин. Во-первых, соблюдение пропорций 
экрана позволит документу занимать его целиком, что избавит пользователя от со-
зерцания черных пустых полос сбоку, сверху или снизу от него. Во-вторых, изо-
бражения будут помещены в публикацию с корректным разрешением, и пользова-
тель сможет просматривать их в великолепном качестве. Мы еще не раз вернемся 
к этой теме в следующих разделах и главах этой книги. А пока просто каждый раз 
при создании нового интерактивного документа будьте предельно сосредоточены и 
обращайте внимание на все описанные нюансы. Этим вы сможете заложить уве-
ренный фундамент для всей своей дальнейшей работы. 

Создание интерактивных закладок  
и текстовых ссылок 

В данном разделе будет рассмотрено, как создавать и управлять различными вида-
ми закладок в документе InDesign CS6. В качестве примера для работы будет ис-
пользоваться файл Sample_work.indd, который находится в папке \Интерактивность 
наших рабочих материалов (описание электронного архива к книге и способ досту-
па к нему см. в приложении). Данный документ представляет собой портфолио не-
коего фотографа, занимающегося пейзажной съемкой в экзотических странах. Мы 
будем работать с данным материалом на протяжении всей этой главы, постепенно 
наращивая для него возможности, которые предоставляет нам интерактивный 
функционал пакета Adobe InDesign CS6. 
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В одном из прошлых разделов мы упомянули, что существует несколько вариантов 

для экспорта готового интерактивного документа. Во-первых, в виде Interactive 

PDF; во-вторых, как Flash-публикацию в двух различных форматах — SWF и FLA. 

В первую очередь в данном разделе мы познакомимся с функциями, которые по-

зволяет нам использовать интерактивная версия формата PDF. Первая из таких 

функций — это внедрение закладок. Закладки представляют собой структурное 

упорядочение итогового PDF-документа, состоящего из большого количества раз-

делов. Мы можем видеть PDF-закладки, в зависимости от используемого про-

граммного обеспечения для чтения файлов, либо в специализированной панели 

Bookmarks, расположенной в левой половине окна просмотра стандартной про-

граммы Adobe Acrobat Reader (рис. 1.5), либо в панелях с другими наименованиями 

в прочих системах воспроизведения PDF. 

 

Рис. 1.5. Вид панели Bookmarks программы Adobe Acrobat Reader 

Данные закладки можно использовать двумя различными способами. Во-первых, 

они, как классическое оглавление в любой книге, дают нам информацию о том, на 

какой странице начинается тот или иной раздел публикации. Кроме того, закладки 

являются ссылками, по нажатию на которые пользователь может переходить непо-

средственно к интересующей его части документа. 
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Немаловажным является факт, что закладки могут быть ссылками как на начало 

целой главы или раздела, так и на внутренние подразделы или параграфы. Кроме 

того, для большей наглядности, практически в любой программе для просмотра 

PDF-документов поддерживается отображение вложенности закладок относительно 

друг друга (рис. 1.6). 
 

 

Рис. 1.6. Отображение вложенности в панели Bookmarks 

 

Например, если у нас есть ссылка на вторую главу какой-либо книги и ссылка на 

пятый параграф этой главы, то в дереве наших ссылок мы увидим структуру, напо-

минающую лестницу, в которой каждый вложенный раздел будет визуально немно-

го смещен относительно родительского. В большинстве программ просмотра также 

поддерживается организация данных закладок по уровням вложенности, т. е. с по-

мощью ряда кнопок в иерархической структуре мы можем свернуть все дерево для 

отображения только глав, можем "войти" внутрь структуры какой-то конкретной 

главы, не "раскрывая" дерево остальных глав, и т. д. Систему закладок данного ви-

да впредь будем называть внешним оглавлением. 

Другой вид закладок, систему которых мы будем называть внутренним оглавлени-

ем, строится несколько по другим принципам. Они не зависят от программы, в ко-

торой производится чтение, и представляют собой фактическое оглавление, вне-

дренное внутрь издания, занимающее определенное количество страниц и не тре-

бующее открытия дополнительных панелей (рис. 1.7). Данный вид закладок может 

иметь собственное оформление, стили и, вместе с тем, обладать все тем же рядом 

функций, что и внешнее оглавление, т. е. определение фактического номера стра-

ницы, соответствующего началу раздела, и ссылочный переход к нему по нажатию 

на текст закладки. 

Для генерации обоих видов оглавления нам достаточно зайти в пункт меню 

Layout > Table of Contents программы InDesign, создать с помощью классических 

стилей оглавление и не забыть установить флажок Create PDF Bookmarks. После 

этого у нас есть две возможности. Мы можем либо поместить наше оглавление 

внутрь публикации и получить внутреннее оглавление, либо не помещать и, соот-
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ветственно, автоматически получить внешнее. Как вы видите, ничего сложного 

здесь нет. Однако, кроме пункта меню Table of Contents, в пакете InDesign CS6 

есть и другие инструменты для работы с закладками. 

 

Рис. 1.7. Внутреннее оглавление в документе PDF 

В нашем примере мы не будем генерировать внутреннее или внешнее многосту-
пенчатое оглавление, а используем закладки для немного других целей. Для этого, 
в первую очередь, откроем панель Bookmarks. Запомните, что закладки — это не 
что иное, как простые ссылки на информацию внутри файла. Предположим, что мы 
хотим создать систему закладок, переводящих нас на каждую из страниц нашего 
документа. В нашем примере присутствует обложка, страница с вводной информа-
цией, страница с галереей и ряд страниц с обзором представленных работ. Для соз-
дания новой закладки на конкретную страницу публикации необходимо выделить 
эту страницу и, открыв палитру Bookmarks c помощью пункта главного меню 
Window > Interactive > Bookmarks, нажать в нижней ее части кнопку New 

Bookmark. 

После этого программа предлагает нам задать имя для вновь созданной закладки 
(рис. 1.8). Так как мы выбрали для создания страницу-обложку, назовем закладку 
Cover. Выделим следующую страницу, повторим операцию, нажав кнопку New 

Bookmark, и назовем новую закладку Introduction. Так же создадим еще одну за-
кладку для страницы с галереей, присвоив ей имя Gallery, и одну для первой пред-
ставленной работы с именем Work 01. 

Итак, мы получили систему навигации, состоящую из четырех закладок. В первую 

очередь, их уже можно использовать для навигации по документу, просто дважды 
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нажимая на название каждой. Обратите внимание на то, что рядом с именем за-

кладки присутствует значок в виде страницы (рис. 1.9). Это означает, что данная 

закладка направляет пользователя на конкретную страницу документа. Кроме это-

го, мы можем создавать закладки на другие типы навигационной информации.  

К примеру, создадим закладку, ссылающуюся на отрывок текста. Для этого выбе-

рите на панели инструментов инструмент Type Tool и установите курсор в любое 

место среди текстовых блоков внутри публикации. После этого, повторив действие 

из предыдущего примера, нажмите кнопку New Bookmark. Точно так же, как и 

раньше, создается новая закладка с предложением ввести для нее имя; в нашем 

случае не принципиально, какое имя вы ей дадите. Акцентируйте ваше внимание 

на том, что, в отличие от предыдущих примеров, значок рядом с названием новой 

закладки по форме напоминает якорь (см. рис. 1.9). 
 

 

  

Рис. 1.8. Вид панели Bookmarks  
при создании новой закладки 

Рис. 1.9. Вид панели Bookmarks  
со всеми созданными закладками 

 

Причина, по которой это происходит, кроется в том, что в данном случае InDesign 

создает закладку типа Text Anchor или текстовый якорь. Чтобы понять, что он со-

бой представляет, в первую очередь давайте выйдем из режима презентации путем 

выбора пункта меню View > Screen Mode > Normal или нажатием горячей клави-

ши <W>. После этого перейдем к пункту меню Type > Show Hidden Characters 

(горячие клавиши <Alt>+<Ctrl>+<I>). Теперь в том месте, где вы установили тек-

стовый якорь, вы можете видеть символ, похожий на двоеточие. Он означает, что  

в данном месте установлен Text Anchor. Таким образом, данные якоря являются, по 
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сути, пунктами назначения для ссылок, которые формируются с помощью палитры 

Bookmarks. 

Стоит обратить внимание на то, что не только простое установление курсора в оп-

ределенном месте текстового массива может позволить создать текстовый якорь. 

Такую же возможность дает выделение фрагмента текста с последующим нажатием 

кнопки New Bookmark. Несомненным плюсом такого способа создания якорей яв-

ляется тот факт, что им автоматически при создании присваиваются имена соглас-

но выделенным фрагментам текста. 

Итак, мы создали ряд закладок, ссылающихся на различные разделы нашего доку-

мента. Обратите внимание на тот факт, что два текстовых якоря, созданные нами  

в последнюю очередь, физически относятся к первому разделу — Introduction, — 

и находятся на первой странице нашей публикации, для которой мы ранее создали 

отдельную закладку. Вспомните про систему вложенности ссылок, о которой мы 

говорили ранее в этом разделе. Давайте организуем нашу систему закладок, чтобы 

добиться подобного эффекта. Для этого нужно щелкнуть мышью по названию 

имеющегося якоря и "перетащить" его на имя раздела, к которому он относится. 

После этого мы увидим рядом с корневой закладкой значок вложенности, щелкнув 

на который отобразятся элементы, находящиеся по структуре внутри данного эле-

мента, в нашем случае текстовый якорь, ранее туда помещенный. 

Для того чтобы устранить вложенность того или иного элемента в нашей публика-

ции, необходимо точно так же щелкнуть по нему мышью и "вытащить" из другой 

закладки. При дальнейшем перемещении элемента вы увидите, что в определенных 

местах появляется жирная линия, наглядно отображающая, в какое место в итого-

вой иерархии попадет перемещаемый элемент (рис. 1.10). 
 

 

 

Рис. 1.10. Вид панели Bookmarks с настроенной системой вложенности 
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Еще один способ создания вложенных закладок заключается в том, что мы можем 

выделить нужную нам главную закладку и, после выделения фрагмента текста и 

нажатия кнопки New Bookmark, можно получить текстовый якорь, который будет 

сразу же вложен в выбранную старшую закладку. 

Для удаления какой-либо закладки достаточно выделить ее и нажать на значок  

мусорного ведра в правом нижнем углу панели Bookmarks. В зависимости от на-

строек может появиться информационное окно, сообщающее пользователю о не-

возвратности этого действия и запрашивающее о дальнейших действиях. Если вы 

уверены в том, что хотите удалить выбранную закладку, то нажмите кнопку OK. 

Если же вы передумали, нажмите кнопку Cancel. 
 

Создание интерактивных гиперссылок 

В прошлом разделе мы изучили методы создания и управления поведением инте-

рактивных закладок и текстовых ссылок. В данном же разделе, как логическое про-

должение прошлого, мы продолжим работать с уже знакомым нам файлом портфо-

лио и научимся создавать гиперссылки внутри интерактивного документа InDesign. 

Когда речь заходит о гиперссылках, у большинства людей в голове возникает ассо-

циация с адресной строкой браузера с адресом для перехода в сети Интернет.  

Однако спектр применения гиперссылок значительно шире, в чем вы в ближайшее 

время сами сможете убедиться. Давайте обратимся к специально разработанной для 

этого панели инструментов Hyperlinks (гиперссылки), которую можно вызвать из 

меню Window > Interactive > Hyperlinks (рис. 1.11). 

Как вы видите, данная панель разделена на два смысловых блока — Hyperlinks и 

Cross-References (перекрестные ссылки). Перекрестные ссылки — это один из ин- 
 

 

 

Рис. 1.11. Вид панели Hyperlinks 
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струментов создания интерактивности, но он необходим больше для работы с объ-

емными документами, такими как, например, книги. С ними мы ближе познако-

мимся в следующей главе, когда будем говорить про создание макетов публикаций 

в формате ePub. Сейчас же давайте обратим наше внимание на блок Hyperlinks 

этой панели. 

Для гиперссылок в InDesign CS6 существует два типа данных, с которыми они мо-

гут работать, — это так называемые данные об источнике и данные о назначении. 

Давайте разберемся с двумя этими типами данных на примере. Для этого перейдем 

к странице 4 нашей презентации. Обратите внимание на боковую панель в правой 

части нашего макета. 

В ее верхнем разделе есть информация о клиенте — его название, web-сайт, имя 

проекта и дата его реализации. Если мы захотим превратить адрес из статичной 

текстовой надписи в гиперссылку таким образом, чтобы по ней можно было перей-

ти на сайт, сама надпись www.polylab.org станет источником; непосредственно же 

сайт www.polylab.org, открытый в браузере, станет, в этом случае, пунктом назна-

чения. 

Держа это принципиальное отличие в голове, рассмотрим несколько типовых под-

ходов к работе с гиперссылками. Во-первых, мы можем, перемещаясь по всему на-

шему документу, на каждый встречающийся адрес одновременно задавать данные 

и об источнике и о назначении. Или же мы можем изначально указать программе 

InDesign информацию обо всех пунктах назначения, на которые могут указывать 

ссылки в документе. Давайте рассмотрим это на примере. 

Для этого обратимся к контекстному меню панели Hyperlinks и выберем в нем 

пункт New Hyperlink Destination (обратите внимание, что предварительно выде-

лять в документе ничего не нужно). 

 

Рис. 1.12. Вид окна New Hyperlink Destination при выбранном типе ссылки Page 

Открывается одноименное диалоговое окно (рис. 1.12), в котором мы можем на-

строить ряд параметров для назначения ссылки. Первый параметр это его тип 

(Type) — по умолчанию он выбран как Page, т. е. страница в текущем документе. 

Для данного типа имеются два базовых параметра для настройки — номер страни-

цы, которая станет назначением (Page), и настройки масштабирования (Zoom 

Setting). Сразу же обращаю ваше внимание на то, что настройки масштабирования 

актуальны только при сохранении в PDF-документе и будут игнорироваться при 
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использовании технологии Flash. Также здесь есть опция (флажок) Name with Page 

Number, отвечающая за автоматическое присвоение имени вида ""Page + № стра-

ницы"" вашему пункту назначения. Соответственно, если данная опция отключена, 

вы можете свободно назначить ему любое имя. 

Второй тип назначения ссылки — Text anchor или текстовый якорь. Как вы видите, 

он сейчас не активен; о нем мы поговорим немного позже. Сейчас же рассмотрим 

третий тип — URL (рис. 1.13). 

 

Рис. 1.13. Вид окна New Hyperlink Destination при выбранном типе ссылки URL 

URL расшифровывается как Uniform Resource Locator (единый указатель ресурсов) 

и является стандартизированным способом записи адреса ресурса в сети Интернет, 

или, проще говоря, привычным для нас адресом сайта вида http://www.site.ru/. 

Именно с этой информацией работает данный тип назначения ссылки. После выбо-

ра этого типа нам предоставляется всего два поля для заполнения. Давайте зададим 

имя нашему первому пункту назначения, пускай это будет MySite, в строке URL 

пропишем адрес назначения, к примеру, http://www.polylab.org/. После этого  

нажмите кнопку OK. Как вы видите, ничего не изменилось, но теперь, если вы вы-

берете в контекстном меню нашей панели Hyperlink Destination Options, то вы 

увидите в раскрывающемся списке Destination диалогового окна Hyperlink 

Destination Options вновь созданное назначение ссылки (рис. 1.14). 

 

Рис. 1.14. Вид диалогового окна Hyperlink Destination Options 

Теперь мы имеем возможность привязывать любое количество источников ссылки 

в нашем документе к созданному пункту назначения. В этом же диалоговом окне 
мы имеем возможность удалять различные ранее созданные пункты назначения, 
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либо выбирая их по одному и нажимая кнопку Delete, либо же можем удалить их 

все сразу, нажав кнопку Delete All; также, при нажатии кнопки Edit, диалоговое 
окно предоставляет возможность редактировать созданные пункты назначения. Для 

того чтобы выйти из этого диалогового окна без изменений, нажмем кнопку 
Cancel. 

Теперь, когда у нас все готово, давайте создадим нашу первую интерактивную ги-

перссылку. Первым способом создания ссылки, как вы уже знаете, является одно-
временное определение и источника и назначения. На боковой панели нашего до-

кумента выделим часть текста "www.polylab.org". Обратите внимание, что теперь в 
панели Hyperlinks стало доступным для заполнения поле URL. Для осуществления 

этого способа просто введите в это поле адрес, к примеру, http://www.polylab.org/ 
(рис. 1.15) и нажмите на клавиатуре клавишу <Enter>. 

 

Рис. 1.15. Создание новой интерактивной ссылки (первый способ) 

Вторым способом, как вы помните, является привязка источника к уже созданному 

назначению. Для этого необходимо в поле URL нажать кнопку открытия раскры-
вающегося списка и в нем выбрать созданный ранее пункт назначения (рис. 1.16), 

после чего на клавиатуре также нажать клавишу <Enter>. 

Кроме того, есть еще один способ создания ссылок, к тому же, дающий нам воз-
можность настроить ряд важных параметров. Для того чтобы это сделать, выделите 

любой другой фрагмент текста и нажмите кнопку Create New Hyperlink в нижней 
части панели. По нажатию открывается соответствующее диалоговое окно New 

Hyperlink. В первую очередь, обратим внимание на верхнюю часть этого окна 
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(рис. 1.17). Первый раскрывающийся список Link To указывает на то, с чем будет 

связана ссылка, по умолчанию здесь указывается Shared Destination и это значит, 
что назначением для данной ссылки будет служить ранее созданный нами пункт, 

который можно выбрать в раскрывающемся списке Name. 

 

Рис. 1.16. Создание новой интерактивной ссылки (второй способ) 

 

Рис. 1.17. Вид диалогового окна New Hyperlink 

Это, пожалуй, самый сложный для понимания момент в области гиперссылок. Ка-

залось бы, для чего нужно придумывать лишнюю "прослойку" между источником 

ссылки и назначением в виде адреса. Для того чтобы это понять, давайте предста-

вим ситуацию, когда мы создаем 100-страничный документ, на каждой странице 

которого в том или ином месте указывается ссылка на сайт одной и той же компа-

нии в виде "Моя Компания". По нажатию на это имя подразумевается, что у поль-

зователя открывается браузер, в адресной строке которого уже указано 

http://www.mycompany.com/. В процессе создания документа вы создали 100 од-
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нотипных ссылок на один и тот же сайт. И все, казалось бы, хорошо, но в послед-

ний день заказчик решил изменить адрес сайта, куда будет идти ссылка, к примеру, 

на такой http://www.mycompany.com/advertising.html/, и поместить там информа-

цию о какой-либо акции. Согласитесь, не такой уж и редкий случай. А теперь пред-

ставьте, сколько времени потребуется на изменение всех этих ссылок. К счастью, 

InDesign предлагает нам уникальную модель работы со ссылками. Это и есть уже 

знакомые вам Hyperlink Destinations. В чем же отличие? В случае работы с ними, 

мы бы один раз создали пункт назначения http://www.mycompany.com/ и при соз-

дании ссылок просто привязывали бы абсолютно любые источники вида "Моя 

Компания", "Компания", "О компании" и т. д. к созданному назначению ссылки. 

А теперь, внимание, в тот момент, когда заказчик решил изменить адрес сайта, про-

сто заходим в пункт контекстного меню Hyperlink Destination Options палитры 

Hyperlinks и меняем адрес. Все наши ссылки, т. к. они вели на сайт не на прямую, а 

через условную "прослойку" в виде назначения ссылки, автоматически снова ста-

новятся правильными. Вот и весь фокус. 

Теперь, когда нам стало понятно, что такое Shared Destination, вернемся к диало-

говому окну New Hyperlink. Раскрывающийся список Document позволяет нам 

выбрать назначение ссылки не только из документа, с которым мы работаем, но 

также из любого ранее созданного документа. Это дает возможность работать над 

достаточно сложными мультимедийными проектами, состоящими их двух и более 

документов. 

Теперь обратимся к нижней части этого диалогового окна (см. рис. 1.17). Во-

первых, в раскрывающемся списке Style нам предоставляется возможность выбрать 

стиль для внешнего вида ссылки — давайте выберем URL (он был заранее подго-

товлен в палитре Character). Самая нижняя группа элементов данного диалогового 

окна называется Appearance и отвечает за внешний вид ссылки, но не в рабочем 

файле InDesign, а в окончательной публикации в программе просмотра PDF-

документов, такой как, к примеру, Adobe Acrobat Reader. Список Type дает воз-

можность выбрать, будет ли видна (Visible Rectangle) или скрыта (Invisible 

Rectangle) зона чувствительности в форме прямоугольника вокруг ссылки. Список 

Highlight указывает, как ссылка будет "подсвечена", т. е. выделена в тексте — под-

черкиванием, инвертированным цветом либо полужирным начертанием; с по- 

мощью опции None можно отключить изменение выделения, что мы и сделаем  

(рекомендуется всегда оставлять настройки внешнего представления в состоянии, 

которое мы только что настроили, т. к. они работают только на уровне программы 

просмотра и могут нарушить те дизайнерские свойства, которые мы внедряем в 

InDesign). После всех изменений нажмем кнопку OK. В нашем документе про-

изошло два принципиальных изменения. Во-первых, как вы видите, изменился цвет 

ссылки. Это произошло потому, что мы задали определенный стиль для внешнего 

представления ссылок ("URL"). Во-вторых, в палитре Hyperlinks появилась новая 

ссылка. Чтобы внести какие-либо изменения в данную конкретную ссылку, все, что 

нам нужно сделать, — это дважды щелкнуть по ней в палитре. Откроется диалого-

вое окно Edit Hyperlink, внешне ничем не отличающееся от знакомого нам окна 

создания новой ссылки. Для того чтобы закрыть его без изменений, нажмем кнопку 
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Cancel. Обратите также внимание на две кнопки в виде стрелок внизу палитры 

Hyperlinks. Нажатие на левую приводит нас к источнику ссылки, нажатие же на 

правую — к открытию браузера на адресе нашего пункта назначения. 

Давайте создадим еще несколько ссылок. Если мы перейдем на пятую страницу 

нашей публикации, то увидим слева похожую панель с данными о клиенте. Давайте 

снова выделим адрес сайта www.polylab.org, нажмем внизу палитры Hyperlinks 

кнопку New Hyperlink, но на этот раз в раскрывающемся списке Link To выберем 

уже другой тип ссылки — URL (рис. 1.18). В данном случае мы можем создать 

прямую ссылку на сайт. 

 

Рис. 1.18. Вид диалогового окна New Hyperlink в режиме URL 

Однако обратите внимание на опцию Shared Hyperlink Destination в группе эле-

ментов Destination. В случае если она выбрана вместе со ссылкой, на основе ее 

данных будет создан также пункт назначения, который, в последующем, можно  

будет использовать при создании новых ссылок. Если же эту опцию отключить, 

будет создана обычная ссылка без привязки к пункту назначения и с возможными 

трудностями, о которых говорилось выше. 

Как резюме, можно отметить, что, если вы создаете хотя бы две ссылки, идущие  

к одному и тому же пункту назначения (дальше мы поймем, что им может быть не 

только сайт), настоятельно рекомендуется использовать Shared Hyperlink 

Destination. В случае же "одноразового" использования ссылки, вполне допустимо 

и даже рекомендуется обходиться без создания дополнительного назначения. 

Рассмотрим дополнительные виды ссылок, которые InDesign позволяет нам создать 

(рис. 1.19). 

Первый из них — File — дает возможность по нажатию на ссылку осуществлять 

открытие заранее заданного файла. Необходимо помнить, что в случае, если вы-
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бранный файл требует специального программного обеспечения для открытия, он 

будет открыт в своем "родном" приложении, за которым он закреплен на пользова-

тельском компьютере. К сожалению, InDesign не предоставляет нам возможность 

принудительно определить, каким приложением будет открываться файл. 

 

Рис. 1.19. Типы поддерживаемых ссылок 

Следующий тип ссылки — Email — определяет ссылки на почтовые адреса. 

Еще один тип — Page — дает нам возможность определять страницу в документе, 

на которую будет осуществляться переход. Причем не только в документе, с кото-

рым мы работаем в настоящий момент, но и в любом другом выбранном проекте. 

Последний тип ссылок, которые можно создавать — Text Anchor, — текстовые 

якоря. Обратите внимание на то, что если мы создаем данный вид ссылки впервые, 

в выпадающем меню Text Anchor вы ничего не обнаружите. Давайте создадим но-

вый текстовый якорь и посмотрим, для чего они необходимы. Для этого закроем 

диалоговое окно New Hyperlink, нажав кнопку Cancel, и выделим какой-либо 

фрагмент текста в нашем документе, к примеру, название проекта, выбрав в кон-

текстном меню New Hyperlink Destination, мы увидим, что по умолчанию в типе 

назначения ссылки установлено Text Anchor. Оставим это без изменений, как и 

имя вновь создаваемого пункта назначения, после чего нажмем кнопку ОK. Снова 

выделим адрес сайта www.polylab.org, нажмем внизу палитры Hyperlinks кнопку 

New Hyperlink, выберем Text Anchor в качестве типа ссылки. Практически ничего 

не изменилось по сравнению с прошлым разом, но теперь в списке Text Anchor мы 

можем выбрать тот текстовый якорь, который только что создали. Таким образом, 

мы можем создавать текстовые якоря в качестве пунктов назначения для наших 

ссылок. 

Теперь давайте займемся созданием ссылок других типов. Для этого перейдем на 

вторую страницу нашей публикации, где внизу вы увидите адрес электронной поч-

ты дизайнера. Мы не будем заранее создавать для данной ссылки отдельный пункт 

назначения и сразу же, выделив e-mail, нажмем кнопку New Hyperlink. После этого 

поменяем тип ссылки на Email. В открывшихся свойствах в поле Address нужно 

ввести адрес, на который будет отправляться письмо по щелчку на эту ссылку, а  

в поле Subject Line — тема отправляемого письма. Опция (флажок) Shared 

Hyperlink Destination, как и ранее, отвечает за автоматическое создание пункта 

назначения, в данном случае для е-mail. Давайте оставим ее включенной. Изменим 
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стиль внешнего представления ссылки на Email, также ранее созданный в палитре 

Character Styles. После нажатия кнопки OK вы увидите, что цвет ссылки поменял-

ся, а в палитре Hyperlinks появилась новая ссылка. 

Итак, мы попробовали создавать ссылки на URL-адреса и адреса e-mail. Теперь да-

вайте разберемся, как работают ссылки на страницы внутри документа и на стра-

ницы внешнего документа. До этого момента мы всегда создавали ссылки на осно-

ве текста. Однако InDesign не ограничивает нас этим. Мы также можем сделать 

ссылкой абсолютно любой фрейм (прямоугольная область, ограничивающая блок 

графической либо текстовой информации в InDesign) внутри нашего документа. 

Для начала, создадим новый пункт назначения на страницу нашего документа.  

Для этого через контекстное меню откроем диалоговое окно New Hyperlink 

Destination, в раскрывающемся списке Type удостоверимся, что выбран тип Page, 

в качестве назначения укажем десятую страницу, а в режиме масштабирования — 

Fit in Window (подогнать под размер окна), после чего нажмем кнопку OK. Откро-

ем первую страницу нашей публикации и выделим фрейм, в котором находится 

надпись "Портфолио", после чего нажмем кнопку New Hyperlink. Далее выберем 

Shared Destination в качестве типа ссылки и Page 10 в раскрывающемся списке 

Name (рис. 1.20). 
 

 

Рис. 1.20. Создание ссылки из графического объекта  
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Для подтверждения нажмем кнопку OK. Как вы уже поняли, только что мы создали 

ссылку на страницу нашего документа, и, как подтверждение этому, обратите вни-

мание на панель Hyperlinks. Рядом с вновь созданной ссылкой мы видим значок в 

виде листка бумаги, отличающийся от значков рядом с другими ссылками. Если 

теперь нажать кнопку GoToDestination (правая стрелка в нижней части панели 

Hyperlinks), то мы окажемся на десятой странице нашей публикации, чего мы и 

пытались добиться. 

К сожалению, при выборе в качестве источника ссылки фрейма, содержащего гра-

фический объект, меньший по размеру самого фрейма или отличающийся от него 

по форме, могут возникнуть некоторые проблемы. Для того чтобы их понять, вновь 

обратимся к первой странице нашей публикации. На ней вы видите наклонные объ-

екты, стоящие очень близко друг к другу. Выделив по очереди несколько из них, вы 

обратите внимание на то, что фреймы, в которые они вписаны, на самом деле не 

только значительно отличаются по форме и габаритам от самих изображений, но и 

пересекаются друг с другом в некоторых местах. Предположим, что мы хотим сде-

лать систему ссылок на основе этих изображений, каждое из которых переводило 

бы нас на соответствующую страницу портфолио. Здесь важно знать, что InDesign 

при работе с такого типа ссылками учитывает не форму самого изображения, а 

прямоугольную рамку вокруг него — так называемый Bounding Box или габарит-

ный контейнер. Таким образом, создав ссылки из данных изображений, мы полу-

чим проблему, заключающуюся в том, что "чувствительные" к нажатию области 

ссылок будут пересекаться, что приведет к возникновению мест с непредсказуемым 

поведением во время нажатия. В связи с этим, будьте осторожны при создании ги-

перссылок, источником которых служат фреймы с графическими данными, и все-

гда дополнительно проверяйте возможность пересечения их областей действия. 

В данном разделе мы изучили весь спектр возможных видов гиперссылок, которые 

можно внедрять в интерактивный документ InDesign. В следующем разделе мы по-

говорим, пожалуй, о самом значимом элементе при создании интерактивных доку-

ментов — о кнопках. 
 

Обзор возможностей работы  

с кнопками и интерактивными формами 

В предыдущем разделе мы говорили о том, каким образом в InDesign осуществля-

ется работа с гиперссылками, рассмотрели их различные типы и проанализировали, 

для чего они необходимы. В этом же разделе мы познакомимся со спецификой и 

методами работы с одним из самых важных элементов интерактивного докумен-

та — кнопками в InDesign. 

Все взаимодействие с кнопками, их создание, удаление, редактирование, придание 

им различных свойств и визуальных эффектов — все это и много другое делается  

в InDesign CS6 через палитру Buttons and Forms, вызываемую с помощью меню 

Window > Interactive > Buttons and Forms (рис. 1.21). 
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Рис. 1.21. Вид палитры Buttons and Forms 

При открытии палитры вы можете обратить внимание на то, что практически все 

функции в ней не активны. Все это потому, что в настоящий момент на нашей ра-

бочей области не выделен ни один объект. 

Давайте сначала поговорим про то, что, собственно, такое кнопки. Любая кнопка, 

по сути, это некоторый катализатор, вызывающий возникновение какого-либо дей-

ствия или ряда действий. В InDesign мы можем создавать кнопку из любого фрей-

ма, или группы фреймов, будь то графические, текстовые или вообще пустые. На 

второй странице нашей публикации в правом нижнем углу вы можете обнаружить 

графический векторный объект, состоящий из двух окружностей разных цветов, 

наложенных друг на друга. Давайте попробуем из этого объекта создать нашу пер-

вую кнопку. 

Обратите внимание, что эти два круга не сгруппированы. В InDesign мы можем 

создать как одну кнопку за раз, так и несколько, просто выделив несколько объек-

тов. Таким образом, если есть необходимость создать одну кнопку, все графические 

или текстовые объекты в ней должны быть объединены в одну группу. В против-

ном же случае каждый из объектов станет самостоятельной кнопкой. 

Итак, для создания кнопки необходимо щелкнуть по значку Convert to Button, 

расположенному в нижней части палитры Buttons and Forms. Посмотрим, что 

произошло. Мы создали сразу же две кнопки, т. к. наш объект до сих пор не был 

сгруппирован. Если вы не видите никаких изменений, нажмите клавишу <W> или 

используйте пункт меню View > Screen Mode > SWF Preview для того, чтобы вый-

ти из режима просмотра. Обратите также ваше внимание на особый вид рамки, об-

рамляющий кнопку в виде пунктирной линии, под которой находится сплошная. 
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Если вы не видите эту рамку или специальный значок в виде кнопки в правом ниж-

нем углу рамки, используйте пункт основного меню InDesign View > Extras > Show 

Frame Edges либо сочетание горячих клавиш <Ctrl>+<H>. Настоятельно рекомен-

дуется всегда оставлять фрейм и данные значки видимыми в течение всей работы, 

т. к. они будут давать информацию о том, с каким типом объектов мы работаем. 

Вернемся к нашим кнопкам. Нам, на самом деле, не нужно сейчас создавать две 

отдельные кнопки, поэтому выберем пункт меню Edit > Undo или же используем 

сочетание горячих клавиш <Ctrl>+<Z> для того, чтобы отменить создание кнопки. 

Теперь, до создания нашей кнопки, сгруппируем обе окружности посредством  

команды меню Object > Group либо же с помощью сочетания горячих клавиш 

<Ctrl>+<G>. После этого вновь нажмем кнопку Convert to Button (рис. 1.22). 

 

Рис. 1.22. Вид палитры Buttons and Forms после создания кнопки  

Как вы видите, в панели Appearance палитры Buttons and Forms также произошли 
некоторые изменения. Давайте поговорим об этой панели подробней. В данном 
случае Appearance можно понимать как внешний вид кнопки. У этой панели, как 
мы видим, есть три строки или три состояния. В настоящий момент создано только 
одно — Normal. Это стационарное положение кнопки, когда с ней не происходит 
никаких действий, и нет никаких "влияний" на нее. 

Давайте щелкнем по строке Rollover, т. е. наведение. Как вы видите, теперь у нас 

появилось еще одно состояние кнопки. Оно описывает внешний вид кнопки при 
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условии попадания в ее область действия курсора мыши, проще говоря, при наве-

дении на кнопку стрелки. Третье и последнее состояние, которое можно создать 

сейчас, это Click, т. е. щелчок. Как нетрудно догадаться из названия, оно описывает 

внешний вид кнопки при осуществлении щелчка мыши по ней. 

Каждое из вышеописанных состояний может быть модифицировано независимо 

друг от друга. Давайте перейдем к состоянию Rollover, выделим внутренний круг и 

поменяем его цвет. Как вы видите, в панели Appearance отразились изменения  

и коснулись они только лишь выбранного состояния, т. е. Rollover, все же осталь-

ные строки остались неизменными. Если вы будете переключаться между этими 

строками, то вы также увидите, что в рабочей области в зависимости от выбранного 

состояния будет отображаться только его внешнее представление. 

Давайте теперь для состояния Click уже известным вам способом изменим цвет 

внутреннего круга на какой-нибудь третий. Таким образом, мы получили три раз-

личных состояния для этой кнопки (рис. 1.23). 
 

 

Рис. 1.23. Вид панели Appearance палитры Buttons and Forms  
после настройки внешнего вида кнопки 

 

Давайте перед тем, как мы перейдем к рассмотрению верхней части палитры 

Buttons and Forms, попробуем просмотреть то, что у нас получилось. Мы, конеч-

но, можем сделать это, экспортировав наш проект в PDF или Flash, но это может 

занять у нас много времени. Для осуществления режима просмотра в InDesign су-

ществует другая функция — палитра SWF Preview. Для ее вызова обратимся  

к пункту основного меню InDesign Window > Interactive > SWF Preview 

(рис. 1.24). 

Рассмотрим эту палитру немного подробней. В правом нижнем углу здесь имеются 

три кнопки, отвечающие за режим просмотра. Если выбрана правая (соответствует 

сочетанию горячих клавиш <Ctrl>+<Alt>+<Shift>+<Enter>), включается режим 

просмотра всего документа. В случае, к примеру, нашего документа, в котором по-

рядка десяти страниц, его загрузка может занять достаточно много времени. По-

этому существует центральная кнопка (сочетание горячих клавиш <Ctrl>+<Shift>+ 

+<Enter>), при нажатии на которую включается режим загрузки просмотра текущей 

страницы, что существенно уменьшает время ожидания. Однако если вы работаете 

с достаточно сложным документом, на каждой странице которого по несколько ин-

терактивных элементов, при текущих манипуляциях бывает удобно просматривать 

только один конкретный элемент. Для этого и создана кнопка просмотра выделен-

ного элемента, расположенная слева в этой группе. 
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Рис. 1.24. Вид палитры SWF Preview 

Теперь, если мы вернемся к публикации, убедимся, что выделена именно созданная 

кнопка, и нажмем значок  (Play), расположенный в левом нижнем углу палитры 

SWF Preview, мы увидим нашу кнопку. Убедитесь, что при наведении и нажатии 

на нее она приобретает цвет, соответствующий ее состояниям, заданным в панели 

Appearance. 

Теперь, когда мы увидели, что все работает корректно, давайте вернемся к палитре 

Buttons and Forms и разберем еще ряд дополнительных опций. Когда кнопка соз-

дана и выделена, на месте создания новой кнопки появляется другая — Convert 

Button to Object, которая позволяет превратить кнопку обратно в объекты, т. е. ра-

зобрать ее. Причем внешний вид получаемых объектов определяется тем состояни-

ем, которое было выбрано в момент нажатия в панели Appearance. Информация  

об остальных состояниях будет просто удалена. Для того чтобы попробовать это, 

выберите состояние Rollover и нажмите кнопку Convert Button to Object. После 

этого вы можете разгруппировать полученный объект с помощью меню Object > 

Ungroup или горячих клавиш <Shift>+<Ctrl>+<G> и удостовериться, что теперь это 

снова обыкновенные векторные окружности. 

Вернитесь к состоянию, когда этот объект был кнопкой, несколько раз нажав соче-

тание горячих клавиш <Ctrl>+<Z>. Мы также можем скрывать или отображать  

определенные состояния наших кнопок, нажимая значок в форме глаза в строке 
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состояния панели Appearance. Если же вы хотите полностью удалить состояние, а 

не просто скрыть его, то выделите нужное и нажмите кнопку Delete optional state 

and its content в форме мусорного ведра в правом нижнем углу палитры Buttons 

and Forms. 

Итак, разобравшись с тем, как управлять внешним представлением кнопок, давайте 

попробуем поработать над их функционалом. Чтобы вам было понятно устройство 
работы кнопок в InDesign, давайте разделим любую манипуляцию с интерактивны-

ми объектами на три основных составляющих: 

1. В каком объекте фиксируются события, т. е. с каким объектом идет работа. 

2. Вследствие чего происходит действие, т. е. какие события предшествуют дей- 

ствию. 

3. Какое действие или действия, собственно, происходят. 

Теперь обратимся к верхней части палитры Buttons and Forms. В первую очередь, 
дадим нашей кнопке имя — напишем в поле Name "test button" (рис. 1.25). Все 

имена для любых интерактивных функций или объектов рекомендуется давать  
с помощью латинских букв. Это наш первый пункт — то, в каком объекте будут 

фиксироваться события. 

 

Рис. 1.25. Список возможных событий в графе Event палитры Buttons and Forms 

После того как кнопка названа, обратимся к следующей строке, а точнее раскры-

вающемуся списку, который называется Event. Этот список указывает на то, что 

должно произойти с кнопкой для запуска ее действия, т. е. пункт 2. По умолчанию 

выбрано событие On Release or Tap, что означает совершить действие после того, 

как пользователь отпустит кнопку мыши (при этом курсор должен находиться над 

кнопкой) или нажмет на кнопку пальцем в случае использования сенсорного экра-

на. Обратите внимание, что кроме этого события в списке имеется очень похо-

жее — On Click. В чем же их принципиальное отличие? 

Представьте, что вы, к примеру, находитесь на каком-либо сайте, находите нужную 

вам ссылку или кнопку и, наведя на нее маркер, уже нажимаете на кнопку мыши 

(событие On Click), но в последний момент решаете перейти по другой ссылке, от-

водите мышь с нее и отпускаете (событие On Release or Tap, но уже вне зоны дей-

ствия кнопки). Как вы знаете, никаких действий не произойдет, т. к. в любых сис-
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темах взаимодействия с пользователем разработчики дают им возможность в по-

следний момент "передумать". В случае с On Click переход осуществлялся бы сра-

зу же после щелчка, не дожидаясь момента отпускания кнопки мыши. В связи  

с этой особенностью всегда старайтесь для своих кнопок использовать действие On 

Release or Tap, если для другого нет особых причин. 

Обратимся снова к раскрывающемуся списку Event. Кроме вышеперечисленных, 
там есть еще ряд параметров. Это, в первую очередь, On Roll Over, из названия 
которого вам должно уже быть понятно, что это событие описывает наведение кур-
сора мыши на кнопку, и On Roll Off, отвечающее за обратный процесс, т. е. выход 
курсора из области действия кнопки. 

Две остальные опции, On Focus (PDF) и On Blur (PDF), являются достаточно спе-
цифическими и присущи только при сохранении публикации в формате PDF. Пер-
вая отвечает за состояние, когда с помощью клавиши <Tab> пользователь "попада-
ет" на какой-либо элемент, такое состояние объекта называется "в фокусе", вторая 
же кнопка отвечает за обратное действие, т. е. когда фокус покидает конкретную 
кнопку. Оставим для нашей кнопки событие On Release or Tap. 

Итак, когда мы определились, вследствие какого события с кнопкой будет проис-
ходить то или иное действие, давайте перейдем к следующему этапу подготовки 
кнопки — формулировки того самого действия. Для этого обратимся к панели 
Actions или действиям, которые, как вы уже догадались, описывает пункт 3 нашего 
списка. 

Для того чтобы добавить какое-либо действие нашей кнопке, нужно нажать на 
кнопку Actions в виде плюса "+" в верхней части этой панели (рис. 1.26). Немало-
важно, что мы можем добавлять не только одно действие, но и целую последова-
тельность различных действий. Кроме того, InDesign дает возможность создавать 
действия для разных событий у одного объекта, например, по нажатию кнопки и по 
наведению на нее курсора могут быть созданы различные действия. 

Как вы видите, список действий кнопки достаточно обширен. Он разделен на три 
раздела. Первая группа действий может быть осуществлена и в PDF- и во Flash-
файлах. Вторая применима только во Flash-файлах, третья, соответственно, только 
в PDF. Для начала давайте выберем самое первое действие в списке: Go To 

Destination (перейти к пункту назначения). После его выбора нам станет доступен 
ряд дополнительных настроек. Во-первых, мы можем выбрать документ назначе-
ния. Во второй строке мы можем выбрать из списка, собственно, место, куда будет 
осуществляться переход. Как видите, здесь их достаточно много, но откуда они 
здесь взялись? На самом деле, все эти пункты назначения — не что иное, как за-
кладки, которые мы с вами создали ранее, и если вы откроете палитру Bookmarks, 
то вы их там увидите. Последняя строка отвечает за настройки масштабирования и 
тоже вам знакома. Единственное изменение здесь по сравнению с тем, что мы уже 
видели — это пункт Inherit Zoom, что значит наследовать настройки масштабиро-
вания из текущего состояния документа. 

Для примера, установим в поле Destination палитры Buttons and Forms значение 
Work 01, а для Zoom укажем Fit in Window, поле Document оставим без измене-
ний, т. к. мы продолжаем работать внутри одной публикации. 
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Рис. 1.26. Список возможных действий после нажатия кнопки Actions  
в виде плюса "+" палитры Buttons and Forms 

Теперь, после того как мы применили все настройки к нашей кнопке, можно по-

смотреть, что у нас получилось. Но не торопитесь открывать палитру SWF 

Preview. В данном случае, т. к. у нас имеет место переход между страницами, не-

обходимо запустить просмотр всего проекта целиком. Для этого в палитре Buttons 

and Forms предусмотрена кнопка Preview Spread, расположенная в левом нижнем 

углу палитры (рис. 1.27), которая является быстрым способом запустить панель 

SWF Preview. 

 

Рис. 1.27. Кнопка Preview Spread в палитре Buttons and Forms 
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Нажмем ее и посмотрим на результат. На первой странице мы видим нашу кнопку. 

При наведении на нее она меняет цвет. Обязательно попробуйте нажать на нее и, 

отведя курсор, отпустить. Ничего не должно произойти. А вот если же нажать и 

отпустить кнопку мыши, пока курсор находится в области действия кнопки, мы 

переходим на последнюю страницу публикации. Поздравляю вас, мы запрограмми-

ровали первый интерактивный элемент. Впереди еще очень много нового, но те 

принципы, которые мы сейчас освоили, мы будем использовать на протяжении 

всей работы. Так что если какой-то момент остался не до конца понятен, пожалуй-

ста, еще раз попробуйте сделать то же самое самостоятельно. Если же все понятно, 

то давайте продолжим. 

Обязательно обратите внимание еще на одну немаловажную особенность. В ниж-

ней части палитры Buttons and Forms в разделе PDF Options мы в поле 

Description можем задать описание для кнопки, которое будет появляться при на-

ведении на нее мыши в программе просмотра либо произноситься компьютером, 

если это специальным образом задать. Это необходимо для поддержки функций 

для людей с ограниченными способностями. Если ваша целевая аудитория включа-

ет данную группу людей, не забывайте об этой функции. 

Создание кнопок  
для системы постраничной навигации 

В прошлом разделе мы научились создавать простейшие кнопки в нашей интерак-

тивной среде посредством палитры Buttons and Forms и проверять полученный 

результат с помощью палитры SWF Preview. В этом разделе мы займемся развити-

ем этих навыков и создадим в нашей публикации систему постраничной навигации, 

т. е. набор кнопок для перехода к следующей и предыдущей странице. 

В первую очередь, давайте удалим созданную ранее кнопку, т. к. она нам больше не 

понадобится. После этого перейдите в палитру Layers и отобразите слой, который 

называется navigation bar. Обратите внимание в нижней части нашей публикации 

на появившиеся кнопки со стрелками; именно они и будут, в конечном итоге, реа-

лизовывать систему навигации. К ним мы очень скоро вернемся, а пока что давайте 

разберемся с мастер-страницами в нашей публикации. Если вы посмотрите в раздел 

с ними в палитре Pages, то увидите, что там находится три основных мастера 

(рис. 1.28). 

Давайте, в первую очередь, откроем мастер B-Navigation. Здесь внизу расположе-

ны две кнопки для перемещения на предыдущую страницу и на следующую соот-

ветственно. Если вы откроете один из мастеров A-Cover или С-Goodbye, то  

увидите, что они специально созданы для первой и последней страницы публика-

ции, т. к. на них отсутствуют кнопки перехода на предыдущую страницу для пер-

вой и перехода на следующую для последней, соответственно. Не трудно догадать-

ся, почему это сделано именно так — перед первой и после последней просто нет 

других страниц. Заметьте также, что оба мастера, и A и С, основаны на мастере  

B-Navigation. Это сделано путем нажатия правой кнопкой мыши на нужном масте-

ре, затем выбором пункта из появившегося контекстного меню Master Option for 
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<Название мастера>... и указанием в открывшемся диалоговом окне Master 

Options в раскрывающемся списке Based on Master имени родительского мастера 

(рис. 1.29). 

 

Рис. 1.28. Вид палитры Pages c мастер-страницами 

 

Рис. 1.29. Вид диалогового окна Master Options 

Как вы можете увидеть, в мастерах A и С указан в этом списке B-Navigation. Это 

также указано рядом с названием мастера в палитре Pages в виде маленькой буквы 

B на значке мастера. 

Так как некоторые элементы на мастерах A и С унаследованы от родительского 

мастера, то с ними невозможно работать в своих мастерах. Для того чтобы это ис-

править, необходимо "поднять" эти элементы на уровень текущих мастеров. Для 

этого нужно, держа одновременно нажатыми клавиши <Ctrl>+<Shift>, щелкнуть по 

нужному нам элементу. 

Теперь, когда структура документа нам понятна, давайте вернемся к мастеру  

B-Navigation и начнем создавать кнопки. Для начала выделите элемент, который 

станет кнопкой. Обратите внимание на то, что в "стопке" он лежит поверх всех  
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остальных элементов. Это немаловажный момент для корректного отображения 

макета при сохранении в формате PDF. В этом формате все кнопки всегда отобра-

жаются поверх остальных элементов. Даже если в изначальном документе это было 

иначе, при сохранении кнопка обязательно окажется наверху. Всегда помните об 

этом при создании интерактивных элементов. 

После того как элемент для кнопки выделен, откройте палитру Buttons and Forms 
и создайте из него кнопку. Также создайте кнопку из маленькой цветной стрелки 
рядом с планируемой кнопкой. Тем самым мы хотим сделать такое визуальное 
представление системы навигации, при котором при наведении курсора мыши на 
кнопку перехода на следующую либо предыдущую страницу отображались бы ма-
ленькие стрелки справа или слева от кнопок соответственно. 

Для маленькой цветной стрелки, которая уже стала кнопкой, укажите опцию 
Hidden Until Triggered в палитре Buttons and Forms. Эта опция (флажок) указы-
вает на то, что кнопка при старте проекта будет скрыта и будет отображена только 
после того, как это будет указано специальной функцией по действию какого-либо 
другого элемента. Не пугайтесь, скоро все станет понятно. Сразу же дайте этой 
кнопке имя, к примеру PageNavNextRollover. Не ленитесь давать кнопкам осознан-
ные имена, иначе вы рискуете запутаться в них, как только количество возрастет. 
Перейдите к основной кнопке и дайте ей имя PageNavNext для перехода на сле-
дующую страницу. 

После того как кнопки названы, займемся описанием их действий. По сути, все 
действия будет делать у нас кнопка PageNavNext, а PageNavNextRollover будет 
просто служить визуальной индикацией для нее. Поэтому выделите кнопку 
PageNavNext и на событие On Roll Over задайте действие Show/Hide Buttons and 

Forms. После этого внизу палитры появится панель Visibility с опциями отображе-
ния для всех кнопок, имеющихся в проекте (рис. 1.30). 

Для того чтобы менять эти настройки, можно щелкать по переключателю рядом  
с названием кнопки. При этом крестик " " означает, что в данном действии с этой 
кнопкой не будет происходить изменение состояния ее видимости, а открытый глаз 
" " будет указывать программе, что необходимо отобразить указанную кнопку. 
Перечеркнутый же глаз подскажет системе, что ту или иную кнопку нужно скрыть. 
Все предельно просто. Как вы уже поняли, нам нужно отобразить кнопку 
PageNavNextRollover. Для этого поставим рядом с ней открытый глаз. 

Теперь, раз у нас есть событие, вызывающее отображение стрелки, нужно преду-
смотреть и обратное, позволяющее нам скрыть указатель после того, как курсор 
мыши покинет область действия кнопки навигации. Для этого у этой же кнопки на 
событие On Roll Off зададим действие Show/Hide Buttons and Forms, в опциях 
которого укажем скрыть видимость у кнопки PageNavNextRollover. Теперь, чтобы 
проверить, как все работает, выделите обе кнопки и нажмите на кнопку просмотра. 
Как мы видим, по наведению на кнопку появляется стрелка, после того как курсор 
меняет позицию, стрелка пропадает. Прекрасно, именно этого мы и хотели до- 
биться. 

После этого давайте придадим нашей кнопке основной функционал, для которого 

она создается, т. е. переход на следующую страницу публикации. Для этого зада-
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дим на событие On Release or Tap (почему именно это событие, а не On Click, 

подробно обсуждалось в прошлом разделе) нашей навигационной кнопки действие 

GoToNextPage, т. е. перейти к следующей странице. У этого действия в качестве 

опций достаточно в поле Zoom указать Fit in Window для отображения вновь от-

крывающейся страницы на все окно. Другие настройки у него отсутствуют. 
 

 

Рис. 1.30. Настройки отображения кнопок по действию Show/Hide Buttons and Forms  
в палитре Buttons and Forms 

 

Далее проделайте те же самые действия с кнопкой возврата к предыдущей странице 

за одним исключением. На событие On Release or Tap необходимо задать действие 

Go To Previous Page, т. е. перейти на предыдущую страницу. Ну и, конечно же, не 

забывайте именовать свои кнопки, PageNavPrev и PageNavPrevRollover, к примеру. 

Когда мы создали кнопки для постраничного перехода вперед и назад по докумен-

ту, давайте проверим, что на других мастерах все кнопки отображаются правильно. 

Кажется, при изменениях, которые мы сделали, у нас на мастерах из родительского 
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мастера перезаписались лишние кнопки. Попробуйте выделить их, удерживая кла-

виши <Ctrl>+<Shift> и щелкнув по ним. К сожалению, ничего не получается. Здесь 

мы сталкиваемся с одной интересной особенностью InDesign. Возможно, это даже 

можно отнести к ошибкам в программе. Чтобы исправить эту ситуацию, нужно 

"перепривязать" дочерние мастера к родительскому. Для этого в каждом из масте-

ров А и C зайдите в диалоговое окно Master Option (как вы помните, это делается 

щелчком правой кнопки мыши по названию мастера и выбором соответствующего 

пункта из появившегося контекстного меню), в раскрывающемся списке Based on 

Master укажите None и нажмите кнопку OK. После этого снова зайдите в это диа-

логовое окно и верните значение списка Based on Master на B-Navigation. После 

осуществления этих процедур вы сможете выделить лишние элементы на дочерних 

мастерах (удерживая клавиши <Ctrr>+<Shift>) и удалить их. 

Теперь, когда все готово, можно посмотреть, что получилось, используя палитру 

SWF Preview и опцию просмотра всего документа целиком. 

Создание невидимых кнопок  
для реализации функций "всплывания" 

В прошлом разделе мы создали для нашего проекта систему навигации с реализа-

цией постраничного перехода. Мы также научились работать с интерактивными 

элементами в составе мастер-страниц. Далее мы продолжим работу с такими эле-

ментами, как кнопки и, используя уже знакомую нам методику отображения и 

скрывания кнопок, разберемся с тем, для чего нам могут быть полезны прозрачные 

кнопки или прочие невидимые интерфейсные элементы электронной публикации. 

Для начала, давайте перейдем на десятую страницу нашей публикации. Здесь вы 

можете увидеть карту, на которой имеются условные точки, обозначающие, в каких 

местах осуществлялся тот или иной проект фотографа. Давайте реализуем на этой 

странице такой интерактивный потенциал, при котором наведение пользователем 

мыши на один из этих кружков приводило бы к всплыванию "контекстного меню"  

с содержанием работы и ссылкой на соответствующую страницу нашей публика-

ции (для того чтобы увидеть их заготовки, отобразите слой map rollover images 

нашего проекта). Подобного рода интерактивные элементы называются HotSpot. Но 

вы, к сожалению, не найдете в InDesign панели или функции, отвечающей за реали-

зацию этой возможности, т. к. она также разрабатывается с помощью особого пове-

дения кнопок. 

Давайте сделаем все по порядку. В первую очередь рассмотрим внимательней, что 

собой представляет эта карта. По сути, это набор векторных графических элемен-

тов, в данном случае окружностей. Так как InDesign в своей интерактивной части 

работает на базе векторных объектов, важно понимать, что, к примеру, кнопка, соз-

данная из векторной окружности, будет иметь область действия, четко соответст-

вующую этой окружности, не больше и не меньше. Для того чтобы понять, как бу-

дет выглядеть область действия у любой вашей вновь создаваемой кнопки, просто 

подведите к ней указатель мыши и вы увидите, в зависимости от слоя, на котором 

размещен элемент, обводку соответствующего цвета. 
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Это-то и будет будущей областью влияния кнопки. В случае с нашим электронным 

изданием, на звание кнопок претендуют маленькие оранжевые круги (рис. 1.31). 

Попробуйте подвести к ним указатель мыши. Согласитесь, достаточно сложно даже 

попасть в них, не говоря уже о том, чтобы зафиксировать указатель и нажать на 

нее. Исходя из этого, логично было бы увеличить элементы, однако это может раз-

рушить нашу дизайнерскую идею. Что ж, именно в таких ситуациях на помощь 

приходят невидимые кнопки или hotspot'ы. 

 

Рис. 1.31. Внешний вид заготовки для кнопки 

Для того чтобы создать подобный объект, выделим второй и третий всплывающие 

элементы и выберем из основного меню InDesign Object > Hide либо используем 

комбинацию горячих клавиш <Ctrl>+<H>. Работу продолжим с первым всплываю-

щим блоком. 

Откроем панель Buttons and Forms и любым известным нам способом создадим из 

открытого блока кнопку и назовем ее, к примеру, MapImage1. После этого слой со 

всплывающими панелями можно на какое-то время скрыть, чтобы он не мешал нам 

работать с другими элементами. 

Теперь выделите маленький кружок, соответствующий первому всплывающему 

блоку, и скопируйте его посредством команды меню Edit > Copy или с помощью 

горячих клавиш <Ctrl>+<C>. После того как вы это сделали, создайте новый слой 

над текущим (а так как выделен маленький круг, текущим слоем будет content). 

Назовем его, например, HotSpots и сразу же после создания расположим его над 

всеми слоями, т. е. на самом верху палитры Layers. После того как слой будет го-

тов и помещен наверх, вставьте в него скопированную ранее окружность. Однако 

необходимо, чтобы она была помещена точно в то самое место, откуда была скопи- 

рована. Чтобы обеспечить это наиболее быстрым путем, выберите в основном ме-

ню пункт Edit > Paste in Place или используйте сочетание горячих клавиш 

<Ctrl>+<Shift>+<Alt>+<V>. 
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Когда все готово, с помощью палитры Swatches присвойте вновь созданному 

кружку цвет None для заливки и обводки. После этого можно, с одновременно на-

жатыми клавишами <Shift> (пропорциональная трансформация) и <Alt> (транс-

формация из центра объекта), увеличить окружность в диаметре примерно в три-

четыре раза, как это вам покажется удобным (рис. 1.32). Теперь создадим из этого 

объекта кнопку с названием MapImageHotSpot1. 

   

Рис. 1.32. Форма и положение невидимой кнопки 

Не теряя времени, для этой кнопки на событие On Roll Over зададим действие 

Show/Hide Buttons and Forms с параметрами, делающими видимой кнопку 

MapImage1. На событие On Roll Off, соответственно, зададим обратное действие, 

т. е. скрыть кнопку MapImage1. 

Когда функционал для этой кнопки подготовлен, вновь отобразите слой map 

rollover images, а теперь немного поработаем с кнопкой MapImage1. В первую оче-

редь, не забудьте установить у нее опцию Hidden Until Triggered. 

Давайте на этом этапе посмотрим, что у нас получилось — нажмем клавиши 

<Ctrl>+<Shift>+<Enter>. Как вы видите, наведение на нашу немного увеличенную 

область приводит к отображению панели и выглядит весьма естественно, несмотря 

на то, что она явно больше непосредственно кнопки. Но, как вы наверняка обрати-

ли внимание, стоит нам убрать указатель мыши с области действия и навести, ска-

жем, на саму всплывающую панель, то она тут же пропадает. Это довольно просто 

исправить. Для этого достаточно просто задать у кнопки MapImage1 на событие On 

Roll Over действие Show/Hide Buttons and Forms с параметрами, отображающими 

ее саму, т. е. MapImage1, и на событие On Roll Off действие Show/Hide Buttons 

and Forms с параметрами, соответственно, скрывающими ее. Как бы странно это 

ни выглядело, если вы проверите, все будет работать четко и красиво. Теперь нам 

осталось только добавить на событие On Release or Tap этой кнопки действие по 

переходу на соответствующую страницу. Это можно сделать, добавив действие 

GoTo Page и указав номер страницы, на которую нужно осуществить переход. 

Поздравляю вас, вы создали свою первую невидимую кнопку или HotSpot 

(рис. 1.33). Как видите, этот элемент существенно расширяет интерактивные воз-

можности и дает широкий простор для творчества при создании электронных пуб-

ликаций. Если вы хотите потренироваться в создании этих кнопок, повторите то же 

самое для всплывающих блоков 2 и 3. 
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Рис. 1.33. Отображение всплывающего блока по наведению на невидимую кнопку 

Работа с интерактивными формами 

Начиная с версии CS6, в InDesign функции интерактивности значительно расшири-

лись, и к ним прибавилась возможность создавать сложные PDF-формы для запол-

нения. Для чего же они нужны? Представьте, к примеру, ситуацию, когда необхо-

димо осуществить быстрый опрос среди сотрудников компании. Стандарт PDF дает 

для этого уникальные инструменты. Вам достаточно распространить среди них 

специально созданную форму, после заполнения которой им будет достаточно про-

сто нажать на кнопку Submit или "Отправить", и она вместе с содержимым будет 

автоматически отправлена ее создателю, т. е. вам. Раньше для создания подобной 

формы требовалось использование пакета Adobe Acrobat Professional. Теперь же это 

элегантное решение получило развитие в InDesign. Давайте разберемся, каким об-

разом можно создавать данные формы. 

Для начала работы откройте нашу рабочую публикацию на странице одиннад-

цать — здесь находится заготовка для нашей формы. Стоит обратить внимание на 

то, что для просмотра и тестирования нашей интерактивной формы нам обязатель-

но будет нужен Adobe Acrobat. Если остальные интерактивные функции прекрасно 

работают в программах просмотра от сторонних производителей, то данная техно-

логия поддерживается только "родным" программным обеспечением Adobe. Па-
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литра SWF Preview, как следует из ее названия, к сожалению, также не подходит 

для тестирования иных функций, кроме кнопок. 

В первую очередь, давайте обратимся к текстовым полям (рис. 1.34). То, что вы ви-
дите перед собой в заготовке — это обыкновенный прямоугольник, к которому 
применены заливка и обводка. С помощью пункта главного меню Object > Corner 

Options также внесены изменения в форму углов фрейма. 

 

Рис. 1.34. Внешний вид элементов формы 

Для того чтобы превратить данный текстовый фрейм в поле для ввода, существует, 
помимо аналогичных способов, описанных ранее для кнопок, еще одна возмож-
ность. Просто щелкните по нему правой кнопкой мыши и в разделе Interactive по- 
явившегося контекстного меню выберите Convert to Text Field. 

При этом происходит автоматическое открытие палитры Buttons and Forms. Сей-
час нам нет необходимости добавлять к данному полю какие-либо дополнительные 
действия, поэтому давайте просто экспортируем данный документ в PDF с по- 
мощью команды главного меню File > Export и выберем в нижней части открыв-
шегося диалогового окна формат PDF (Interactive). Все опции экспорта можете 
оставить неизменными, о них мы поговорим чуть позже. Главное, необходимо про-
верить, что в разделе Forms and Media выбран пункт Include All. После этого 
можно нажать кнопку OK и посмотреть на результат. Как вы видите, цвет заливки 
и обводки сохранились, при этом форма была потеряна (рис. 1.35). 

Это происходит из-за того, что Acrobat пока не поддерживает отображение нестан-
дартной формы у текстовых полей. Наверняка, в следующей версии мы увидим и 
эту возможность. А пока мы можем просто конвертировать данный объект обратно  
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Рис. 1.35. Вид элемента формы после экспорта 

в простой текстовый фрейм, оставить его в качестве фона, а сверху наложить рабо-

чее поле без заливки и обводки. Точно так же как с кнопками, не забывайте давать 

всем интерактивным элементам, в том числе и полям, осознанные имена. Вы уже 

знаете, что впоследствии нам это пригодится. Если вы вновь откроете палитру 

Buttons and Forms, в ее разделе PDF Options существует ряд настроек, как раз 

созданных для регулирования поведения элементов на форме (рис. 1.36). В поле 

Description можно указать подсказку для пользователя, который будет работать  

с данной формой. Тогда, при наведении на объект курсора мыши, данная подсказка 

будет проявляться рядом с ним. 

Из опций, представленных далее, всего три идентичны для всех элементов и при-

дают объекту на форме ряд свойств. 

 Printable — объект будет виден при печати формы. 

 Required — объект обязателен для заполнения или выбора. Без этого форма не 

сможет быть отправлена. 

 Read Only — придаст данному элементу статус "только для чтения", т. е. уста-

новит запрет на его изменение. 

Для текстового поля существует три дополнительные опции. 

 Password — поле пароля, символы в котором отображаются при заполнении 

в виде звездочек. 

 Scrollable — определяет включение функции прокрутки при переполнении  

поля. 

 Multiline — позволяет создать поле, в котором будет несколько строк. В про-

тивном случае, весь текст в поле будет следовать одной непрерывной строкой. 

Еще одна настройка, которая здесь присутствует — Font Size — позволяет прину-

дительно задать размер шрифта, которым будет выполняться заполнение. При этом 

из-за особенностей пользовательских настроек на каждом индивидуальном компь-

ютере настоятельно рекомендуется для данной опции всегда устанавливать значе-
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ние Auto. В противном случае, пользователь может просто не увидеть символы, 

которые он набирает в поле. 

Когда мы разобрались со всеми опциями, продублируйте создание текстовых полей 

с разнообразными настройками для всех остальных заготовок. 

 

Рис. 1.36. Вид палитры Buttons and Forms при работе с текстовыми полями 

Теперь давайте перейдем к другому типу интерактивных элементов на форме — 

Check Box (кнопка-флажок с независимой фиксацией, установленное состояние 

обычно помечается "галочкой" либо "крестиком"). Объекты данного типа позволя-

ют пользователю выбрать один или несколько пунктов из списка, представленного 

перед ними. Каждая из ячеек может быть выбрана или отключена. Для его создания 

можно в рабочей области нарисовать прямоугольники. Если теперь определить его 

с помощью раскрывающегося списка Type палитры Buttons and Forms как Check 

Box (рис. 1.37), то вы увидите, что в разделе Appearance, в отличие от трех поло-

жений у кнопки, здесь присутствует целых четыре — два для выключенного 

(сброшенного) состояния и два для выбранного или включенного (установленного). 
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Рис. 1.37. Вид палитры Buttons and Forms при работе с элементом Check Box 

Вы можете создавать разнообразные собственные дизайны для данного типа управ-

ляющих элементов или же воспользоваться контекстным меню палитры Buttons 

and Forms и, выбрав в нем пункт Sample Buttons and Forms, подобрать необходи-

мый вид из уже готовых дизайн-решений. Еще один важный момент при работе  

с данным элементом заключается в том, что сам элемент Check Box и подпись  

рядом с ним на самом деле никак не связаны, поэтому, для того чтобы определить 

значение данного элемента, нам необходимо указать его в поле Button Value раз-

дела PDF Options в палитре Buttons and Forms. Последняя нерассмотренная нами 

опция — Selected by default — определяет, будет ли данный Check Box включен по 

умолчанию при запуске формы. 

Следующий элемент, который может присутствовать на интерактивной форме — 

это Radio button или кнопка-переключатель с зависимой фиксацией для выбора 

единственного значения среди представленных. Методика ее создания немного от-

личается от того, что мы делали ранее. Для того чтобы InDesign "понимал", что все 

кнопки относятся к одной группе и пользователь может выбрать, в конечном счете, 

только один вариант, нужно сначала создать все макеты кнопок, после чего только 

определять их функционал. Как пример, создайте на рабочем поле четыре окруж-

ности, соответствующие четырем пунктам выбора. После этого, выделив их одно-
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временно, определите их тип в палитре Buttons and Forms как Radio Button. Как 

вы видите, опции в разделе PDF Options совпадают с теми, что мы видели при ра-

боте с Check Box. Однако здесь имеется принципиальное отличие. Если ранее мы 

могли выбрать опцию Selected by default для каждого из элементов, здесь включе-

ние данной опции у одной кнопки автоматически отключает ее у всех других из 

одной группы (зависимая фиксация). 

Еще один интересный элемент в формах — Combo Box, позволяющий создавать 

раскрывающиеся списки значений. Для того чтобы снабдить его информацией, да-

вайте выделим заготовку "Занимаемая должность" и определим ей тип Combo Box 

(рис. 1.38). 

 

Рис. 1.38. Вид палитры Buttons and Forms при работе с элементом Combo Box 

 

В нижней части палитры Buttons and Forms вы увидите поле, в которое с по- 

мощью кнопки "+" (см. рис. 1.38) можно добавить элемент, название которого 

предварительно будет вписано в поле List Items. Кнопка "–" служит для удаления 

выделенного элемента. Здесь также присутствует новая опция (флажок) — Sort 
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Items, которая, как вы, наверное, уже понимаете, сортирует значения в списке в 

алфавитном порядке. Если вы хотите, чтобы какое-либо значение выводилось по 

умолчанию, то при открытии формы просто выберите его в данном списке. Здесь же 

с помощью простого перетаскивания можно менять последовательность элементов. 

Следующий элемент, который мы рассмотрим, называется List Box (окно списка 

для выбора) и, по сути, повторяет функционал предыдущего за небольшим исклю-

чением. Дело в том, что List Box представляет собой поле, в котором одновременно 

отображаются все элементы из заданного списка. Кроме того, если мы включим 

опцию Multiple Selection, у пользователя появится возможность одновременного 

выделения нескольких элементов. Во всем остальном данный объект полностью 

идентичен элементу Combo Box. 

Последний важный интерактивный элемент, который InDesign позволяет нам вне-

дрить, — это Signature Field или поле для цифровой подписи. По своему существу 

электронная подпись представляет собой реквизит электронного документа, позво-

ляющий установить отсутствие искажения информации в нем с момента формиро-

вания данной подписи и проверить принадлежность подписи владельцу сертифика-

та соответствующего ключа. Более подробную информацию об электронных  

подписях можно узнать по ссылке http://www.digitalsign.ru/ или в любом другом 

источнике. 

Итак, когда мы разобрались с тем, как обеспечить форму элементами для заполне-

ния, давайте решим вопрос с дальнейшей работой с ней. Для решения данной зада-

чи InDesign предлагает нам три действия для программирования кнопок. Первое — 

Clear Form — позволяет очистить нашу форму и привести ее состояние к тому, что 

было установлено по умолчанию. Второе — Print Form — позволяет распечатать 

форму; при этом учитываются те опции печати, которые мы задавали для каждого 

элемента. Наконец, последнее действие — Submit Form — как раз дает нам воз-

можность обеспечить сбор данных форм от разных пользователей. Для этого мы 

можем либо указать URL-адрес специального web-приложения, которое собирает 

данные из них, либо просто указать наш электронный адрес (e-mail), на который 

данная форма будет отправлена в виде вложения, в следующей форме "mailto: ваш 

e-mail адрес". 

Данные возможности позволяют нам создать уникальные формы для сбора данных 

или для любых других целей и существенно расширяют наши интерактивные воз-

можности при работе в InDesign CS6. 

Использование аудиофайлов в проекте 

В данном разделе мы научимся добавлять в наш проект аудиофайлы и настраивать 

для них разнообразные дополнительные опции, такие как, к примеру, управляющий 

компонент (виджет) и другие. 

Для того чтобы начать работу, отобразите слой Audio controllers в палитре Layers 
и перейдите на уже знакомый нам мастер B-Navigation. В нем, в правом верхнем 
углу, вы обнаружите эскизы управляющих кнопок для аудиозаписей. В нашем слу-
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чае на кнопку в форме треугольника мы будем закладывать функции запуска музы-
кальной композиции, на кнопку в форме квадрата — остановки воспроизведения. 
Окружность с ноткой внутри в качестве кнопки пока что использоваться не будет и 
будет просто служить пиктограммой, объясняющей предназначение рядом стоящих 
кнопок. Однако если вы хотите, то можете самостоятельно придумать для нее 
функцию, например смену музыкальной композиции. 

Итак, вернемся к кнопкам. Первое, что нам следует сделать при работе с мультиме-
дийными композициями, к которым относятся в том числе и аудиофайлы, — это 
загрузить данные о файле в наш проект. Для этого наряду с использованием пункта 
главного меню InDesign File > Place, вы также можете использовать сочетание го-
рячих клавиш <Ctrl>+<D>. В открывшемся окне выберите необходимый музыкаль-
ный файл, для нашей публикации это Music.mp3 из папки \Интерактивность нашей 
рабочей документации. InDesign CS6 воспринимает в качестве аудиофайлов только 
формат MP3. Если ваш файл находится в другом формате, то вам необходимо ис-
пользовать отдельную программу для его конвертации. После нажатия кнопки 
Open вы заметите, что курсор изменит форму, и это будет означать, что вы все сде-
лали верно, и теперь необходимо указать, на какое место следует вставить этот 
файл. Выберите любое место на листе и щелкните один раз мышью. После этого, 
для того чтобы соблюдать логику нашей слоевой структуры, переместите встав-
ленный файл на слой content. Проверьте, что вы находитесь в режиме отображения 
Normal; для этого выберите пункт меню View > Display Mode > Normal или ис-
пользуйте горячую клавишу <W>. Когда вы это сделаете, обратите внимание на то, 
что область, ограничивающая только что вставленный аудиофайл, будет заполнена 
диагональной штриховкой (рис. 1.39). 

 

Рис. 1.39. Отображение помещенного в проект музыкального файла 

Это означает, что эта область содержит в себе медиафайл. Значок в форме динами-

ка в верхнем левом углу дает нам понять, что это медиафайл — аудиозапись. Когда 

мы будем работать с медиафайлами других типов, вы обязательно обратите внима-

ние на изменение этого значка. 

При работе с любыми медиафайлами вы всегда должны держать в памяти, что они 

могут быть доступны для работы только в том случае, если расположены внутри 

рабочей области документа, т. е. в пределах листа. Причем, абсолютно не обяза-

тельно, чтобы весь фрейм попадал в эту область, достаточно просто, чтобы в ка-
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ком-либо месте было их пересечение и больше половины фрейма находилось на 

листе. Соблюдая эти несложные правила, вы сможете избежать проблем, которые в 

дальнейшей работе может быть весьма сложно диагностировать. 

Так как мы работаем на мастер-странице, здесь вы также можете наблюдать пре-

имущество использования наследования в мастерах. В случае с нашей рабочей 

публикацией вы можете, единожды внедрив медиафайл в родительский мастер  

(B-Navigation), автоматически получить его во всех дочерних мастерах (A-Cover, 

C-Goodbye). Кроме удобства, используя подобную компоновку, мы можем избе-

жать проблемы с одной параллельно играющей композицией, которая возникает 

при многократном помещении одного медиафайла на разные страницы или масте-

ра. В качестве резюме запомните, что желательно всегда создавать компоновку 

мастер-страниц проекта таким образом, чтобы не происходило дублирование ка-

кой-либо информации. 

После того как мы разобрались с медиафайлом, давайте вернемся к нашим кноп-

кам. Создадим из треугольной заготовки кнопку, которую назовем "Play". Тут же 

можно попрактиковаться в создании разных визуальных представлений кнопок. 

Давайте создадим такой макет состояния Rollover для данной кнопки, в котором 

изменим ее цвет на зеленый. Для этого щелкните по строке Rollover для создания 

нового состояния, после этого выделите кнопку и, перейдя в палитру Swatches, вы-

берите зеленый цвет заливки. Давайте также создадим кнопку из квадрата и назо-

вем ее "Stop". Не забудьте также изменить для ее положения Rollover цвет на крас-

ный. Это позволит нам достаточно интересно разнообразить внешний вид этих 

элементов управления. 

После того, как кнопки созданы, добавим им требуемый функционал. Начнем  

с кнопки Play. Зададим на событие On Release or Tap действие Sound. Вы должны 

были обратить внимание на то, что при выборе такого действия отобразился не-

сколько другой набор элементов настроек. Первым из них является Sound — это 

имя того аудиофайла, с которым нужно произвести какие-либо действия, а раскры-

вающийся список Option позволяет эти самые действия выбрать. В первом раскры-

вающемся списке мы можем выбрать наш файл Music. В случае если бы ранее бы-

ло загружено несколько медиафайлов, мы могли бы выбрать здесь любой  

из них. Теперь посмотрим, что нам предлагает раскрывающийся список Options 

(рис. 1.40). 

Первый вариант, который мы можем выбрать — Play — отвечает за начало проиг-

рывания композиции; второй — Stop — отвечает за остановку выбранной компо-

зиции; далее следует Pause — отвечает за временную приостановку проигрывания 

файла; Resume — отвечает за восстановление ранее приостановленной компози-

ции; и, наконец, Stop All (SWF only) — отвечает за остановку всех играющих в 

данный момент композиций. Обратите внимание, что этот вариант доступен только 

для файлов, сохраняемых в формате SWF, т. е. Flash. Выберем для нашей кнопки 

Play соответствующую опцию из списка. То же самое проделаем с кнопкой Stop. 

Теперь давайте снова обратим внимание на наш фрейм с медиасодержимым. При 

работе с ним может возникнуть еще одна трудность. При экспорте в формат PDF 
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готовой публикации во время проигрывания музыки мы будем видеть наш медиа-

фрейм, более того, внутри него появятся управляющие кнопки для работы с музы-

кой, заложенные по умолчанию в программе (рис. 1.41). Это не всегда удобно и 

часто мешает реализовать некоторые дизайнерские проекты. К сожалению, не су-

ществует возможности принудительно указать программе просмотра PDF не ото-

бражать эти управляющие элементы. Единственное, что мы можем сделать, — это 

попытаться скрыть этот фрейм средствами InDesign, что мы сейчас и попробуем 

сделать. 
 

   

Рис. 1.40. Вид палитры Buttons and Forms  
при работе с аудиофайлами 

Рис. 1.41. Отображение управляющих 
элементов при проигрывании композиции  

в Adobe Acrobat Reader 

 

 

Для начала, выделив наш фрейм с аудиофайлом, давайте перейдем к новой панели 

Media. Чтобы отобразить ее, выберите в главном меню Window > Interactive > 

Media. Эта панель позволяет настраивать параметры для таких внедряемых эле-

ментов, как аудио- и видеофайлы (рис. 1.42). 
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Рис. 1.42. Вид палитры Media при работе с аудиофайлами 

 

Для звуковых элементов предусмотрены следующие флажки для настройки:  

Play on Page Load, позволяющий запускать музыкальный файл сразу же при от-

крытии страницы; Stop on Page Turn, указывающий, что нужно приостановить 

проигрывание при покидании пользователем данной страницы; Loop для включе-

ния цикличного воспроизведения композиции. Также здесь имеется раскрываю-

щийся список Poster, который позволяет выбрать "заглушку" для того самого 

фрейма, о котором мы говорили ранее. Здесь представлены три основные опции. 

None означает отсутствие какого-либо наполнения, Standard — отображение знач-

ка в виде музыкального динамика. Если же выбрать пункт Choose Image..., то нам в 

фрейме представится возможность выбрать в качестве изображения любую картин-

ку с нашего диска (если размер картинки будет превышать размер фрейма, то она 

будет обрезана). 

Теперь, когда мы разобрались с параметрами панели Media, давайте вернемся к 

решению задачи со скрытием нашего фрейма. Если вы посмотрите на панель опций 

в верхней части экрана, то увидите, что сейчас он имеет размер 60×60 пикселов. 

Для того чтобы фрейма не было видно, уменьшим его так, чтобы его размер был 

меньше 1 пиксела. Теперь, когда мы будем нажимать кнопку Play, фрейм не будет 

виден. 

Еще она особенность заключается в том, что для первоначального проигрывания 

музыки нам всегда нужно будет нажимать на кнопку Play дважды — первый раз 

для загрузки файла и второй раз для выполнения команды Play. Это неудобство, 

к сожалению, никакими способами исправить не удастся. 
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Использование видеофайлов  
в проекте 

В этом разделе мы научимся добавлять в наши интерактивные проекты видеофай-

лы и управлять их поведением. 

Давайте перейдем на четвертую страницу нашей публикации и сфокусируемся на 

левом верхнем углу. Здесь расположена заготовка для внедрения видеофрагмента. 

Ниже находится заготовка для кнопки запуска проигрывания видео. 

Для начала работы перейдите в режим отображения Normal (горячая клавиша 

<W>) и выделите содержимое фрейма-заготовки, щелкнув по полупрозрачной ок-

ружности в центре фрейма, которая, кстати, называется Content Grabber. После 

этого удалите это изображение. 

Теперь, когда все подготовлено, поместим, так же как мы делали со звуковым фай-

лом, внутрь проекта видеофайл, к примеру Movie.f4v. Предпочтительными форма-

тами видео для InDesign являются FLV, F4V и H.264. Несмотря на то, что некото-

рые другие форматы также поддерживаются, публикации с ними могут быть кор-

ректно экспортированы только в формат PDF. Для того чтобы поместить 

видеофайл сразу же совпадающий по размеру с подготовленным фреймом, подве-

дите указатель мыши к левому верхнему углу фрейма, дождитесь, когда у значка 

стрелки появятся маленькие линии, щелкните и проведите до нижнего правого угла 

таким образом, чтобы произошла "привязка" к нему. Теперь можно отпустить 

кнопку мыши. Как вы видите, видео было помещено в нашу публикацию 

(рис. 1.43), но так как оно находится не в формате HD, пропорции его сторон равны 

3:4. Это не дает ему полностью вписаться в размеры нашего фрейма. 

К этому мы вернемся немного позже, а сейчас вновь, как и в прошлом разделе, где 

мы работали с аудиофайлами, обратимся к палитре Media (рис. 1.44). 

 

Рис. 1.43. Отображение помещенного видеофрагмента 
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Рис. 1.44. Вид палитры Media при работе с видеофайлами 

Как вы уже успели заметить, она выглядит несколько по-другому, нежели чем ко-
гда мы работали с аудиосодержимым. Так же, как и раньше, мы можем в верхней 
части этой палитры просмотреть видео, немного ниже находятся настройки. Разбе-
ремся в них немного подробней. Здесь мы видим уже знакомые вам опции 
(Options): Play on Page Load, отвечающую за запуск проигрывания видео при от-
крытии страницы, Loop (Except PDF) для зацикливания проигрывания видеофраг-
мента (обратите внимание, что данная опция будет работать только при экспорте 
вашего проекта в формат Flash). Кроме того, имеется раскрывающийся список 
Poster, предназначенный для настройки внешнего вида фрейма в моменты, когда 
видео не проигрывается. Однако набор возможных параметров в данном списке 
немного отличается. Итак, значение None — так же, как и раньше, означает пустое 
поле, Standard — значок в виде ленты с кадрами, а Choose Image... — выбор изо-
бражения в качестве "заглушки". Вместе с ними, здесь появляется дополнительный 
пункт From Current Frame, означающий, что в момент, когда видео не проигрыва-
ется и не находится в режиме паузы, будет отображаться кадр, который в настоя-
щий момент выбран в верхней части палитры. 

Выберем значение Choose Image... и подберем нужное нам изображение. Когда это 

будет сделано, вы увидите, что изображение заполнило видеофрейм, но не совпада-
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ет с ним по размеру. Для того чтобы корректировать размеры этого изображения, 

нужно два раза нажать на Content Grabber (полупрозрачный круг внутри изобра-

жения) (рис. 1.45). 

 

Рис. 1.45. Внешнее отображение Content Grabber 

Масштабируйте выбранное вами изображение, чтобы оно вписывалось в размеры 

фрейма. Как вы видите, в нашем случае, по краям все равно остались поля. Чуть 

позже мы решим эту проблему, а пока в раскрывающемся списке Poster снова  

установим значение None. 

Еще один раскрывающийся список для настроек называется Controller и отвечает 

за то, какой набор кнопок будет представлен в линейке управления проигрыванием 

после запуска видеофайла. Мы не будем подробно обсуждать каждый из представ-

ленных вариантов, просто запомните, что они отличаются только набором кнопок. 

Если вы захотите понять, как выглядит каждый, просто попробуйте переключать их 

и просматривать результат. Для нашей ситуации давайте выберем значение 

SkinOverSeekMute. Опция (флажок) Show Controller on Rollover позволяет ото-

бражать строку управления проигрыванием каждый раз при наведении курсора 

мыши на это видео. 

Чуть ниже мы видим еще один важный раздел видеопараметров — Navigation 

Points. Для чего же нужны эти параметры? Чтобы быстро это понять, вспомните 

любой последний фильм, который вы смотрели на DVD. На пульте вашего плеера 

обязательно есть кнопка, позволяющая переключиться на следующую сцену. Так 

вот Navigation Points или навигационные точки — это и есть своего рода разметка, 

по которой проигрыватель, будь то устройство или программа, понимает, где начи-

наются и заканчиваются сцены. Для создания новой навигационной точки нажмите 

на кнопку в виде плюса в левом нижнем углу палитры. После этого вам будет 

предложено как-то назвать вновь созданную точку. С помощью кнопки в форме 

знака минус, которая располагается там же, можно удалять эти точки. 
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Мы сделали достаточно много настроек и теперь можно просмотреть, что у нас по-
лучилось. Давайте откроем палитру SWF Preview и запустим наш проект. Как вы 
можете видеть, на его месте находится пустое поле. Это произошло из-за того, что 
у нас не определено, по какому событию будет происходить проигрывание видео. 
Вспомните схему "объект-событие-действие". Мы пока успели определить только 
последний пункт из них. Давайте продолжим с остальными. 

Поместите во фрейм, который остался от удаленной картинки, любое изображение, 
после чего переместите и масштабируйте его таким образом, чтобы он занимал весь 
контейнер. После этого выделите соответствующую заготовку и создайте из нее, 
как вы уже умеете, кнопку PlayVideo. На событие On Release or Tap этой кнопки 
задайте действие Video. После этого внизу вы увидите настройки, очень похожие 
на то, что мы видели в разделе Sound, однако с тем исключением, что в самом низу 
добавился еще один пункт, который называется Point. Также в раскрывающемся 
списке Options добавился еще один пункт Play from Navigation Point. Совместное 
использование этого пункта с каким-либо элементом из списка Point позволит вам 
начать проигрывание видео именно с того отрезка, который вы сами определите. 
Эта функция существенно расширяет возможности работы с видеофрагментами.  
В нашем случае, однако, давайте установим просто вариант Play для простого на-
чала проигрывания. По аналогии создайте и настройте действия для кнопки Stop, 
указав в действии Video соответствующую опцию. 

Когда основное действие настроено, вернемся, наконец, к решению нашей задачи  
с полями вокруг видеофайла. Для этого, в первую очередь, мы будем использовать 
картинку, которую мы загрузили, в качестве "заглушки", пока видео не проигрыва-
ется, и будем скрывать ее при нажатии на кнопку PlayVideo и снова отображать 
при нажатии кнопки StopVideo. Для того чтобы это сделать, превратите эту кар-
тинку в кнопку и потом настройте опции ее видимости по нажатию на соответст-
вующие клавиши, как мы делали в одном из предыдущих разделов, когда создавали 
HotSpot. Также будет полезно предварительно скопировать этот фрейм, он нам еще 
понадобится. 

Наконец, позаботимся о том, чтобы избавиться от непропорциональных полей сле-
ва и справа от видеофрейма. Для того чтобы сделать это, вставьте предусмотри-
тельно скопированный ранее фрейм, удалите из него картинку и, используя палит-
ру Swatches, залейте его черным цветом. После этого останется лишь переместить 
его на задний план страницы. 

После того, как все это сделано, перейдите в палитру SWF Preview и попробуйте, 
как работают все функции, которые мы только что внедрили. Обратите особое 
внимание на внешний вид видеоролика. Как вы видите, по его краям теперь просто 
находятся аккуратные черные полосы. Именно для этого мы и вставили дополни-
тельный черный фрейм позади всех элементов. 

Создание эффектов Page Transitions 

В этом разделе мы научимся создавать и настраивать интерактивные переходы ме-

жду страницами. Для начала поговорим о том, что же такое переходы между стра-

ницами. По сути, это процесс превращения одной страницы в другую. Он может 
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быть мгновенным и незаметным глазу, но, в то же время, с определенными на-

стройками, может стать интересным дизайнерским решением для вашего проекта. 

Итак, начнем по порядку. 

Переходы между страницами или эффекты Page Transitions работают при экспорте 

как в PDF-документы, так и при использовании Flash. Существует несколько спо-

собов применить эти эффекты. Давайте перейдем к первой странице нашей публи-

кации и организуем интерактивный переход с первой на вторую страницу. Первый 

способ сделать это — щелчок правой кнопкой мыши по значку первой страницы  

в палитре Pages и выбор в появившемся контекстном меню пункта Page 

Attributes > Page Transitions > Choose... Эта же опция доступна также из контек-

стного меню палитры Pages. Пользуйтесь тем способом, который вам удобен. 
 

 

Рис. 1.46. Вид диалогового окна Page Transitions 

 

В открывшемся диалоговом окне Page Transitions (рис. 1.46) вы можете выбрать 

тот вид перехода, который вам нравится; внизу также имеется опция для примене-

ния данного типа перехода для всех страниц в документе. Для более обстоятельно-

го просмотра каждого из вариантов просто наведите на него курсор мыши. Обрати-

те внимание на то, что последний вариант перехода, т. е. Page Turn (SWF Only) 

(переворот страницы), рассчитан только для использования при экспорте Flash. 

Как только вы применили к странице один из вариантов перехода, рядом с ней  

в палитре Pages появляется значок, постоянно напоминающий об этом. Теперь  

попробуйте снова перейти к пункту меню Page Transitions. Вы увидите, что вдоба-

вок к предыдущей опции сейчас появилось две дополнительных, позволяющих из-

менять и удалять настройки перехода страниц. Если мы выберем опцию Edit, т. е. 
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вариант изменения, для нас откроется палитра, которую мы еще не видели — Page 

Transitions (рис. 1.47). 

Она содержит в себе настройки, позволяющие изменять поведение каждого из уви-

денных вами ранее вариантов. Например, для перехода типа Blinds доступны вари-

анты выбора направления распространения эффекта — Direction и его скорости — 

Speed. Для других эффектов некоторые настройки могут быть заблокированы, как 

например, если мы выберем значение Fade, то опция Direction станет недоступна. 

Кстати, в правом нижнем углу этой палитры также есть кнопка для применения 

выбранного перехода страницы на весь документ. 

 

Рис. 1.47. Вид палитры Page Transitions и соответствующих индикаторов в палитре Pages 

Давайте выберем для нашего документа эффект с названием Box, установим сред-

нюю скорость его воспроизведения (Medium) и в настройках раскрывающегося 

списка Direction укажем значения In. После этого давайте экспортируем наш до-

кумент в интерактивный PDF и просмотрим его. Попробуйте полистать страницы. 

Для достижения большего эффекта при отображении Page Transitions документ 

должен быть открыт в полноэкранном режиме. Если вы используете Adobe Acrobat 

Reader, нажмите комбинацию горячих клавиш <Ctrl>+<L>, в противном случае 

найдите в основном меню вашей программы для просмотра опцию перехода в пол-

ноэкранный режим. 

Функции создания Multi-state Object 

В данном разделе мы поговорим про создание и настройку объектов с множествен-

ными состояниями или Multi-state Objects и их использованием в интерактивной 

среде InDesign. Сразу хочу отметить, что данная функция, а также все последую-

щие до конца этой главы применимы только для публикаций, экспортируемых  

в формат Flash. При использовании для сохранения формата PDF эти элементы ра-

ботать не будут. 
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Для начала работы давайте перейдем на страницу два уже хорошо знакомой вам 

публикации. Если вы выделите и переместите картинку в левой части листа, то 

увидите, что под ней располагается еще одна. На самом деле, здесь лежит несколь-

ко изображений для создания Multy-state Object. Что это за объекты, мы поймем  

в процессе их создания. Для создания и управления данным типом элементов ис-

пользуется палитра Object States, которую можно открыть, выбрав в главном меню 

пункт Window > Interactive > Object States. 

Нашей задачей будет являться создание своеобразного слайд-шоу. Мы попытаемся 

добиться такой функциональности, чтобы при нажатии на маленькую кнопку в 

форме ромба в нижней части листа происходила смена изображения и, кроме того, 

также менялась подпись к нему справа от этой кнопки. 

Для того чтобы попробовать, как работает функция Multi-state Object, давайте вы-

делим одно изображение и одну подпись и нажмем маленькую кнопку в форме 

листа в правом нижнем углу палитры Object States (рис. 1.48). Она называется 

Convert Selection to Multi-state Object и превращает выделенный объект или груп-

пу объектов в объект с множественными состояниями. Вы должны были обратить 

внимание на то, что вместо одного объекта, как мы задумывали, было создано 

два — один для изображения, один для подписи. Если мы хотим, чтобы этого не 

происходило, изображения и подписи нужно попарно сгруппировать. Нажмите 

клавиши <Ctrl>+<Z>, для того чтобы отменить предыдущее действие, и перейдите 

к палитре Layers. 

 

Рис. 1.48. Вид палитры Object States после создания первого объекта 

 

Вы найдете там слой под названием intro images/captions. В нем, как вы видите, 

находятся все изображения из этой стопки и все подписи к ним. Давайте, попарно 

выделяя их, объединим их все в группы так, чтобы каждому изображению соответ-

ствовала его подпись. После этого выделите все полученные группы и вновь на-

жмите кнопку Convert Selection to Multi-state Object. Кстати, кнопка слева от нее 

позволяет вставить в выделенное состояние скопированный ранее объект. 
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Как вы видите, было создано шесть состояний, соответствующих своим группам из 

изображений и подписей к ним (рис. 1.49). В верхней части палитры мы видим по-

ле Object Name, которое позволяет нам задать имя для вновь созданного объекта,  

к примеру "IntroImages". Таким образом, мы получили объект, который внутри себя 

содержит ряд определенных состояний, — это и есть Multi-state Object. Выбирая 

каждое из этих состояний, вы будете видеть, как они отображаются на вашем  

листе. 

 

Рис. 1.49. Вид палитры Object States после создания всех объектов 

 

Теперь давайте немного поговорим про редактирование уже имеющихся состоя-

ний. Когда выделено какое-либо состояние (State n), к примеру, State 1, то вы мо-

жете, дважды щелкнув по какому-либо объекту, входящему в него, перевести его в 

состояние редактирования и теперь любые изменения, перемещения и т. д. будут 

сохраняться внутри записи о состоянии. 

Кроме того, если вам не нравится, как в настоящий момент названы наши состоя-

ния, то их можно в любой момент переименовать. Для этого следует трижды щелк-

нуть мышью по имени состояния State n. 

Наконец, чтобы вернуть любое из состояний в положение обычных объектов, тем 

самым исключив их из Multi-state Object, следует из контекстного меню палитры 

Object States выбрать пункт Release State to Objects для "освобождения" одного 

состояния либо же Release All States to Objects для всех состояний данного объек-

та. Не следует путать данный пункт с Delete State, при выборе которого состояние 

просто будет удалено вместе со всем содержимым. Также обратите внимание на 

опцию Hidden Until Trigered в этом меню, подобную такой же при работе с кноп-

ками. Как вы помните, она позволяет скрыть объект до тех пор, пока он не будет 

принудительно отображен с помощью какого-либо действия. 
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Теперь, когда объект со всеми внутренними состояниями создан и настроен, самое 

время заняться настройкой кнопки, которая будет управлять его поведением. Для 

этого преобразуйте заготовку в виде ромба в кнопку с именем IntroNextCaption и 

настройте для нее те параметры внешнего отображения, какие вы захотите. Кстати, 

если вы считаете, что данная кнопка слишком мала и неудобна для работы, то  

можете попрактиковаться в создании HotSpot. После этого на событие On Release 

or Tap задайте действие Go To Next State (IntroImages) (рис. 1.50). 

 

Рис. 1.50. Вид палитры Buttons and Forms при работе Multi-state Object 

Для него в настройках существует всего две опции. Первая — Object — служит для 

выбора Multi-state Object, на который будет направлено действие, а вторая — Stop 

at Last State — включает режим, при котором при попадании на последнее состоя-

ние в объекте не будет перехода на первое, т. е. не будет происходить цикличный 

просмотр. 

Теперь все готово для того, чтобы просмотреть, что же у нас получилось. Попро-

буйте несколько раз нажать на созданную кнопку и посмотрите, что происходит. 

Обратите внимание, что изменяются не только картинки, но и подписи к ним. 
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Создание галереи изображений  
с помощью Multi-state Object 

В предыдущем разделе мы научились создавать объекты с переменным состояни-

ем. Теперь давайте попробуем применить их для какой-либо прикладной задачи, 

например, создания интерактивной галереи изображений. 

В первую очередь, перейдите к третьей странице нашей публикации и отобразите 

слой gallery images. Здесь вы увидите заготовку для этой галереи. В нашей работе 

мы будем добиваться такой функциональности, чтобы после щелчка по миниатю-

рам в левой части листа открывались полноценные изображения в правой. Кроме 

того, нужно предусмотреть возможность скрыть все изображения и вернуться к со-

стоянию с пустым полем. Для этого в правом верхнем углу предусмотрена малень-

кая заготовка для кнопки в форме креста (рис. 1.51). 

 

Рис. 1.51. Вид заготовки для галереи 

Итак, приступим. Во-первых, скройте слой gallery images. Когда вы это сделаете, 

то сможете увидеть, как должно выглядеть поле без изображений. 

После этого давайте вновь отобразим его и заблокируем слой content (нажмем зна-

чок замка на нем). Перед тем как создавать из изображений Multi-state Object, да-

вайте перейдем на слой gallery images и нарисуем немного выше над изображе-

ниями прямоугольник без заливки и обводки (невидимый). Это нужно для того, 

чтобы создать такое состояние, в котором не отображалась бы ни одна картинка. 

Позже вы увидите, как это произойдет. Когда вы завершили с прямоугольником, 

выделите его вместе со всеми изображениями и в палитре Object States нажмите 

кнопку Convert Selection to Multi-state Object. Как вы видите, мы получили новый 

объект с набором состояний (рис. 1.52). Назовите его Gallery Previews. Обратите 

внимание на состояние State 1. Это и есть наш прямоугольник. Переименуем его  
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Рис. 1.52. Промежуточный этап создания галереи 

 

в null, чтобы было проще его идентифицировать. Так как он не видим, если мы вы-

берем это состояние, вы увидите просто пустое поле, как мы и задумывали. 

Теперь осталось привязать миниатюры в левой части листа к вновь созданному 

Multi-state Object. 

Во-первых, создадим кнопку для отображения пустого поля или кнопку закрытия 

галереи. Для этого, как вы помните, у нас есть в правом верхнем углу специальная 

заготовка. Выделим ее и конвертируем в кнопку с названием GalleryClose. На са-

мом деле, сейчас мы не будем задавать для нее какие-либо действия, т. к. они 

должны быть прописаны для каждого конкретного State. В противном случае, сис-

тема работать не будет. Чтобы сделать это, сейчас просто вырежем эту кнопку  

с помощью комбинации горячих клавиш <Ctrl>+<X>. Теперь, переходя в каждое 

состояние State кроме null, вам просто требуется нажать кнопку Paste copied 

objects into selected State (кнопка со звездочкой в нижней части палитры Object 

States) (см. рис. 1.52). В каждом из состояний теперь останется только, выделив эту 

кнопку задать ей на событие On Release or Tap действие по переходу на состояние 

null в объекте Gallery Previews. Это делать мы уже умеем. Когда вы закончите, 

можно разблокировать слой content. 

Нам осталось только определить поведение по нажатию на каждую из миниатюр. 

Не сложно догадаться, что оно будет связано с событием On Release or Tap, в ре-
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зультате которого будет происходить действие Go to State с указанием соответст-

вующего состояния в Gallery Preview. 

После того, как все готово, давайте посмотрим, что же у нас получилось. По щелч-

ку на каждую из миниатюр фактически отображается соответствующая картинка. 

Старайтесь обязательно проверять все возможные варианты работы пользователя  

с вашим продуктом. Например, сначала можно попробовать нажать все миниатюры 

по очереди и проверить, все ли картинки им соответствуют, потом логично прове-

рить работоспособность кнопок Close на каждом изображении из галереи и т. д. 

Бывают ситуации, когда подобная проверка позволяет выявить небольшие ошибки 

и устранить их до передачи готовой работы заказчику. 

Когда вы закончили проверку, наша работа по созданию галереи завершена. Теперь 

вы понимаете для чего нужны Multi-state Objects, а также то, что в каждое состоя-

ние можно помещать не только изображения, но и другие интерактивные элементы. 

Это существенно расширяет диапазон наших возможностей при создании интерак-

тивных публикаций. 

Использование палитры Animation 

В данном разделе мы научимся добавлять в наш проект анимацию и разберемся  

с тем, что такое предустановки движения и каким образом можно ими управлять. 

Нам снова потребуется третья страница нашей публикации с галереей. Для нашего 

первого анимационного опыта давайте разработаем такое поведение кнопок-

миниатюр, при котором наведение на них мыши будет вызывать увеличение их  

в размере. В тот же момент, когда указатель мыши будет выходить за область дей-

ствия кнопки, они должны возвращаться к своему стандартному размеру. 

Первый шаг, с которого мы начнем работу, — выделим первую кнопку и откроем 

палитру Animation (рис. 1.53), которую можно вызвать, выбрав в главном меню 

пункт Window > Interactive > Animation. 

Здесь мы увидим достаточно большое количество настроек. Давайте "пройдемся" 

по каждой из них. Самая первая — поле Name — как понятно из названия, это имя 

объекта. Обратите внимание, что если мы изменим имя здесь, то эти изменения от-

разятся на всех остальных палитрах, в том числе Buttons and Forms, если мы рабо-

таем с кнопками, как в этом случае. Следующий пункт настройки — раскрываю-

щийся список Preset — это предустановка анимации, т. е. набор настроек, собран-

ный в единую группу, применяемую единовременно. Как вы видите, здесь их очень 

много. Вы можете выбрать любой из пунктов и посмотреть демонстрацию того, как 

они работают в верхней части палитры. Для реализации нашей задумки лучше все-

го подойдет Preset под названием Grow или рост. 

Чуть ниже расположен пункт настроек Event, уже знакомый нам по работе с кноп-

ками, — это событие, которое должно побудить начало анимации. Импульсы здесь 

представлены четырьмя вариантами — On Page Load (при загрузке страницы), On 

Page Click (при щелчке по странице), On Click (Self) (при щелчке по самому  

объекту) и On Roll Over (при наведении на объект курсора мыши). Последний ва-
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риант — это именно то, что нам нужно. Обязательно обратите внимание, что когда 

мы выбрали последний вариант, прошлый выбор все равно остался актуальным, и 

анимация будет происходить после одного из этих событий. Так что не забудьте 

отключить ненужный вариант. 

 

Рис. 1.53. Вид палитры Animation при работе с интерактивными объектами 

После выбора On Roll Over (Self) в качестве события, для нас делается доступной 

опция Reverse on Roll Off, т. е. выполнить обратную анимацию в момент ухода 

указателя мыши из области действия кнопки. Нам необходимо включить ее. 

Сейчас обратим наше внимание на кнопку, которая расположена несколько правее 

этих настроек и называется Create button trigger. Если вы нажмете ее, то увидите, 

что форма вашего курсора изменилась, и теперь он стал похож на прицел. С по- 

мощью данного инструмента можно, щелкнув по любому фрейму, придать ему те-

кущие настройки, выбранные в настоящий момент в палитре Animation. Причем, 

если щелкнуть по элементу, который, скажем, не является кнопкой, то он автома-

тически будет конвертирован в нее. 

Следующая группа настроек отвечает за время проигрывания анимации (Duration) 

и количество раз, которые она будет повторяться. Установим первую на 0,5 секун-

ды, а вторую оставим по умолчанию равной 1. Ели вы выберете опцию Loop, то 

анимация будет повторяться циклично бесконечное количество раз. Последняя оп-
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ция в этой логической группе — Speed отвечает за регулирование скорости на 

"входе" и "выходе" анимации, проще говоря, за замедление проигрывания в начале 

(In) или конце (Out) анимации. Для того чтобы понять, как работает каждая из них, 

попробуйте просмотреть, как они меняют характеристики движения объекта в 

верхней части палитры. Вариант From Preset устанавливает такой вариант, кото-

рый был изначально заложен в предустановках анимации, в нашем случае Grow. 

Выберем Ease In для нашей анимации. 

Завершающий раздел настроек — Properties — позволяет еще более детально ре-

гулировать, как будет вести себя анимация. Если под этой надписью вы не видете 

настроек, нажмите на маленький треугольник слева от нее. 

Первый пункт данных настроек — раскрывающийся список Animate — мы рас-

смотрим несколько позже. Пока же, перейдем к следующим — Rotate — угол, на 

который будет поворачиваться объект при анимации, и Scale — масштаб по шири-

не (W) и высоте (H), в котором будет трансформироваться объект. В данных полях, 

по умолчанию, установлено значение 200, 200 — это настройка также получена из 

предварительной установки (Preset). Нам нужно изменить ее до значений 125, 125 

для того, чтобы добиться эффекта небольшого увеличения. Цепочка  справа от 

заполняемых полей W и H является индикатором того, что значения изменяются с 

соблюдением пропорции объекта, а матрица из девяти маленьких квадратов  по-

зволяет настроить, из какой точки объекта будет происходить трансформация. 

В нашем случае, можно оставить эти параметры без изменений. 

Раскрывающийся список Opacity позволяет настроить направление действия 

Fade — плавного исчезновения или появления объекта. Этот эффект достигается за 

счет привязки значения прозрачности ко времени. Оставим в этом списке значение 

None, как это было установлено по умолчанию. Две последних опции, одна из ко-

торых вам уже знакома, отвечают за отключение отображения объекта до и после 

анимации соответственно. 

Когда все настроено, можно нажать кнопку SWF Preview, расположенную в левом 

нижнем углу палитры для просмотра результата. Теперь можете навести указатель 

мыши на выбранную вами миниатюру, и вы увидите, как она увеличится в разме-

рах (рис. 1.54), причем в начале увеличение будет происходить медленней, чем  

в конце. Это и есть тот самый эффект Ease In, который мы выбрали в настройках. 

  

Рис. 1.54. Результат настройки анимации 
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Осталось лишь применить подобные настройки для всех остальных кнопок. Можно 

делать это каждый раз вручную, но есть более быстрый и удобный способ — соз-
дание собственных предустановок анимации или Motion Preset. Для этого необхо-

димо выбрать в контекстном меню палитры Animation пункт Save и в открывшем-
ся диалоговом окне Save Preset задать имя для создаваемых предустановок, напри-

мер ThumbnailGrow. Как вы видите, теперь в раскрывающемся списке Preset 
указывается уже наше название вместо Custom (Grow). 

Теперь, все, что нам нужно сделать, — это применить наши параметры предуста-

новки (Preset) ко всем остальным кнопкам, просто выбрав его в раскрывающемся 
списке Preset. Обратите внимание, что данные предварительные настройки сохра-

няют все значения из всех полей кроме двух. Вручную каждый раз вам придется 
задавать, во-первых, Event и, во-вторых, Speed. Но, в любом случае, это уже значи-

тельно меньше, чем если настраивать все опции. Когда все готово, то можно запус-
тить просмотр и насладиться прекрасными увеличивающимися миниатюрами. 

В завершение хочется отметить, что, несмотря на огромное обилие возможных ви-

дов анимации, старайтесь никогда не перегружать вашу публикацию сложными 
переходами, большим количеством движения и тому подобными эффектами, если 

вы четко не понимаете, какую цель тем самым преследуете. Это изобилие не только 
увеличит объем вашего файла и скорость загрузки проекта, но и может отвлечь 

пользователя от той информации, которую вы изначально пытались ему препод- 
нести. 

Создание и работа с Custom Motion Path 

В данном разделе мы будем развивать наши навыки по работе с анимацией и на- 
учимся задавать и настраивать параметры движения по заданному контуру. Для 

начала работы, перейдем к первой странице нашей публикации и отобразим слой, 
который называется cover overlays. В нем находятся своего рода "заглушки", за-

крывающие изображения на обложке. Нашей задачей будет создать такую анима-
цию, при которой после открытия страницы эти заглушки по очереди откроют все 

изображения, "уплыв" наверх листа. Но так как форма изображений предполагает 
наклон, эти заглушки должны двигаться также под углом. Для этого нам и понадо-

бится контур движения. Давайте приступим. 

Когда мы говорим о таком понятии, как Motion Path, нужно понимать, что это не 
что иное, как обыкновенный векторный контур, который мы можем конвертиро-

вать в "маршрут" движения наших объектов. 

Для создания нашего первого контура выберите инструмент Direct Selection (белая 
стрелка) и выделите вертикальную грань крайней правой заглушки. Ее мы исполь-

зуем в качестве заготовки, чтобы правильно зафиксировать угол движения. Скопи-
руйте и вставьте эту линию с помощью команд, вызываемых сочетанием клавиш 

<Ctrl>+<C> и <Ctrl>+<V> соответственно. После этого переместите ее таким обра-
зом, чтобы нижняя точка полученной линии совпадала с центром заглушки. 

Теперь, чтобы конвертировать обычную векторную линию в Motion Path, нужно 

одновременно с ней выделить объект, который будет по ней двигаться, в нашем  
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Рис. 1.55. Настройка Custom Motion Path 

 

случае заглушку, и выбрать в контекстном меню палитры Animation пункт Convert 

to Motion Path (рис. 1.55). После того как мы это сделали, вы можете обратить 

внимание на то, что контур, который мы использовали, стал зеленым и на нем по- 

явились точки, которые условно обозначают кадры анимации. Также, если вы на-

жмете кнопку Show animation proxy в левой нижней части палитры Animation 

(рис. 1.56), то увидите конечное положение вашего объекта. 

На секунду отвлечемся от этого процесса и откроем палитру Animation. В ней ос-

талась еще одна не изученная нами функция, находящаяся в разделе Properties и 

имеющая название Animate. В настоящий момент она имеет настройку From 

Current Appearance. Попробуйте изменить ее на To Current Appearance или To 

Current Location. Как вы видите, эта опция означает, будет ли текущее состояние 

объекта считаться начальным или же конечным для настроек внешнего вида 

(Appearance) и положения (Location) соответственно. В нашем случае, как вы по-

нимаете, необходимо оставить настройку From Current Appearance. 

Следующее действие, которое нам нужно предпринять, — изменить размер вновь 

созданного Motion Path для того, чтобы "заглушка" целиком исчезала за пределами 

листа. Для этого с помощью известных вам инструментов трансформации просто  
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Рис. 1.56. Состояние объектов после конвертации в Custom Motion Path 

 

измените размер контура, задающего движение. Не забывайте при трансформации 

держать нажатой клавишу <Shift> для соблюдений пропорций объекта. 

Когда контур готов, осталось лишь настроить параметры анимации. В первую оче-

редь изменим время анимации на 0,25 секунды — этого будет вполне достаточно 

для достижения желаемого визуального эффекта. Во-вторых, для настройки Speed 

выберем уже знакомое нам значение Ease In. Посмотрим, что получилось в резуль-

тате. Анимация работает как надо и теперь нужно скопировать контур движения из 

первого объекта с помощью сочетания горячих клавиш <Ctrl>+<C> и вставить в 

любом месте для последующего использования во всех остальных изображениях по 

аналогии с первой анимацией. Для того чтобы обратить ваше внимание на возмож-

ные сложности, давайте будем создавать наши анимационные заглушки не по по-

рядку, а в случайной последовательности, т. е., например, можете начать с крайней 

левой, а потом сделать вторую справа и т. д. Когда вы завершите работу над всеми 

элементами, посмотрите, что получилось. Как вы видите, анимация работает хоро-

шо, но последовательность движения была построена на основании порядка ее соз-
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дания. Это не всегда нас устраивает, поэтому в следующем разделе мы научимся, 

каким образом можно управлять этой последовательностью. 

Регулировка времени в проекте 

В данном разделе мы научимся управлять временем действия в нашей анимации, а 

также настраивать правильные последовательности в случаях, когда имеются не-

сколько анимаций, идущих подряд. В прошлом разделе мы создали и настроили 

контуры движения для заглушек, закрывающих изображения на первой странице 

нашей публикации. Однако в конце мы столкнулись с проблемой. Она заключается 

в том, что при формировании порядка анимаций InDesign берет в качестве последо-

вательности их воспроизведения тот порядок, в котором они были созданы. Давай-

те исправим эту неточность. Для этого воспользуемся палитрой Timing, которая 

как раз таки позволяет контролировать порядок, в котором будут происходить те 

или иные события в публикации (рис. 1.57). Для того чтобы ее отобразить, выбери-

те в главном меню пункт Window > Interactive > Timing. 

 

Рис. 1.57. Вид палитры Timing во время работы 

В этой панели, как вы видите, находится весь "сценарий" нашего документа. Каж-

дый пункт можно перемещать друг относительно друга (перетаскиванием мышью), 

тем самым настраивая последовательность, в которой будут происходить события  

в публикации. Давайте выстроим теперь все анимационные движения наших за-

глушек в правильном порядке и посмотрим в палитре SWF Preview на результат 

наших действий. Для большего удобства заглушки названы согласно их реальной 

последовательности именами overlay 1—overlay 6. Теперь ряд воспроизведения 

восстановлен, и все заглушки двигаются по очереди. 

В данной палитре также имеется еще две немаловажных опции. Первая из них — 

Delay, с помощью которой можно настроить задержку перед проигрыванием ани-

мации. Вторая (Play...times) позволяет запускать анимацию для объектов в группах 

по несколько раз или в цикле при выборе опции Loop. 
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Наконец, давайте представим ситуацию, в которой мы хотим, чтобы все объекты 

двигались одновременно. Для этого в нижней правой части палитры Timing преду-

смотрена специальная кнопка Play Together. Обратите внимание на то, что для то-

го, чтобы ей воспользоваться, предварительно нужно выделить те объекты, кото-

рые вы предпочитаете видеть перемещающимися вместе. Если вы хотите прервать 

эту связь, нажмите кнопку, расположенную рядом — Play Separately. 

Использование альтернативных версий  
и плавающей верстки при подготовке макетов 
для различных устройств 

Продолжая разговор про подготовку макетов электронных публикаций, немало-

важно затронуть тему альтернативной верстки. Давайте разберемся, что кроется 

под этим понятием. В эпоху печатных изданий для каждого из них создавался один-

единственный макет, который приводился к соответствию техническим требовани-

ям типографии и затем отправлялся на печать. В эпоху развития электронных  

публикаций ситуация несколько изменилась. Как вы уже знаете, при разработке и 

подготовке макетов мы ориентируемся на определенные целевые устройства, на 

которых впоследствии пользователь будет просматривать наше издание. Кроме того, 

у каждого современного устройства существует встроенный датчик ориентации, 

который позволяет определить, в вертикальном или горизонтальном положении 

просматривается публикация. Таким образом, для обеспечения совместимости мы 

будем иметь от двух (если мы ориентируемся только на одно устройство) до, в не-

которых случаях, десяти-двенадцати макетов по сути одного и того же издания. 

Ранее нам приходилось создавать макеты в различных файлах, особым образом на-

зывать их и вся эта работа осуществлялась вручную, что существенно увеличивало 

время, затраченное на каждую из публикаций. С приходом версии CS6 ситуация 

коренным образом изменилась. В данном разделе мы разберемся с несколькими 

новейшими разработками в области верстки публикаций для мобильных устройств, 

которые предлагает нам компания Adobe в обновленном пакете InDesign. 

Начнем мы с того, что познакомимся с крайне удобной инновацией, которая назы-

вается Alternate Layout. По сути, Alternate Layout — это набор дополнительных 

размеров и версток нашего издания, хранящихся при этом в одном файле с основ-

ной версткой. Чтобы лучше это понять, давайте откроем палитру Pages нашей пуб-

ликации. Для примера представим, что у нас есть необходимость сделать вторую 

версию обложки для устройства с другим размером экрана. Если раньше для дан-

ного задания потребовалось бы создавать отдельный документ, то теперь достаточ-

но лишь выбрать из главного меню пункт Layout > Create Alternate Layout или 

нажать на стрелку рядом с надписью Original в палитре Pages и также выбрать 

Create Alternate Layuot (рис. 1.58). 

В открывшемся диалоговом окне вы можете задать имя, источник, итоговые разме-

ры и ориентацию для создаваемой альтернативной верстки. В нижней части окна 

мы видим раскрывающийся список Liquid Page Rule, о котором поговорим чуть 
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позже, а пока что обратите внимание на три опции ниже. Опция (флажок) Link 

Stories включает режим связки текстовых блоков в оригинальной и создаваемой 

версии верстки. Это означает, что любые изменения в тексте исходного блока не-

замедлительно будут отражены во вновь создаваемом на всем протяжении работы. 

Вторая опция — Copy Text Styles to New Style Group — позволяет создавать в па-

литре Charаcter и Paragraph Styles папки, содержащие копии стилей для каждой 

из версий верстки. Последняя же опция — Smart Text Reflow — позволяет добав-

лять дополнительные страницы к макету в случае, если при изменении размеров 

возникает переполнение текстового блока. 

 

Рис. 1.58. Вид палитры Pages и диалогового окна Create Alternate Layout  
при создании альтернативной верстки 

 

Если мы хотим создать альтернативную версию только для какой-либо одной стра-

ницы, можно указать рядом с именем источника Original:номер страницы, напри-

мер Original:1 — будет создана альтернативная верстка только для первой страни-

цы. После этого обратите внимание на палитру Pages. Если мы увеличим нашу па-

литру по ширине, то вы увидите, что теперь в ней появилась вновь созданная 

альтернативная верстка. При этом, теперь выбрав одну из версий и внеся в нее оп-

ределенные изменения, вторая версия останется прежней. Это дает нам возмож-

ность использовать данную функцию не только для создания разных версий для 

устройств с различными размерами экрана, но и просто хранить и, например, де-

монстрировать заказчику разные версии дизайна в одном файле. Давайте создадим 

еще одну альтернативную верстку, на этот раз меньшего размера и другой ориента-

ции. Перейдите к ней и, если нажить горячую клавишу <W> для включения режима  
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Рис. 1.59. Демонстрация проблемы, возникающей при применении альтернативной верстки 

просмотра, вы увидите, что часть текста и графических элементов просто пропали 

за пределами рабочей области (рис. 1.59). 

Для решения этой задачи компанией Adobe предложена еще одна интересная 

функция — Liquid Layout или плавающая верстка, которая содержит в себе не-

сколько алгоритмов или правил, позволяющих автоматически корректировать вер-

стку под заданный размер макета. Для того чтобы разобраться в том, как она рабо-

тает, мы, отменив создание альтернативной верстки, можем использовать инстру-

мент Page Tool. Выбрав его, давайте вручную изменим размеры нашего листа. Как 

вы видите, результат от таких действий не очень нас устраивает — размеры листа 

изменилась, но все элементы на нем остались на тех же местах, где они стояли до 

этого, и нам предстоит большая работа по их переверстке. Для более элегантного 

решения данной задачи давайте познакомимся с новой палитрой в InDesign CS6, 

которая стала эволюцией функционала Layout Adjustmеnts и называется Liquid 

Layout. Вызвать ее можно, обратившись к пункту главного меню Window > 

Interactive > Liquid Layout. В первую очередь обратите внимание на то, что  

настройки данной палитры доступны только при изменении размера листа с по- 

мощью инструмента Page или при использовании Alternate Layout, о котором мы 

поговорим чуть позже. 

Итак, давайте вернем наш файл к исходному состоянию, вновь выберем инстру-

мент Page, но на этот раз обратим наше внимание на пункт Liquid Layout Rule  

в панели настроек. Давайте выберем в нем пункт Object-Based и вновь изменим 

размеры листа. Как вы видите, эффект совершенно другой — все объекты, как по 

волшебству, следуют за формой листа, максимально вписываясь в него. В этом  

и заключается функция Liquid Layout (рис. 1.60). 
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Рис. 1.60. Демонстрация эффекта включения правила Object-based Liquid Layout 

 

Теперь вернемся к палитре Liquid Layout (рис. 1.61). Здесь можно, во-первых,  

выбрать метод или правило, по которому будет происходить трансформирование и 

перемещение объектов при изменении размера листа. 

Всего на сегодняшний день существует четыре подобных правила в раскрываю-

щемся списке Liquid Page Rule: 

 Scale — масштабирует и перемещает объекты в той же пропорции, в которой 

изменяется сам лист. 

 Re-Center — определяет положение общего центра всех объектов относительно 

центра листа и меняет его пропорционально изменяющемуся размеру листа. Са-

ми объекты не трансформируются. 

 Object-based — позволяет для каждого конкретного (предварительно выделен-

ного) объекта настроить свое поведение при изменении размера листа. Для этого 

служат опции в нижней части палитры и специальные пиктограммы на самом 

объекте: 

 Resize with Page — позволяет включить или отключить возможность мас-

штабирования объекта отдельно по горизонтали и вертикали. При одновре-

менном включении опций масштабирование будет происходить пропорцио-

нально. Данная опция дублируется смежными пиктограммами в виде замка 

или волны. 

 Pin — позволяет закрепить расстояния от края листа до объекта. Данная  

опция дублируется пиктограммами в видео окружностей на краях контейнера 

объекта. 
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Рис. 1.61. Вид палитры Liquid Layout при работе с объектами верстки 

 Auto-Fit — данная опция означает, что изображение внутри фрейма (при на-

личии вложенности) будет масштабироваться вместе с фреймом, при этом 

используя то же правило Liquid Layout, что и фрейм. 

 Guide-based — позволяет зафиксировать области влияния трансформации листа 

на внутренний контент. Для этого требуется при включенном инструменте Page 

Tool поместить на рабочую область направляющие линии. Как вы видите, они 

отмечены пунктиром и называются Liquid Guides. Теперь, когда вы трансформи-

руете лист, данные направляющие указывают, в каких областях и в каких на-

правлениях следует перемещать и масштабировать объекты. 

Кроме этого существует вариант наследования настроек поведения Liquid Layout от 

мастера, на основе которого создана данная страница. Для этого следует выбрать 

Controlled by Master. Если же вы желаете полностью отключить данную функцию, 

необходимо выбрать Off. 

Когда мы разобрались с настройками Liquid Layout, давайте вернемся к нашему 

первому примеру и попробуем совместить первую и вторую инновацию, т. е. 

Alternate Layout и Liquid Layout. В первую очередь, подготовьте все элементы в 

вашей верстке для работ с Liquid Layout. Когда все готово, попробуйте создать но-

вую альтернативную верстку и при этом обратите внимание на небольшой раскры-

вающийся список Liquid Page Rule в открывшемся диалоговом окне Create 

Altrnate Layout. Здесь вы можете выбрать одно из правил плавающей верстки,  

о которых мы говорили ранее, для использования его непосредственно при созда-



92 Глава 1 

нии новой альтернативной верстки. После нажатия на кнопку ОK вы увидите, что 

оно корректно применилось в новой верстке. 

Таким образом, используя данные новые возможности, которые предоставляет нам 

InDesign CS6, мы можем на порядок улучшить производительность нашей работы, 

сделав ее при этом структурной и упорядоченной. 

Экспорт полученных проектов  

в форматы Interactive PDF и Flash 

В этом разделе мы научимся экспортировать полностью разработанную интерак-

тивную публикацию в два главных формата, специально разработанных для хране-

ния данных этого типа — Interactive PDF и Flash. 

В первую очередь давайте разберемся с PDF-файлами. Для того чтобы начать рабо-

тать над экспортом в этот формат, выберите пункт главного меню File > Export, 

придумайте файлу название, например example.pdf. Очень важно не забыть в рас-

крывающемся списке Save as Type выбрать в качестве сохраняемого формата 

Adobe PDF (Interactive). Если вы не сделаете этого, после экспорта интерактивные 

элементы не будут работать. 

Нажмите кнопку Save, и для вас откроется диалоговое окно настройки опций экс-

порта — Export to Interactive PDF (рис. 1.62). Давайте кратко рассмотрим все из 

них. В верхней части окна вы можете выбрать, экспортировать ли все страницы  
 

 

 

 

Рис. 1.62. Вид диалогового окна Export to Interactive PDF  
и его дополнительных настроек безопасности 
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вашей публикации или же выбрать последовательность или диапазон нужных вам 

страниц. Ниже расположено два переключателя для выбора — Pages и Spreads, 

позволяющих экспортировать документ (при изначальной верстке его в виде разво-

ротов) либо сохраняя его в виде разворотов, либо трансформируя в отдельно стоя-

щие страницы. Далее следует флажок View After Exporting, указывающий про-

грамме открыть получившийся документ сразу же после экспорта. Установленный 

флажок Embeded Page Thumbnails немного увеличивает размер получаемого фай-

ла, но при этом внедряет в него миниатюры страниц, что позволяет в дальнейшем 

таким программам, как InDesign, просматривать их без открытия. Обе этих опции 

желательно оставлять всегда включенными. Следующий флажок — Create Acrobat 

Layers — внедряет в получаемый файл клон слоевой структуры документа, что по-

зволяет, к примеру, непосредственно в программе просмотра включать или отклю-

чать видимость тех или иных слоев. Оставим эту опцию отключенной. 

Раскрывающийся список View дает нам возможность выбрать, в каком размере бу-

дет открываться файл при запуске, оставим здесь все по умолчанию, т. е. значение 

Default, как и в следующем раскрывающемся списке — Layout. Он отвечает за то, 

в каком виде страницы будут располагаться друг относительно друга — разворота-

ми, по одной станице, последовательно и т. д. 

Следующий далее флажок Open in Full Screen Mode дает нам возможность уста-

новить режим, при котором публикация будет всегда открываться в полноэкранном 

режиме. Это может быть очень полезно, если она будет использована для проведе-

ния презентаций. В этом случае, одновременно с этой опцией можно настроить ав-

томатический переворот страниц в заданный промежуток времени. Это делается с 

помощью установки флажка Flip Pages Every и задания соответствующего значе-

ния в поле seconds. В нашем проекте также оставим эти опции отключенными. 

С помощью настройки значения в раскрывающемся списке Page Transitions можно 

установить принудительные варианты переходов страниц. При этом все настройки 

из документа будут игнорироваться. Выбрав же в этом списке значение From 

Document, все настройки списка Page Transitions будут браться из вашего доку-

мента. Выберем для нашего документа именно это значение. Здесь также можно 

выбрать None. В данном случае любые настройки Page Transitions не попадут в 

конечный документ. 

Ниже, в группе переключателей Forms and Media, вы имеете возможность выбора, 

внедрить ли в публикацию полный функционал всех управляющих элементов 

(Include All) или только их внешнее представление (Appearance Only). Выберем 

переключатель Include All, чтобы получить полностью рабочую версию публи- 

кации. 

Опция создания PDF-тегов — флажок Create Tagged PDF — достаточно специ-

фична и позволяет включить режим метки всех содержащихся в файле элементов. 

К данным меткам можно позже обращаться через программу просмотра. Данная 

опция может быть очень полезна в случае, когда вы создаете интерактивную PDF-

форму для заполнения. Если совместно с ней установить следующий флажок — 

Use Structure for Tab Order, то нажатие на клавишу <Tab> при просмотре доку-
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мента будет приводить к переключению между интерактивными элементами на 

странице, что сделает заполнение формы более удобным. 

Последние три раскрывающихся списка настроек дают нам возможность выбрать, 

будет ли осуществляться сжатие изображений в итоговом документе (Compres-

sion), и если будет, то в какой степени (JPEG Quality) и до какого разрешения 

(Resolution (ppi)). Решение по данным вопросам всегда принимается в зависимости 
от того, на каких устройствах планируется просматривать публикацию. Кнопка 

Security, расположенная в левом нижнем углу, позволяет открыть настройки безо-
пасности нашего вновь создаваемого документа. В них можно установить пароли 

на открытие, печать и изменения нашего документа. 

После того как настройка всех параметров будет завершена, для экспорта получен-
ного документа нажмите кнопку OK. Так как мы оставили установленным флажок 

View After Exporting, то после обработки вы увидите ваш документ сразу же в ок-
не программы просмотра и сможете проверить, корректно ли соблюдены все пара-

метры, которые вы настроили. Итак, поздравляю, вы только что создали свой пер-
вый интерактивный PDF-документ. 

Теперь давайте продолжим работать с уже другим типом интерактивных файлов 

для экспорта — Flash. 

В данном варианте у нас есть два основных формата, в которых сохраняются фай-

лы. Первый — SWF — служит для простого просмотра публикаций и презентаций 

в специальных программах и интернет-браузерах. Второй формат — FLA — пред-
назначен для открытия и дальнейшей обработки документов в профессиональном 

редакторе, таком как Adobe Flash Professional. Мы последовательно разберемся во 
всех настройках, как в одном, так и в другом случае. 

Итак, начнем с SWF. Для экспорта в этот формат необходимо использовать пункт 
главного меню File > Export и в нижней части открывшегося диалогового окна в 

списке Format выбрать значение Flash Player (SWF). В результате откроется диа-

логовое окно Export SWF с двумя вкладками: General и Advanced (рис. 1.63). 

Рассмотрим эти вкладки. Начнем по порядку с вкладки General (см. рис. 1.63, слева). 

 В разделе Export представлен ряд настроек, связанных с экспортом документа. 

 Переключатели Selection, All Pages, Range позволяют выбрать, нужно ли 
экспортировать только выделенную область, все страницы, либо же диапазон 

страниц, который, кстати, здесь же и указывается. Переключатель Selection 
будет недоступен, если мы до запуска этого диалогового окна не выделим ка-

кой-либо объект в нашем документе. 

 Флажок Generate HTML File позволяет вместе с SWF-презентацией создать 
web-страницу с Flash-содержимым, которую сразу же можно разместить в се-
ти Интернет. Обратите внимание на то, что если в вашем документе исполь-

зуются мультимедийные файлы, такие как видео, также будет создана папка 
resources, в которую будут помещены оригиналы этих файлов. 

 Флажок View SWF after Exporting уже нам знаком и позволяет открыть для 

просмотра полученный документ сразу же после экспорта. 
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Рис. 1.63. Вид вкладок General и Advanced диалогового окна Export SWF 

 Второй условный раздел Size (pixels) отвечает за размеры в нашей публикации и 
представлен рядом настроек. 

 Переключатель Scale и соответствующее поле задает масштаб, в котором бу-
дет экспортироваться и, в последующем, отображаться публикация. 

 Переключатель Fit To и соответствующее поле позволяет указать, в окно ка-
кого размера необходимо вписать размеры публикации. 

 Если же выбраны настройки Width и Height, то можно вручную задать раз-
меры получаемого документа, причем, отключив значок связи Link между 
ними, можно делать это, игнорируя его исходные пропорции. 

 В группе переключателей Background можно выбрать, каким цветом будут ото-
бражаться участки публикации с прозрачностью, если таковые имеются. Пере-
ключатель Paper Color означает, что они примут цвет бумаги, заданный  
в InDesign, а Transparent — что они останутся прозрачными и будут окрашены 
в зависимости от того, какой фон будет присутствовать на заднем плане. 

 Группа переключателей Interactive and Media и раскрывающийся список 
Page Transitions знакомы нам по экспорту в формат PDF, однако здесь имеется 
еще одна опция — флажок Include Interactive Page Curl, отвечающий за вклю-
чение режима интерактивной имитации перелистывания. Оставьте его установ-
ленным при экспорте, и вы сможете листать страницы в вашей публикации, как 
в настоящей книге. 

Теперь давайте перейдем к вкладке Advanced (см. рис. 1.63, справа), где можно 

управлять рядом дополнительных опций, предоставляющих ряд дополнительных 

возможностей. 
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 Frame Rate — число кадров в секунду. Значение, установленное по умолчанию, 

а именно 24 кадра в секунду подходит для абсолютного большинства случаев и, 

кстати, соответствует данному же параметру, стоящему по умолчанию в про-

грамме Adobe Flash Professional. Большее количество кадров в секунду может 

создать ощущение плавной анимации, но при этом существенно увеличивает 

объем памяти, занимаемый файлом. Помните, что изменением количества кад-

ров не получится изменить время анимации объекта. 

 Следующий раскрывающийся список — Text — дает нам выбор из трех вариан-

тов: 

 Flash Classic Text — сохраняет при экспорте текст в виде текста, не отменяя 

возможности для его выделения и поиска браузером. 

 Convert to Outlines — конвертирует текст в векторные контуры. 

 Convert to Pixels — растрирует текст и превращает его в пиксельную гра- 

фику. 

Для большинства случаев рекомендуется использовать значение по умолчанию, 

т. е. Flash Classic Text. В случае данного выбора в нижней части данного окна 

мы сможем увидеть перечень внедряемых в публикацию шрифтов. 

 С помощью опции Rasteryze Pages можно целиком растрировать все содержи-

мое публикации. 

 Настройка Flatten Transparency удаляет прозрачность из объектов, оставляя 

только ее видимость. Будьте осторожны с этой опцией. Если использовать ее,  

то все интерактивные элементы потеряют свой функционал и не будут рабо- 

тать. 

 Последний раздел в данном диалоговом окне — Image Handling. Он прекрасно 

знаком вам по настройкам экспорта PDF. Однако еще раз хочу напомнить, что 

всегда желательно сверять разрешение конечного документа с тем, на каких 

устройствах он будет просматриваться, чтобы добиться максимального качества 

при отображении и максимального эффекта для зрителя. 

Теперь, когда мы знаем, каким образом осуществляется экспорт в формат SWF, да-

вайте также разберемся, на какие настройки следует обратить внимание при экс-

порте в формат FLA. 

Для экспорта в этот формат необходимо использовать пункт главного меню 

File > Export и в нижней части открывшегося диалогового окна в раскрывающемся 

списке Format выбрать значение Flash CS6 Professional (FLA), в результате от-

кроется диалоговое окно Export Flash CS6 Professional (FLA) (рис. 1.64). 

Как вы видите, настройки расположены несколько по-другому, но если вниматель-

но разобраться, то они точно такие же. На самом деле, единственное отличие кро-

ется в раскрывающемся списке Text. Здесь появился еще один пункт, который на-

зывается Flash TLF Text. TLF расшифровывается как Text Layout Framework, и,  

если вы много работаете во Flash, вы должны понимать преимущества данной  

опции. 
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Рис. 1.64. Вид диалогового окна Export Flash CS6 Professional (FLA) 

Поздравляю, вы научились экспортировать готовые интерактивные презентации  

в форматы Flash и PDF, мы завершаем работать с интерактивными документами  

в InDesign и переходим к не менее интересной области — к подготовке макетов 

электронных книг в формате ePub. 
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ГЛАВ А 2 
 
 
 
 

Подготовка макетов  
электронных книг в формате ePub 

Теоретические понятия о формате ePub 

Формат EPUB — это XML-формат переформатируемых цифровых книг и доку-

ментов, стандартизированный ассоциацией International Digital Publishing Forum 

(IDPF) для индустрии цифрового издательства. IDPF официально приняла формат 

EPUB в октябре 2007 года, а в 2008 году пошел быстрый процесс принятия стан-

дарта крупными издателями. Формат EPUB можно читать с помощью различных 

коммерческих программ и программ с открытым исходным кодом для всех основ-

ных операционных систем, устройств на основе электронных чернил или e-ink,  

таких как Amazone Kindle, и карманных устройств, таких как Apple iPhone. 

EPUB состоит из трех отдельных спецификаций IDPF, хотя на практике все их вме-

сте можно с уверенностью называть EPUB. 

 Open eBook Publication Structure Container Format (OCF) — определяет структу-

ру дерева каталогов и файлов формата (ZIP-) архива EPUB. 

 Open Publication Structure (OPS) — определяет общие словари для eBook, осо-

бенно в форматах, которые будут использоваться для текста книги (например, 

XHTML и CSS). 

 Open Packaging Format (OPF) — описывает обязательные и дополнительные мета-

данные, порядок чтения и оглавление в EPUB. 

Кроме того, для определенных типов содержимого архива EPUB применяется ряд 

других стандартов, таких как XHTML 1.0 и Digital Accessible Information System 

(DAISY). 

Хотя первыми формат EPUB освоили традиционные издатели, ничто в этом форма-

те не ограничивает его использование исключительно книгами. С помощью сво-

бодно распространяемых программных инструментов можно упаковать в EPUB 

web-страницы, конвертировать текстовые файлы или трансформировать в хорошо 

отформатированный и правильный пакет EPUB существующие документы 

DocBook XML. 
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Готовый EPUB представляет собой простой ZIP-архив (с расширением epub), со-

держащий расположенные определенным образом файлы. Существует ряд требо-

ваний по подготовке ZIP-архива, которые будут подробно обсуждаться в следую-

щих разделах. В остальном же формат EPUB довольно прост — он почти целиком 

состоит из XML или HTML-кода. Файлы EPUB можно создавать с помощью стан-

дартных инструментальных средств XML без какого-либо специального или запа-

тентованного программного обеспечения. 

Контент EPUB (собственно текст электронной книги) почти всегда представляет 

собой XHTML 1.1 (Альтернативным форматом является DTBook, стандарт кодиро-

вания книг для людей со слабым зрением.) 

Большинство схем EPUB XML взяты из существующих, опубликованных и сво-

бодно доступных спецификаций. 

Особенностью формата EPUB является также то, что входящие в него текстовые 

(XHTML) файлы не должны по размеру превышать 260 Кбайт, а иллюстрации — 

10 Мбайт. Сама книга может быть значительно больше. Никакого специального 

ограничения в описании EPUB нет, но здравый расчет на невеликую оперативную 

память устройств для чтения электронных книг все же не помешает. А потому вер-

стальщик должен предусмотреть разбиение книги на отдельные части, главы, пара-

графы, которые при конвертации превратятся внутри EPUB в отдельные XHTML-

файлы. 

EPUB — это формат "плавающей" верстки. Это означает, что он не поддерживает 

композицию текста на странице или, тем более, развороте. (Единственным исклю-

чением, когда EPUB может поддерживать и блочную верстку — программа iBooks 

для Apple iOS.) А потому в процессе конвертации вся информация об относитель-

ном расположении элементов макета на странице исчезает, и весь дизайн становит-

ся линейным — глава за главой, иллюстрация за иллюстрацией, блок за блоком, все 

в одном непрерывном потоке. 

Чтобы избежать непредвиденных ошибок, постарайтесь приспособить макет, кото-

рый вы потом конвертируете в EPUB, таким образом, чтобы на каждой странице 

был только один текстовый фрейм, все фреймы были связаны друг с другом, а весь 

текст и графика были упакованы в этот ряд фреймов. Только это гарантирует, что 

все содержимое публикации будет конвертировано в EPUB именно в том порядке, 

в котором расположено в макете. Как это сделать средствами Adobe InDesign, мы 

поговорим в следующих разделах. 

Если вы забудете связать какой-то блок с общим потоком, InDesign экспортирует 

его содержимое в соответствии со следующим порядком расположения блоков на 

странице: слева направо, затем сверху вниз. Теоретически вы можете управлять 

последовательностью контента посредством изменения размеров блоков или их 

перемещением по странице, но такая методика может оказаться слишком затратной 

по времени. 

Кроме того, следует иметь в виду, что InDesign, следуя правилу "одного потока", не 

включит в EPUB содержимое шаблона (например, колонцифры и колонтитулы), 

содержимое невидимых слоев и т. д. 
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Вы можете включить дополнительные элементы дизайна в линейную верстку, сде-

лав их привязку. Заякоренный объект является частью абзаца, а потому попадет в 

общий поток текста при конвертации. 

Оглавление или Table Of Contents — важный элемент электронной книги, посколь-

ку он позволяет читателю быстро переходить от одной к другой части текста. Сле-

дует различать два вида оглавления, которые могут быть включены в электронную 

книгу: обычное оглавление, расположенное внутри книги (как правило, в ее нача-

ле), и навигационное меню, которое будет использовать программа для чтения 

электронной книги. Для отображения навигационного меню программы для чтения 

электронных книг используют разные средства: например, в iBooks это меню ото-

бражается сразу после обложки как оглавление книги на служебном экране книги,  

в Adobe Digital Editions навигационное меню доступно пользователю в левой ко-

лонке окна программы. 

Наконец, что касается изображений, спецификация EPUB напрямую поддерживает 

только четыре графических формата: JPEG, PNG, GIF и SVG. Поэтому все иллюст-

рации должны быть предварительно конвертированы в любой из этих форматов. 

Сами иллюстрации, как отмечалось ранее, попадут в итоговый файл только в том 

случае, если они были вставлены внутрь текста. Следует иметь в виду, что EPUB  

в старых версиях не поддерживает обтекание. Для них рекомендуется вставлять 

иллюстрации в отдельные абзацы, задавая им соответствующий стиль (например, 

выравнивание или отбивку от предыдущего/следующего абзаца). 

Хотя не все современные устройства способны отображать цветную графику, жела-

тельно не отказываться от цвета: читатель увидит цветные иллюстрации, если  

будет читать электронную книгу онлайн или же на устройстве с цветным  

ЖК-экраном. Кроме того, рано или поздно отображать цвет научатся и специализи-

рованные устройства. 

Основы процесса работы с ePub-документами 

Любой рабочий процесс, когда мы говорим про ePub, начинается с программы 

InDesign. Конечно, ePub можно создавать в Microsoft Word и даже в Блокноте, но 

именно InDesign позволяет самым оптимальным образом решать вопросы форма-

тирования текста, верстки и внедрения в них специализированных функций, таких 

как ссылки, просмотр изображений и т. д. 

Вторым шагом в работе чаще всего является экспорт полученных InDesign-файлов 

в формат EPUB. На данном этапе выбирается версия формата, настраиваются раз-

личные опции экспорта, тип и уровень компрессии и другие. После этого необхо-

димо визуально проверить полученный ePub-документ на наличие ошибок в верст-

ке, последовательности изображений и т. д. в программе Adobe Digital Editions или 

подобной ей. К сожалению, эта проверка является очень грубой, т. к. у каждого 

конкретного устройства имеются свои особенности и здесь ситуация, в целом, по-

вторяет подобную с web-браузерами. Так же как один и тот же сайт в разных брау-

зерах может смотреться абсолютно по-разному, в Adobe Digital Editions, на iPad и, 
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скажем, электронной книге созданный вами ePub-документ может выглядеть раз-

лично. Поэтому данный тип проверки считается очень поверхностным. Однако, 

чаще всего, как фильтр грубой очистки, он отсекает большинство самых заметных 

ошибок. После выявления их при просмотре, вы можете исправлять их как в 

InDesign, так и с помощью вмешательства в полученный код HTML внутри архива 

с расширением epub. 

Наконец, после того как большинство ошибок будет исправлено, до публикации 

необходимо пройти еще один немаловажный шаг, который называется валидация 

или, проще говоря, проверка на годность. Это осуществляется при помощи специа-

лизированного программного обеспечения, которое либо необходимо установить 

на локальный компьютер, или же можно воспользоваться услугами специализиро-

ванных онлайн-сервисов, например ePubCheck. 

Последним этапом является, собственно, выгрузка готового ePub-документа на 

свой сайт или в любые другие каналы распространения и продажи. 

Обо всех этих этапах мы и будем говорить в процессе нашей дальнейшей работы 

в течение всей этой главы. 
 

Создание документа  
для последующей конвертации в ePub 

Самый лучший способ начать работу с документом ePub — это использовать суще-

ствующий InDesign-файл, настраивать и управлять его версткой. Мы в нашей рабо-

те, в основном, будем использовать документ Main_Sample_work_epub.indd, лежа-

щий в папке \Подготовка ePub нашей рабочей документации, или же отдельные его 

части. Он представляет собой многостраничную книгу с текстовыми блоками, изо-

бражениями, таблицами, элементами векторной графики и другими объектами. Как 

вы можете видеть, в данном файле нет каких-либо сложных интерактивных эле-

ментов, кнопок и мультимедийных файлов, т. к. ePub не поддерживает большинст-

во из них. Единственный интерактивный элемент, который мы научимся использо-

вать и внедрять, — это ссылки. По сути, перед нами здесь обыкновенная публика-

ция, вполне подходящая для печати. 

Для того чтобы понять, с какими проблемами мы столкнемся при работе, давайте 

сразу же попробуем экспортировать данный документ в ePub. Для этого выберите 

пункт главного меню File > Export и в выпадающем списке внизу в качестве фор-

мата для экспорта установите ePub. После этого, задав файлу имя, вы можете на-

жать на кнопку Save в данном диалоговом окне. Оставьте все пункты без измене-

ний. К более детальному их разбору мы вернемся несколько позднее. А пока что 

просто нажмем кнопку OK и посмотрим, какой документ мы получим в итоге. 

Наш полученный файл откроется автоматически в программе, которая установлена 

в вашей системе по умолчанию для просмотра ePub-документов, скорее всего это 

будет Adobe Digital Editions (рис. 2.1), но, конечно, вы можете использовать любую 

другую удобную для вас программу. Если на вашем компьютере не установлено ни 
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одного приложения для просмотра подобных файлов, скачать его можно по ссылке 

http://www.adobe.com/products/digitaleditions/. 

Как мы видим, в левой части экрана у нас отображается подобие обложки, сформи-

рованное из первой страницы, и название, просто дублирующее название файла 

InDesign. В области справа отображается сама книга. Очевидно, что данный доку-

мент требует значительной доработки. Изображения и текст не связаны друг с дру-

гом, верстка сохранилась только частично, отсутствует какое-либо разделение по 

главам или рубрикам, просто исчезли некоторые графические элементы. 
 

 

Рис. 2.1. Окно просмотра публикации в программе Adobe Digital Editions 

 

Обратите внимание на то, что может возникнуть ситуация, при которой кирилличе-

ские шрифты будут отображаться некорректно. Это происходит из-за того, что в 

InDesign CS6 был изменен алгоритм шифрования встроенных шрифтов, поэтому 

программы просмотра с ранней версией Reader mobile SDK, такие как Adobe Digital 

Editions 1.7, встроенные шрифты игнорируют и заменяют их своими. Из-за этого и 

возникают проблемы с кириллицей и другими кодировками, кроме латиницы. Для 

того чтобы исправить эту ситуацию, вам необходимо установить Adobe Digital 

Editions Preview 1.8 или более позднюю версию. 

Таким образом, мы должны понять, что при экспорте из InDesign ePub-документа 

используется ряд правил, которые в данном случае не были соблюдены, что и при-

вело к ошибкам в итоговом документе. В этой главе мы проанализируем каждую из 

них и найдем способы их исправления. Также мы научимся добавлять в наши книги 

такие немаловажные элементы, как оглавление, глоссарий и многие другие. 
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Создание навигационного оглавления 

Любое издание по объему большее 4 страниц в современном издательском мире 

редко обходится без такого немаловажного элемента, как оглавление (в случае, ко-

гда в книге присутствуют главы) или содержание. В мире ePub существует два вида 

оглавлений или TOC (Table of Contents) — навигационное и внутреннее. В данном 

разделе мы научимся создавать глобальное навигационное оглавление для нашей 

книги и настраивать его многоуровневую версию. Для этого существует три раз-

личных способа — с помощью TOC-styles, посредством InDesign Book, а также  

с помощью комбинирования первого и второго. Рассмотрим каждый из них под-

робней. Начнем с первого. 

Для начала работы откроем файл Main_Sample_work_epub_TOC.indd. Как вы види-

те, это выдержка из нашей книги. В ней присутствуют заголовки и текстовые бло-

ки, идущие одним непрерывным потоком. Если вы откроете палитру Paragraph 

Styles при помощи команды главного меню Window > Styles > Paragraph Styles, то 

увидите, что текстовому блоку и заголовкам присвоены соответствующие стили. 

Предположим, что нам необходимо сделать настройки для того, чтобы каждый из 

наших заголовков стал пунктом навигационного оглавления. 

Для этого, в первую очередь, нам нужно создать стиль оглавления, выбрав пункт 

главного меню Layout > Table of Contents Styles (рис. 2.2). Далее, нажав кнопку 

New, мы переходим в раздел создания нового стиля оглавления. 

 

Рис. 2.2. Вид диалогового окна Table of Contents Styles 

 

В поле TOC Style диалогового окна New Table of Contents Style (рис. 2.3) дадим 

этому стилю имя, например "epub TOC". Чтобы добавить в оглавление наши заго-

ловки, найдем стиль параграфа, примененный к ним, в правой колонке; как вы 

помните, он называется Subhead. Нажатие кнопки Add добавит данный стиль па-

раграфа в определение навигационного стиля. Если вы хотите сделать многоуров-

невое оглавление, то InDesign предоставляет также и такую возможность. Для этого 
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просто нужно добавить в левый столбец стиль ваших подзаголовков и, ниже, в раз-

деле Style, выбрав его, увеличить значение в списке Level до 2. Таким образом, мы 

получим заголовок второго уровня. Далее, добавляя дополнительные стили и регу-

лируя их вложенность, мы можем создавать многоуровневое дерево навигации, ко-

торое позволит пользователю с большим удобством перемещаться по разделам 

книги. Однако сейчас для примера давайте организуем TOC Style всего с одним 

уровнем. 

 

Рис. 2.3. Вид диалогового окна New Table of Contents Style 

На базе этого стиля мы не будем пока создавать само содержание внутри докумен-

та — об этом мы поговорим несколько позже, а просто используем его в настрой-

ках навигационного оглавления. Поэтому, когда стиль будет добавлен, мы просто 

нажимаем кнопку OK. 

Теперь, когда все настроено, выберем пункт главного меню File > Export и выбе-

рем внизу в качестве формата экспорта ePub. В дальнейшем, чтобы каждый раз не 

описывать эту процедуру, будем называть ее "Открытие диалогового окна экс-

порта ePub". 

Теперь, все, что нам остается сделать — это в раскрывающемся списке TOC Style 

раздела General выбрать наш созданный стиль epub TOC (рис. 2.4). 

Теперь можно смело нажимать на кнопку OK и смотреть, что у нас получилось 

(рис. 2.5). Как вы видите, на левой панели программы Adobe Digital Editions теперь 

присутствует встроенное в документ навигационное оглавление. Нажимая на каж- 
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Рис. 2.4. Вид диалогового окна EPUB Export Options при организации навигационного оглавления 

 

Рис. 2.5. Полученное навигационное оглавление в окне программы Adobe Digital Editions 
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дый из его пунктов, мы будем попадать на требуемый нам раздел книги. Вы можете 

поэкспериментировать с созданием многоуровневого TOC. Этот процесс абсолют-

но ничем не отличается от того, что мы сделали только что. Изменение будет за-

метно лишь при просмотре готового документа, и оно будет заключаться во вло-

женности пунктов навигации согласно созданной вами структуре. 

Следующий способ, который мы разберем, — создание навигационного ТОС с ис-

пользованием функции создания книги в InDesign. Для работы здесь нам понадо-

бятся несколько документов. Вы можете найти их в папке \Подготовка ePub\ 

TOC_FromBook нашей рабочей документации. Здесь, как вы видите, представлены 

те же самые разделы, что и ранее, но разбитые на отдельные файлы. Выберите  

в главном меню функцию File > New > Book и, используя семь файлов разделов, 

создайте новую книгу. Вы также можете использовать готовую книгу из файла 

Book.indb, расположенного в той же папке. 

Поскольку файлы были пронумерованы по очереди, в палитре Book они также вы-

строены в правильном порядке (рис. 2.6). Когда книга загружена, выберите в кон-

текстном меню палитры Book пункт Export Book to EPUB — в результате откро-

ется диалоговое окно экспорта ePub. Оставьте все настройки без изменений и на-

жмите OK. При просмотре полученного документа вы увидите, что каждый раздел 

назван соответственно первоначальному имени конкретного документа и внедрен в 

навигационное оглавление. Кроме того, этим способом мы добились эффекта раз-

деления рубрик, и теперь каждая глава начинается с новой страницы. Если проана-

лизировать полученный документ немного глубже, то мы также поймем, что для 

каждого из разделов при таком способе внутри ZIP-архива с расширением epub 

создается отдельный HTML-файл. 

 

Рис. 2.6. Вид палитры Book после создания книги 

Если вам не нравится, что в качестве названий разделов в навигационном оглавле-

нии автоматически используются имена файлов, последний, комбинированный 

способ, позволит исправить это. В данном случае нам вновь потребуется открытая 

в InDesign книга с загруженными в нее готовыми файлами. Но теперь давайте, пе-

ред тем как экспортировать книгу в ePub, создадим, как мы делали это в первом 
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способе, стиль оглавления. Нам не нужно делать его для каждого документа в кни-

ге, а достаточно лишь настроить один раз для мастера (он обозначен специальным 

значком слева от названия документа в палитре Book). Делается это так же, как  

в первом способе — создадим новый TOC Style с названием, к примеру, epub-book, 

используя стиль Subhead как базовый для него. Единственное отличие от того, что 

мы делали раньше, заключается в том, что обязательно нужно проследить, чтобы 

опция Include Book Documents в окне New Table of Contents Style была включена. 

Когда стиль оглавления создан, выберите его в знакомом вам раскрывающемся 

списке TOC Style диалогового окна экспорта ePub и экспортируйте данный доку-

мент. После открытия вы получите документ, не только обладающий навигацион-

ным оглавлением с корректными именами, но и состоящий из разделов, каждый из 

которых открывается с новой страницы. Тем самым мы смогли добиться объедине-

ния плюсов и устранения минусов обоих способов создания навигационного оглав-

ления. 
 

Разделение глав на базе Paragraph Styles 

Как мы видели в предыдущем разделе, экспорт ePub из книги InDesign, состоящей 

из нескольких документов, приводит к тому, что каждый из этих разделов впослед-

ствии в итоговом документе будет открываться с новой страницы. Однако не всегда 

это лучший способ добиться такого эффекта. Существует более технологичное и 

правильное решение. Для его осуществления в документе Main_Sample_work_ 

epub_TOC.indd из папки \Подготовка ePub создадим навигационное оглавление  

с помощью первого способа из прошлого раздела. При экспорте вы увидите, что, 

несмотря на то, что навигация работает прекрасно, разделы идут одним непрерыв-

ным потоком и не открываются при щелчке на соответствующем пункте навигаци-

онного оглавления с новой страницы. 

Для того чтобы настроить именно такое поведение, необходимо сделать еще один 

шаг — определить места принудительных разрывов страниц. Для этого, начиная  

с версии CS6, существует два способа. В более ранних версиях была возможность 

использовать разрывы страниц лишь для одного из Paragraph Styles, выбранного  

в диалоговом окне экспорта ePub. Данная функция сохранилась до сих пор. Для ее 

реализации в диалоговом окне экспорта ePub в разделе Advanced можно выбрать  

в раскрывающемся списке Split Document любой заранее созданный стиль пара-

графа, например Subhead (рис. 2.7). 

После нажатия кнопки OK вы сможете убедиться, что страницы разрываются не-

посредственно перед параграфом с указанным стилем. Этот способ удобен, когда 

мы работаем с простыми документами, требующими разрывов только перед одно-

типными заголовками или разделами. 

Однако в новой версии InDesign, вместе с сохранением этого варианта, существует 

более интересный способ. Давайте поговорим о нем подробней. Если мы хотим 

сделать разделение страниц более чем по одному стилю, например, одновременно и 

перед главами и перед параграфами, мы можем настроить так называемые метки  
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Рис. 2.7. Вид диалогового окна EPUB Export Options при настройке разбиения документа на основе стиля 

 

Рис. 2.8. Вид диалогового окна Paragraph Style Options при настройке разбиения документа на основе тегов 
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экспорта для любого количества стилей. Для этого нужно выбрать нужный стиль  

и, открыв двойным щелчком по его названию диалоговое окно Paragraph Style 

Options, в разделе Export Tagging установить флажок Split Document (EPUB only) 

(рис. 2.8). Такие манипуляции необходимо произвести с каждым стилем, перед аб-

зацами которого вы желаете поместить разрыв страниц. 

После этого нам останется только открыть диалоговое окно экспорта ePub и в уже 

знакомом нам раскрывающемся списке Split Document выбрать Based on 

Paragraph Style Export Tags. После экспорта вы сможете убедиться, что страницы 

прерываются как раз перед параграфами, в стиль которых вы ранее внесли метку  

о разрыве. Эта новая функция дает нам широчайшие возможности по структуриро-

ванию нашего ePub-документа и разделения его на отдельные страницы именно 

в тех местах, где нам это нужно. 

Зависимость вывода готового ePub-документа 

от видов форматирования 

До этого момента мы использовали, в основном, очень простые документы для 

экспорта — в них мы видели только текстовую информацию, причем идущую од-

ним непрерывным потоком. В связи с этим у нас не возникало проблем с сохране-

нием в итоговом документе порядка следования элементов. В этом разделе мы не-

сколько усложним нашу задачу и посмотрим, как будет вести себя при экспорте  

в ePub более сложная верстка, в которую внедрены такие элементы, как изо- 

бражения, текст в контуре, обтекание и др. Давайте откроем в InDesign файл 

Main_Layout.indd из папки \Подготовка ePub наших рабочих документов и сразу же 

откроем диалоговое окно экспорта ePub (рис. 2.9). 

Здесь, в раскрывающемся списке Content Order в группе Setup раздела General, 

который как раз и отвечает за порядок следования элементов в макете, мы увидим 

три варианта для выбора — Based on Page Layout (основываясь на расположении 

элементов на странице), Same as XML Structure (такой же как в XML-структуре 

документа), Same as Articles Panel (такой же как последовательность разделов  

в палитре Articles). Как вы видите, в настоящий момент активен только первый 

пункт. В следующих разделах мы обсудим остальные два. Сейчас же оставим все 

по умолчанию и нажмем кнопку OK. 

Получившийся документ (рис. 2.10), к сожалению, слабо напоминает то, что мы 

видели в оригинальной верстке. Самым первым отображается герб, после этого мы 

видим надпись "Рубрика “Мой любимый город”", следом идет текст "подготовлено 

для исторического архива города Санкт-Петербург". После этой части мы видим 

основной текст (сразу же оба соединенных текстовых блока с разных страниц), 

причем не в форме, как это было в InDesign. Последними в итоговом файле стоят 

заголовок и изображения с подписями. 

Во-первых, как вы уже заметили (рис. 2.11), все векторные графические элементы, 

такие как красные прямоугольники и форма обтекания текста, исчезли. К сожале- 
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Рис. 2.9. Вид диалогового окна EPUB Export Options  
при настройке последовательности элементов верстки 

нию, они не поддерживаются стандартом ePub 2.0 и автоматически исключаются из 

документов этого типа. 

Во-вторых, перед нами встает логичный вопрос о том, руководствуясь каким прин-

ципом InDesign расставил элементы верстки при экспорте именно в таком порядке. 

Ответ на это достаточно прост. Все дело в том, что при включенной опции Based 

on Page Layout в расстановке элементов в итоговом ePub-файле главным фактором 

является то, как они расположены на листе в рабочей области InDesign. Здесь дей-

ствует простой порядок следования — слева направо и сверху вниз. То есть первым 

объектом, который попадет целиком в ePub, будет самый левый на листе — как вы 

видите, у нас это два объекта — герб и "Рубрика “Мой любимый город”". В данном 

случае вступает в действие второе правило — сначала следует объект, расположен-

ный выше, следом — тот, что ниже. Поэтому-то последовательность в ePub имеет 

именно такой вид: сначала герб, затем рубрика. Как вы видите, все дальнейшие 

элементы следуют именно в таком порядке. Важный момент, на который обяза-

тельно следует обратить внимание, — это текст. Вы должны запомнить, что текст 

всегда вставляется целиком, независимо от того, из скольких связанных текстовых 

блоков он состоит. В нашем примере в исходном файле было два текстовых блока 

на разных листах; тем не менее, в итоговом файле текст идет сплошным потоком. 

Однако текстовые блоки, не соединенные в один поток, а стоящие отдельно,  
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Рис. 2.10. Верстка в начальном файле 

 

Рис. 2.11. Верстка в полученном ePub файле 
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в своей расстановке будут руководствоваться правилом слева направо, сверху вниз. 

Это можно наблюдать в примере с подписью к изображениям. 

Знание и умение использовать данные правила позволяет управлять версткой по-

средством перемещения объектов в InDesign и является первым и самым простым 

способом реализации этой задачи. Как резюме, если вы хотите, чтобы объект в ито-

говом файле отображался в первую очередь, просто поместите его на листе левее 

и выше тех объектов, которые должны идти после него. 

Использование палитры Articles  
для управления отображением верстки 

Предыдущий способ управления версткой, который мы рассмотрели, безусловно, 

подкупает своей простотой, однако делает сам процесс работы не совсем техноло-

гичным и наглядным. 

В этом разделе мы будем развивать навыки управления потоком верстки и разбе-

рем второй способ — использование палитры Articles. 

Для работы понадобится уже знакомый нам файл Main_Layout.indd из папки 

\Подготовка ePub, а также палитра Articles, которую можно вызвать с помощью 

команды главного меню Window > Articles (рис. 2.12). 

  

Рис. 2.12. Вид палитры Articles при работе 
с множественными элементами верстки 

Рис. 2.13. Вид диалогового окна New Article 

 

С помощью этой палитры мы можем управлять порядком следования элементов  

в экспортируемом документе без необходимости физически перемещать их по лис-

ту. Добавить элементы или разделы в палитру можно двумя способами. Во-первых, 

просто перетащив тот или иной элемент на палитру и задав для него соответст-

вующее имя в открывшемся диалоговом окне New Article (рис. 2.13). 

Здесь же, кстати, с помощью флажка Include When Exporting можно либо вклю-

чить, либо исключить создаваемый элемент из экспорта. После создания вы увиди-
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те, что в палитре отображается раздел и под ним его содержимое. Перетаскивая 

следующие элементы на палитру, вы уже сможете вставлять их в созданные ранее 

разделы. Будьте крайне внимательны, чтобы не забыть включить в палитру все 

элементы, присутствующие на листе, т. к. если этого не сделать, то неиспользуемые 

элементы не будут включены в итоговый файл. Сейчас можете попробовать  

экспортировать документ в ePub — как вы заметили, в знакомом нам раскрываю-

щемся списке Content Order стал доступен для выбора пункт Same as Articles 

Panel. Выберем его и нажмем кнопку OK. Остальные настройки можно не менять. 

Как вы видите, в публикацию попали только те элементы, которые были внедрены 

в палитру Articles. 

Второй способ создания разделов в палитре Articles — нажатие кнопки New Article 

в правом нижнем углу палитры. В результате откроется то же самое диалоговое 

окно, но после создания, если у вас в рабочей области не было выделено ни одного 

документа, раздел будет пустым. В случае если таковые присутствовали, то именно 

они и попадут в новый раздел. Обратите внимание на то, что при желании вы мо-

жете включать один и тот же элемент из рабочей области в разные разделы в па-

литре Articles. Это приведет к тому, что в полученной публикации данные элемен-

ты будут повторяться. 

Для того чтобы удалить раздел или какой-либо элемент в нем, можно использовать 

кнопку в форме мусорного ведра, расположенную в правом нижнем углу палитры. 

Заметьте, что объект будет удален только из палитры Articles, но не из документа 

InDesign. Однако если вы выделите какой-либо элемент и нажмете клавишу 

<Delete> на клавиатуре, то он будет удален именно из публикации. 

Добавьте в палитру Articles все оставшиеся в рабочей области элементы. Для этого 

просто выделите их одновременно и переместите в области палитры. Смело можете 

использовать группы — в палитре Articles вы сможете увидеть, из каких элемен- 

тов они состоят. С помощью перемещения элементов внутри данной палитры  

можно корректировать их положение в итоговой верстке. Когда вы поместите все 

объекты в палитру, экспортируйте документ в ePub с сохранением предыдущих 

настроек. 

У палитры Articles есть еще один немаловажный плюс. Она позволяет экспортиро-

вать в публикацию прежде недоступные нам векторные формы (рис. 2.14). В сле-

дующих разделах мы гораздо более подробно остановимся на этих возможностях. 

Пока же давайте удалим наши векторные прямоугольники и расставим все остав-

шиеся элементы в том порядке, в котором мы хотим их увидеть. После этого вы 

можете экспортировать полученный документ с выбранным в раскрывающемся 

списке Content Order значением Same as Articles Panel и посмотреть на результат. 

Последнее, что хотелось бы отметить, если вы хотите отключить загрузку какого-

либо раздела, добавленного в данную палитру, отключите галочку рядом с его на-

званием. Для включения раздела в публикацию вновь включите ее. 

Данный способ управления версткой лучше всего подходит для начинающих и бо-

лее опытных пользователей и позволяет в наглядной форме максимально гибко на-

страивать порядок следования элементов в вашей публикации. 
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Рис. 2.14. Верстка в полученном ePub-файле с использованием палитры Articles 

Использование XML-тегов  
для управления отображением верстки 

Последний и, пожалуй, самый профессиональный способ управления версткой  
в итоговом ePub-документе — это использование XML-тегов. Для реализации этой 
функции служит палитра Tags (рис. 2.15), которую можно вызвать, выбрав в глав-
ном меню пункт Window > Utilities > Tags. 

 

Рис. 2.15. Вид палитры Tags при работе с множественными элементами верстки 
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Первое, что нам нужно сделать, — это создать внутри документа InDesign теги, со-

ответствующие логическим частям публикации. Когда вы открываете палитру 

Tags, там всегда присутствует тег Root, являющийся коренным по умолчанию.  

В создании тегов нет ничего сложного. Достаточно просто нажать кнопку New Tag, 

расположенную в правом нижнем углу палитры, и дать ему соответствующее имя, 

например "headline" для заголовков, "byline" для подписей, "body" для основного 

текста. Обратите внимание на то, что для именования тегов можно использовать 

только маленькие латинские буквы и цифры, недопустимы заглавные буквы, про-

белы, знаки препинания и пр. Таким же образом создайте теги для всех логических 

видов объектов. Перед следующим шагом немного изменим модель просмотра на-

шего рабочего документа — выберем пункт главного меню View > Structure > 

Show Tagged Frames. 

Теперь, чтобы применить тег к конкретному объекту, нам нужно выделить элемент, 

скажем заголовок, и просто щелкнуть по названию тега, в данном случае headline. 

Давайте разметим таким образом все фреймы, которые мы имеем в нашей рабочей 

области. 

Здесь, так же как и в случае с палитрой Articles, все элементы, не помеченные 

своими тегами, просто не будут включаться в публикацию при экспорте. 

После того как все элементы размечены, откроем панель Structure при помощи 

пункта главного меню View > Structure > Show Structure и, развернув список 

Root, нажав на маленький треугольник  слева от него, вы сможете увидеть тот 

порядок, в котором будут экспортироваться объекты в итоговую публикацию 

(рис. 2.16). 

 

Рис. 2.16. Вид структуры документа после разметки тегами 

Здесь вам может помочь одна удобная функция. В контекстном меню панели 

Structure выберите пункт Show Text Snippets — он отобразит небольшие подсказ-

ки рядом с каждым из тегов и вам сразу же станет понятно, что к чему относится.  
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В данной панели, перемещая теги один относительно другого, мы можем регулиро-

вать расположение соответствующих им объектов в конечном ePub-документе. 

После того как нужный вам порядок выстроен, выберите в знакомом нам раскры-

вающемся списке Content Order пункт Same as XML Structure и, не меняя  

остальные настройки, экспортируйте документ в ePub. 

Как вы уже, наверное, поняли, структура тегов из документа InDesign сформирова-

ла соответствующую последовательность объектов в конечном ePub-документе. 

Все три из рассмотренных нами способов позволяют корректно регулировать по-

следовательность элементов верстки в итоговой публикации, и каждый из них мо-

жет быть полноценно использован для решения подобных задач различной слож-

ности. 
 

Соглашение об именовании внутренних стилей  
и файлов верстки 

Когда мы занимаемся подготовкой макетов для электронных публикаций в формате 

ePub, одним из немаловажных моментов является то, каким образом данные файлы 

будут названы. Также не стоит забывать об определенных стандартах в именовании 

внутренних стилей, внешних ссылок и прочих служебных объектов в рабочем до-

кументе InDesign. 

Давайте обсудим, какие же правила существуют для задания этих имен. Во-первых, 

так наш итоговый ePub-файл — это, по сути, архив, внутри которого располагаются 

HTML-файлы, описывающие содержимое и CSS-стили, характеризующий внешнее 

представление или вид этого содержимого. Внутри CSS-файла стили из InDesign 

автоматически конвертируются в соответствующие классы, которые затем при-

сваиваются соответствующим параграфам публикации. Исходя из этого, в зависи-

мости от того, какое имя вы дадите стилю в InDesign, такое же имя получит класс 

CSS, а к этим именам уже есть особые требования. То же самое касается ссылок на 

внешние файлы. 

Исходя из всего вышесказанного, рекомендуется всегда придерживаться следую-

щих несложных правил при именовании файлов и служебных объектов: 

1. Всегда используйте только латинские символы или цифры (Aa—Zz, 0—9).  

В случае нарушения этого и использования, к примеру, символа "/", он может 

быть воспринят компилятором HTML, как часть ссылки или адреса. Это может 

привести к ошибкам при открытии файла. 

2. Не используйте символ пробела. Если возникает необходимость разделить слова 

в названии, то можно применить дефис "-" и нижнее подчеркивание "_" или же 

использовать имена следующего вида "FileName". 

Если в вашей книге или публикации есть файл, определяющий обложку, пользуй-

тесь теми же требованиями, что указаны выше, т. к. именно ими руководствуются 

при приеме данных файлов интернет-магазины, такие как Amazon. 



118 Глава 2 

Мы еще не раз вернемся к названиям файлов в следующих разделах, а пока что 

просто запомните эти несложные правила. 

Наконец, если вы хотите больше узнать о порядке именования файлов и наверняка 

быть уверенными в том, что все ваши файлы называются правильно, то можно вос-

пользоваться соответствующими инструкциями, которые можно найти на сайте 

http://msdn.microsoft.com/en-us/library/windows/desktop/aa365247(v=vs.85).aspx. 

Управление отступами в тексте 

Часто случается так, что документы, отправляемые на печать или же сохраняемые  

в формате PDF, выглядят совсем не так, как при экспорте в ePub. Как мы уже поня-

ли, это происходит из-за особых требований и условий, предъявляемых к конечной 

верстке данным стандартом в формате ePub. 

Такая же ситуация происходит при экспорте документов, у которых межстрочный 

интервал задан нестандартными методами — в некоторых случаях, результат та- 

кого экспорта просто непредсказуем. Давайте разберемся с этой проблемой на при-

мере. 

Откройте документ Main_Spacing.indd из папки \Подготовка ePub и попробуйте 

экспортировать его сразу же в ePub. Для экспорта смело можете использовать на-

стройки по умолчанию. Как вы видите, после этого все интервалы между строками 

и абзацами исчезли. Давайте посмотрим, почему это произошло. Для этого перей-

дем из текущего режима отображения документа в нормальный режим нажатием 

горячей клавиши <W>. Теперь стало очевидно, что это произошло из-за того, что 

текст в этом документе был представлен не как общий поток, а как разобщенные 

блоки или фреймы. Вам необходимо запомнить, что при экспорте в ePub ни гео-

метрия, ни взаимное расположение фреймов не учитывается. Текст все равно груп-

пируется в единый непрерывный поток. 

Для того чтобы исправить текущее состояние, давайте в первую очередь соберем 

весь имеющийся текст в одном фрейме. Для этого, кстати, совсем не обязательно 

копировать и вставлять каждый из блоков. Достаточно просто объединить их в 

один, щелкая по значку переполнения каждого (цветной квадратик на правой грани 

текстового фрейма) и отпуская кнопку мыши с нажатой клавишей <Alt> на сле-

дующем. После этого просто удалите все фреймы кроме первого и увеличьте его в 

размере так, чтобы он занимал всю страницу. Итак, мы поместили весь текст в один 

фрейм. Теперь давайте попробуем задать между строками различный интервал. 

Первый способ — просто попробуем несколько раз нажать клавишу <Enter> после 

каждой строки. Визуально интервал появился. Но что же будет при экспорте  

в ePub? Как вы видите, в итоговом документе никаких изменений не произошло. 

Это случилось из-за того, что, как вы уже наверное поняли, многократные прину-

дительные переходы на новую строку форматом ePub также игнорируются. 

Теперь, когда мы убедились в несостоятельности предыдущих способов, давайте 

уберем лишние переносы строк и перейдем к единственно верному способу реше-

ния этой задачи. Этим решением может быть только использование заданных ин-
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тервалов при помощи палитры Paragraph или стилей с уже заданными интервала-

ми для параграфа. Для этого выделите любой из абзацев, для которых вы хотите 

настроить отступ, перейдите с помощью специальной кнопки в режим Paragraph 

Formatting Control панели настроек в верхней части экрана (рис. 2.17) и увеличьте 

значение параметра Space Before до уровня, когда отступ будет заметен вашему 

глазу. 

 

Рис. 2.17. Положение кнопки Paragraph Formatting Controls в палитре настроек 

После этого можете экспортировать данный документ в ePub. Единственное, что 

вам нужно будет сделать до этого — проверить, чтобы в группе CSS Option разде-

ла Advanced диалогового окна экспорта ePub-документа EPUB Export Options был 

установлен флажок Preserve Local Overrides (рис. 2.18). Эта опция отвечает за  
 

 

 

Рис. 2.18. Флажок Preserve Local Overrides в диалоговом окне EPUB Export Options 
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включение режима, при котором во время экспорта будут учитываться все локаль-

ные изменения в стилях. 

Чтобы стало понятно, что это значит, представьте, что ко всем абзацам в документе 

применен один и тот же стиль. Мы выбираем один из них и в палитре настроек, как 

мы с вами это недавно сделали, меняем только для этого абзаца какой-либо пара-

метр. Это изменение и называется Local Override. Опция же, призванная учитывать 

это сохранение при экспорте, называется, соответственно, Preserve Local Overrides. 

Теперь посмотрите, что получилось в результате экспорта — как видите, расстоя-

ние между заданными абзацами теперь отображается корректно. 

Как вы понимаете, настраивать данные расстояния для каждого конкретного абзаца 

не имеет никакого смысла, поэтому самое правильное, что можно сделать — это 

добавить настройку отступа в каждый стиль параграфа. Однажды сделав это, вам 

больше не придется настраивать отступы для каждого абзаца отдельно — это будет 

происходить автоматически. Ну и, конечно же, вся эта информация будет учиты-

ваться при экспорте в конечном ePub-документе. 

Исправление ошибок в непечатаемых символах 
верстки ePub с помощью автозамены 

В зависимости от того, каким образом был подготовлен ваш изначальный документ 

InDesign, в нем могут встречаться такие ошибки, как повторяющиеся переносы 

строк, лишние знаки табуляции, непечатаемые символы и пр. В некоторых случаях 

это недопустимо и может повлечь за собой ошибки. Например, одну из таких оши-

бок мы видели с вами в прошлом разделе, когда говорили о расстоянии между 

строками. В этом разделе мы поговорим о разных способах устранения этих не-

нужных символов. 

Откройте уже знакомый нам файл Main_Spacing.indd из папки \Подготовка ePub 

наших рабочих документов. Если вы включите режим демонстрации непечатаемых 

символов, то увидите здесь очень много подобных моментов. 

Первый способ устранения данных объектов заключается в ручном поиске и удале-

нии всех этих элементов. Как вы понимаете, это не технологичный способ и может 

отнять у вас очень много времени. Поэтому, давайте не будем на нем останавли-

ваться. 

Следующий и гораздо более быстрый и удобный способ знаком большинству поль-

зователей InDesign, работающих с классической печатной версткой. Это автомати-

ческая замена, диалоговое окно которой Find/Change можно вызвать с помощью 

пункта главного меню Edit > Find/Change (рис. 2.19). 

В данном диалоговом окне, если мы перейдем на вкладку Text, можно простым 
способом устранять, скажем, повторяющиеся символы. Для этого достаточно в рас-
крывающемся списке Find what набрать, например, несколько пробелов, а в списке 
Change to — один. После нажатия кнопки Change All будет произведена замена 
заданного количества пробелов на один. Последовательно уменьшая количество 
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ненужных символов, мы придем к состоянию, в котором больше не происходит за-
мен. Это будет означать, что все подобные комбинации были исправлены. То же 
самое мы можем делать и с другими символами. Если вы не знаете, как обозначить 
тот или иной знак, нажмите кнопку @ справа от нужного списка и выберите необ-
ходимый символ при помощи меню подсказок. 

 

Рис. 2.19. Вид диалогового окна Find/Change 

Однако, пожалуй, самый удобный способ делать замены повторяющихся объек-
тов — использование GREP (Global Regular Expression Print) или регулярных выра-
жений. Для того чтобы сделать это, для начала перейдите на вкладку GREP окна 
Find/Change (рис. 2.20). Если вы раньше не работали с подобными выражениями, 
вы можете выбрать из раскрывающегося списка, расположенного в верхней части 
данного диалогового окна, одну из предложенных предустановок, например 
Multiple Space to Single Space для устранения множественных пробелов. 

Кроме множественных повторяющихся пробелов или переносов строк, есть также 
ряд дополнительных символов или сочетаний символов, появление которых в ито-
говой ePub-публикации нежелательно. Вы, в некоторых случаях, даже не всегда 
сможете увидеть какие-либо визуальные проблемы в самом издании, однако при 
попытке пройти валидацию, в случае присутствия данных символов, вы наверняка 
не сможете сделать это. Поэтому, самый лучший способ избежать данных про-
блем — это устранить их еще до момента экспорта. 

Одним из примеров такого символа является принудительный обрыв строки 
(рис. 2.21). При верстке классического издания подобные объекты часто использу-
ются для вгонки или выгонки строк. 

В электронном же устройстве чтения у нас в принципе не существует понятия  

о ширине строк, т. к. эта величина является переменной и зависит как от размера 
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самого устройства, так и шрифта, выбранного пользователем. Именно поэтому на-

личие данного символа в вашей публикации не позволит ей пройти валидацию для 

дальнейшего распространения среди пользователей через один из каналов, таких 

как Amazon. 

 

Рис. 2.20. Вид диалогового окна Find/Change в режиме GREP 

  

Рис. 2.21. Символ принудительного обрыва строки 
в тексте 

Рис. 2.22. Символ  
условного дефиса в тексте 

Еще одним таким значком может быть так называемый условный дефис или 
discretionally hyphen. Данный символ, будучи поставленным перед тем или иным 
словом, зачастую используется дизайнерами и верстальщиками для того, чтобы 
предотвратить разбиение данного слова при переносе (рис. 2.22). Как вы понимае-
те, его наличие также противоречит идеологии формата ePub. 

Кроме вышеописанных, существует еще один знак, который управляет поведением 
слов на строке, — это неразрывный пробел. Как вы, наверное, знаете, этот символ 
служит для того, чтобы при переходе на новую строку слова, между которыми он 
установлен, не разрывались, а переносились вместе. 
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Все эти элементы мы можем также устранять с помощью простых команд 
Find/Change. Однако есть другой, гораздо более элегантный и быстрый способ 
сделать это. Он называется Find/Change by List или групповой поиск и замена,  
это один из бесплатных скриптов, идущих в стандартной поставке InDesign. Вы 
можете найти его, выбрав в главном меню пункт WIndow > Utilities > Scripts.  
В данной одноименной палитре Scripts внутри папки Application находится  
папка Samples, внутри которой находится еще одна с названием JavaScript 
(рис. 2.23). Именно в ней вы можете найти этот скрипт — здесь он называется 
FindChangeByList.jsx. 

 

Рис. 2.23. Вид палитры Scripts с выделенным скриптом FindChangeByList.jsx 

По сути, данный скрипт является последовательностью правил поиска и замены, 
собранных в один файл. Если мы щелкнем по нему, то нам будет предложен выбор: 
производить поиск по всему документу или же лишь по выбранной группе тексто-
вых фреймов. Пока что не будем выполнять поиск. Сначала разберемся с тем, как 
он, собственно, работает. Для поиска и замены данный скрипт использует тексто-
вые инструкции, которые хранятся в одноименной папке под именем 
FindChangeList.txt. Если щелкнуть по данному файлу правой кнопкой мыши, 
можно выбрать пункт Reveal in Explorer или Reveal in Finder, если вы работаете 
на Mac, после чего можно просто открыть этот файл как обычный документ и про-
смотреть его содержимое. 

В начале данного файла следуют инструкции по тому, каким образом можно про-

писывать выражения для поиска и замены, после начинается сама программная 
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часть. Каждое из выражений данной последовательности выглядит примерно сле-

дующим образом (листинг 2.1). 

Листинг 2.1. Типовое выражение автозамены 

grep   {findWhat:"  +"}   {changeTo:" "}   {includeFootnotes:true, 

includeMasterPages:true, includeHiddenLayers:true, wholeWord:false} 

 

Данное выражение описывает поиск всех повторяющихся пробелов и замену их на 
одинарный. Дальше следуют выражения по замене повторяющихся переносов 

строк, изменения дефисов на тире и т. д. В нашей работе мы можем использовать 
не только эти заранее прописанные инструкции, но и создавать свои. Это является 

удивительной особенностью InDesign. Однажды созданный набор инструкций на-
всегда может избавить нас от необходимости контролировать наличие тех или 

иных символов, а позволит решать эту проблему простым запуском одного лишь 
скрипта. Для того чтобы проверить наличие недопустимых для формата ePub  

символов, в папке \Подготовка ePub\Scripts лежит заранее подготовленный  
файл FindChangeByList-epub.jsx и, вместе с ним в одноименной папке —  

FindChangeList-epub.txt, содержащий все инструкции по поиску и замене данных 
символов. Внимательно изучив его, вы найдете, что, во-первых, в нем присутству-

ют все стандартные правила, которые мы уже видели, и, во-вторых, что в него так-
же добавлены специфические вещи для формата ePub, такие как неразрывные про-

белы, условные дефисы и т. д. 

Давайте разберемся, каким образом можно применить данные инструкции. В пер-
вую очередь вы должны поместить скрипт вместе с файлами инструкций в соответ-

ствующую папку на вашем компьютере. Если вы не знаете, где она находится, то 
щелкните правой кнопкой мыши по любому элементу палитры Scripts и в открыв-

шемся контекстном меню выберите пункт Reveal in Explorer/Finder. В открыв-
шемся окне вы сможете увидеть адрес, по которому располагаются все папки со 

скриптами, в том числе папка User, служащая для размещения пользовательских 
скриптов. Поместите внутри нее наш готовый скрипт, не забыв рядом разместить 

папку с инструкциями для него. После этого найдите в папке User палитры скрипт 

Scripts FindChangeByList-epub.jsx и дважды щелкните по нему. После этого вер-
нитесь к нашему тексту и посмотрите, какие изменения с ним произошли. Как вы 

видите, все инструкции сработали четко — все нежелательные символы были ав-
томатически убраны. Таким образом, с использованием скриптов с прописанными 

GREP-выражениями мы можем вывести рутинную работу по поиску и устранению 
ненужных элементов в нашей публикации на совершенно новый уровень, пол- 

ностью автоматизировав ее. 

Применение стилей параграфа и символа 

Когда вы конвертируете документ InDesign в формат ePub, все стили, как парагра-

фов, так и символов, автоматически преобразуются в один CSS-документ (Cascade 

Style Sheet). Если вы знакомы с web-графикой, то это определение должно быть вам 
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понятно. Если же нет — ничего страшного, в процессе работы вы все поймете, т. к. 

в следующих разделах мы будем достаточно часто касаться этой темы. По сути, 

каскадные таблицы стилей, а именно так переводится данный термин, это наборы 

правил, описывающих внешнее представление элементов. Данные правила посред-

ством особых методов иерархии, таких как классы, привязываются к тем или иным 

элементам HTML-документов, указывая, каким образом они должны отображаться. 

Проще говоря, если один из параграфов имел в InDesign стиль Subhead, предписы-

вающий жирное начертание шрифта Myriad Pro и оранжевый цвет, то при экспорте 

в HTML-документ будет помещено примерно следующее выражение (листинг 2.2): 

Листинг 2.2. Пример содержимого HTML-файла 

<h1 class="subhead">Текст заголовка</h1>. 

 

Одновременно с этим, в CSS-файл будет добавлено описание внешнего вида данно-

го заголовка (листинг 2.3). 

Листинг 2.3. Пример содержимого CSS-файла 

h1.subhead { 

 font-family: "Myriad Pro"; 

 font-weight: bold; 

 color: #ff5200; 

}. 

 

В этом примере представлены только лишь немногие параметры, чаще всего их 

бывает значительно больше. 

Теперь, когда мы поняли, каким образом выглядит экспортированный в формат 

ePub фрагмент текста, оформленный в InDesign с помощью стилей, давайте разбе-

ремся, почему же так важно использовать именно стили, а не верстать каждый эле-

мент по отдельности. На это есть ряд причин. Первая из них очевидна и не отно-

сится к области электронных публикаций — использование стилей существенно 

упрощает процесс верстки и экономит огромное количество времени на эту  

работу. Вторая причина не так тривиальна, именно с ней мы сейчас и будем разби-

раться. 

Предположим, что мы имеем достаточно простой документ. В качестве примера 
давайте продолжим работать с предыдущим документом Main_Spacing.indd из пап-

ки \Подготовка ePub. В данном файле, как вы видите, есть ряд параграфов, к кото-
рым применены стили. Вместе с этим, здесь также присутствуют так называемые 

переопределения или overrides. Мы немного касались их ранее. Напомню вам, что 
override в понятиях среды InDesign — это любое изменение внешнего вида текста 

вне стиля. К примеру, в данном файле к переопределениям можно отнести текст, 

написанный жирным курсивным начертанием, т. к. данные его особенности были 
приданы не с помощью создания нового стиля, а просто с помощью изменения зна-
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чений в палитре настроек в верхней части рабочей области. Чтобы определить 

это — просто посмотрите на палитру Paragraph Styles при выделении какого-
нибудь параграфа. Если рядом с именем стиля вы видите знак "+", значит в данном 

параграфе присутствуют переопределения. К чему это может привести при экспор-
те в формат ePub? Давайте попробуем проверить это. При экспорте можете оста-

вить все опции по умолчанию. Обязательно обратите внимание на то, что настрой-
ка Preserve Local Overrides, о предназначении которой мы уже говорили ранее, 

включена. После загрузки полученного документа вы увидите, что вся верстка вы-
глядит прекрасно, все переопределения также сохранены в полученном файле. Ло-

гичным будет вопрос, в чем же тогда проблема? А проблемы начинаются тогда, 
когда мы приступаем к более детальной проработке нашего файла, уже не с по- 

мощью InDesign, а корректируя код HTML и CSS итогового файла. Дело в том, что 
InDesign, к сожалению, пока не позволяет внедрять и полноценно настраивать все 

функции, которые поддерживает стандарт ePub. Поэтому зачастую мы прибегаем  
к ручной корректировке файлов уже после экспорта. Вот на этом-то этапе и всплы-

вают все сложности с переопределениями. Для примера, давайте изменим у полу-

ченного ePub-файла расширение на zip и разархивируем его любой предназначен-
ной для этого программой. Удобнее всего использовать для этого такие редакторы, 

как Notepad++ для Windows и Text Wrangler для Mac. Они позволяют открывать 
ePub-файлы даже без разархивирования и предварительного изменения расши- 

рения. 

Итак, после открытия в папке OEBPS вы сможете найти полученный в ходе экспор-
та HTML файл Main_Spacing.xhtml. Если вы бегло просмотрите его текст, то увиди-

те в нем большое количество следующих элементов: char-style-override-1, char-

style-override-2 и т. д. Это как раз и есть те самые переопределения. Дело в том, 
что при экспорте в таблице стилей для каждого из этих override создается свой соб-

ственный класс. Если в вашем тексте принудительно вне стилей будет выделено 
жирным 100 фрагментов, то вы в вашем конечном файле получите после экспорта 

100 новых классов. При этом, помимо того, что вы солидно увеличите объем файла, 
текст в HTML станет практически нечитаемым, что, соответственно, лишит нас 

возможности его детальной корректировки. То же самое касается и каскадных таб-
лиц стилей. 

Теперь давайте вернемся в InDesign и попробуем вновь экспортировать наш доку-

мент, но уже с другими настройками. В данном случае, давайте отключим опцию 
Preserve Local Overrides. После экспорта вы наверняка обратите внимание на то, 

что в документе исчезнут все переопределения, как и проблемы, с ними связанные. 

Как вы понимаете, и тот и другой вариант, рассмотренные ранее, являются некото-
рыми компромиссами для достижения или одной или другой цели. Теперь давайте 

попробуем добиться одновременного выполнения и сохранения стилистического 
оформления и отсутствия перегруженности конечных документов. 

Первым и самым очевидным способом достижения этого является задание для  
каждого из переопределений собственного стиля paragraph или character style.  

Однако, как вы понимаете, это может в случае работы с большими документами 

отнять значительное время. 
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Следующий способ решения нашей задачи — использование знакомой нам функ-

ции окна Find/Change. В данном диалоговом окне на вкладке GREP (рис. 2.24),  

в нижней его части, присутствует функция поиска по формату и замены на другой 

формат соответственно. 

 

Рис. 2.24. Вид нижней части диалогового окна Find/Change  
для поиска и замены по стилевым особенностям 

 

Для того чтобы ее использовать, оставьте поля раскрывающихся списков Find what 

и Change to пустыми, а для полей Find Format и Change Format задайте искомый 

и целевой форматы с помощью стандартного диалогового окна настройки стиля. 

Что самое важное в данном окне — это то, что вы можете в разделе Style Options 

выбрать либо существующий стиль, либо создать новый специально для того или 

иного вида форматирования. После нажатия на кнопку Change All вы увидите, что 

все неразмеченные стилем искомые элементы будут заменены точно такими же, но 

уже с присвоенным стилем Character Style. Это второй способ разрешения данной 

ситуации. 

Но существует самый быстрый и простой способ для достижения нашей цели, и, 

как и в прошлом разделе, — это специальный скрипт. Он называется PrepText.jsx, 

вы можете найти его в папке наших рабочих материалов или скачать с сайта 

http://indesignsecrets.com. К счастью, он находится в свободном доступе и беспла-

тен. Все, что делает этот скрипт — это анализирует текст на наличие переопреде-

лений и, при нахождении их, создает новый стиль символа и присваивает его най-

денному фрагменту. 

Для того чтобы попробовать его в действии, перенесите его уже известным вам 

способом в палитру Scripts и запустите при открытой палитре Character Styles. Вы 
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увидите, как в данной палитре появляются новые стили. Что примечательно, если  

в тексте встречаются, скажем, два фрагмента, выделенных одинаковым форматиро-

ванием, будет создан всего один стиль, однако применен он будет к обоим фраг-

ментам. Если вы теперь выберите любой из фрагментов, в котором ранее присутст-

вовало переопределение, то вы увидите, что сейчас для него создан соответствую-

щий стиль. 

Наконец, давайте вновь экспортируем полученный текст и, увидев, что все форма-

тирование сохранилось, откроем итоговый файл в одном из редакторов, Notepad++ 

или Text Wrangler. Сделав это, вы сможете также убедиться, что все внутренние 

файлы на этот раз выглядят структурированными и не перегружены ненужной ин-

формацией. 

Методика работы с таблицами 

Если вы работаете с документом InDesign, который содержит таблицы, информация 
из данных таблиц будет включена при экспорте в итоговый ePub-файл. Однако при 

этом вы, наверняка, потеряете большую часть форматирования и параметров внеш-

него отображения таблицы, таких как заливки и границы. К счастью, это может 
быть легко восстановлено в CSS-файле уже после экспорта. 

Для примера, откройте файл Main_Table.indd из папки \Подготовка ePub нашей ра-
бочей документации. После этого, убедитесь в том, что вы находитесь в нормаль-

ном режиме просмотра (переключение между режимами, как вы помните, можно 

осуществить с помощью горячей клавиши <W>). Обратите внимание на то, что 
таблица внедрена в текстовый блок и, кроме того, вставлена в поток параграфов. 

Кроме того, весь текст, находящийся в таблице, размечен специальными стиля-
ми — вы можете удостовериться в этом, открыв палитру Paragraph Styles. 

Теперь, когда мы поняли, с каким документом имеем дело, давайте сразу же экс-
портируем его в ePub. При этом можете использовать настройки по умолчанию. 

Как вы видите, таблица сохранила в том или ином виде свой характер (рис. 2.25), 

т. е. мы все так же видим строки, столбцы и даже какое-то подобие форматирова-
ния — к примеру, сохранился цвет текста. Кроме того, мы также видим обводку 

ячеек таблицы. Вы должны понимать, что при использовании Adobe Digital Editions 
таблица может выглядеть не совсем так, как это будет происходить на конечном 

устройстве. Кстати, чтобы дополнительно убедиться в этом, вы можете скачать 

специальный плагин для своего браузера, который позволит открывать и просмат-
ривать ePub-файлы. Сделав это и открыв данный документ в браузере, вы наверня-

ка увидите совершенно другое состояние таблицы, и, скорее всего, выглядеть она 
будет значительно лучше (рис. 2.26). 

Все дело в том, что так как формат ePub построен изначально на HTML, а для брау-

зеров — это, по сути, родной язык, компилировать страницы они будут значитель-

но лучше, чем Adobe Digital Editions. 

Теперь давайте откроем наш ePub-файл в одном из HTML-редакторов. Нам нужно 

обратиться к файлу Main_Table.xhtml, находящемуся в папке OEBPS. Если вы  
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Рис. 2.25. Вид таблицы в экспортированном документе 

 

Рис. 2.26. Вид таблицы в экспортированном документе при просмотре в браузере Safari 
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спуститесь немного ниже по тексту, то увидите структуру примерно следующего 

вида (листинг 2.4): 

Листинг 2.4. Пример отображения таблицы в HTML-коде 

<table id="..." class="..."> 

<tr> 

<td> 

<p class="Имя класса">Текст из ячейки таблицы</p> 

</td> 

. 

. 

. 

</tr> 

</table> 

 

Для тех, кто знаком с языком HTML, данная структура является вполне понятной. 

Для тех же, кто впервые ее видит, поясняю — с помощью текстовых тегов, пред-

ставленных выше, можно описать таблицу абсолютно любой сложности. Тег 

<table> означает начало данной таблицы, <tr> задает последовательность строк, а 

<td> — столбцов. <p> внутри ячейки указывает на начало параграфа. В указанном 

примере у тега параграфа также есть класс. Мы ранее уже сталкивались с таким 

элементом, однако вы должны знать, что абсолютно у любого тега может быть соб-

ственный класс, причем он всегда наследуется для всех элементов, вложенных в 

него, если для данных элементов принудительно не заданы другие свойства. Ска-

жем, если в классе таблицы указать, что начертание текста должно быть жирным, 

то весть текст в ней будет обладать свойством bold. Но если у одного из вложенных 

элементов принудительно указать в настройках начертания — regular, то линия 

наследованная прерывается и текст, безусловно, будет руководствоваться только 

своими свойствами. 

В очередной раз обращаю ваше внимание на то, что если посмотреть на названия 

классов наших элементов, в том числе и табличных, то они будут строго соответст-

вовать таковым в InDesign-документе до экспорта. 

Если в вашей таблице присутствуют объединенные ячейки, то структура, описы-

вающая их, будет выглядеть приблизительно следующим образом (листинг 2.5): 

Листинг 2.5. Пример отображения объединенных ячеек таблицы в HTML-коде 

<td colspan="2"> 

<p class="Имя класса">Текст из ячейки таблицы</p> 

</td> 

 

Это означает, что вместе с текущей ячейкой необходимо объединить еще одну сле-

дующую. Объединение, кстати, всегда происходит слева направо. 
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А теперь перейдем к самому интересному. Если вы откроете файл template.css, ко-

торый описывает все внешнее представление ePub-документа, то вы увидите, что 

для каждого класса здесь прописаны правила отображения элементов, размеченных 

им. Это касается в равной мере и таблиц. Таким образом, внося изменения в данные 

структуры, мы можем корректировать их внешний вид. 

Еще один немаловажный момент заключается в следующем — если вы попробуете 

изменить ширину окна Adobe Digital Editions, то вы увидите, что текст формирует-

ся таким образом, чтобы всегда занимать ее всю площадь, чего нельзя сказать про 

таблицы. К сожалению, плавающая верстка таблиц практически невозможна в ePub 

и может потребовать значительных знаний в области web-дизайна, но даже это,  

к сожалению, не гарантирует корректный результат. Единственное, что мы можем 

сделать для правильного отображения содержимого таблиц — это тщательно про-

думывать его компоновку таким образом, чтобы даже на самом маленьком устрой-

стве, таком как iPhone, данные можно было легко различить и структурировать. 

На самом деле существует только один способ сделать так, чтобы сохранить внеш-

ний вид вашей таблицы неизменным вне зависимости от того, на каком устройстве 

она просматривается — это конвертация ее в растровое изображение. Если мы де-

лаем это и таблица перестает быть структурой данных, а превращается в простой 

набор пикселов, который уже не может быть интерпретирован иначе, чем он вы-

глядел при создании. Это, однако, приводит к тому, что вы теряете все возможно-

сти работы с данными в таблице — их уже нельзя найти поиском, выделить и т. д. 
 

Работа с графическими элементами  
и конвертация объектов InDesign  
в растровые изображения перед экспортом 

Вы уже успели заметить, что при экспорте в итоговый ePub-документ попадает не 

только текст, но и все внедренные изображения. Что не попадает в конечный доку-

мент при экспорте — так это все векторные контуры или графические элементы, 

созданные непосредственно в InDesign. Также, если мы работаем с текстом по кон-

туру, при экспорте будет сохранен только текст, контур обязательно исчезнет. 

Чтобы проиллюстрировать все вышесказанное, давайте откроем файл 

Main_Images.indd из папки \Подготовка ePub наших рабочих документов и сразу же 

экспортируем его в ePub с настройками по умолчанию. Как вы видите, все, что мы 

описали ранее, имеет место быть на практике. Как же тогда включить все те эле-

менты, которые мы создали? В этом разделе мы постараемся досконально разо-

браться в этом. 

По сути, если вы хотите экспортировать векторные элементы в итоговый ePub, то 

вам необходимо конвертировать их во внедренную растровую графику. Для этого 

есть два шага. Во-первых, вы можете с помощью команды меню File > Export экс-

портировать данные элементы по отдельности в такие графические форматы, как 

JPEG или GIF, а после внедрить их уже в таком виде в публикацию перед экспор-
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том. Однако данный вариант, как вы понимаете, требует значительных усилий и 

времени. Поэтому в InDesign предусмотрен другой способ для решения этой зада-

чи. Он заключается в том, чтобы установить параметры графики таким образом, 

чтобы InDesign автоматически при экспорте конвертировал их в требуемый формат 

уже с нужным разрешением. 

Этот способ дает нам ряд преимуществ. Во-первых, мы экономим значительное 

количество времени, теряя необходимость принудительно переопределять все век-

торные элементы в публикации. Во-вторых, все эти элементы остаются полностью 

редактируемыми в среде InDesign, т. к., по сути, остаются векторными объектами 

до момента непосредственно экспорта. 

Для реализации данного способа необходимо выделить требуемый объект и вы-

брать из главного меню пункт Object > Object Export Options. Давайте начнем ра-

боту с настройками корректного экспорта векторной кривой в нижней части доку-

мента. 

 

Рис. 2.27. Вид диалогового окна Object Export Options 

После открытия диалогового окна Object Export Options перейдите на вкладку 

EPUB and HTLM и установите флажок Custom Rasterization (рис. 2.27). В данном 

случае все, что в настоящий момент выделено в рабочей обрасти InDesign, при  

экспорте в ePub будет конвертировано в растровое изображение с использованием 

настроек, представленных на данной вкладке. На этой вкладке, помимо уже знако-

мых нам раскрывающихся списков Format, Resolution, Quality, Method, отвечаю-

щих за качество изображения после экспорта, существует также настройка поведе-

ния размера изображения. Размер, указанный в списке Size, может быть фиксиро-

ванным — в данном случае следует выбрать значение Fixed; либо же он может 

зависеть от размера экрана устройства или окна при просмотре на экране компью-

тера — для этого выберите значение Relative to Page Width. Выбрав последний 

вариант, как вы понимаете, при изменении размера окна просмотрщика, размер 

изображения будет изменяться пропорционально. Еще одна настройка, которая 
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присутствует здесь — Custom Layout, задает настройки выравнивания экспорти-

руемого объекта относительно окна или экрана устройства. Чтобы ее использовать, 

необходимо выбрать либо значение Float Left для выравнивания по левому краю, 

либо Float Right — по правому. Кроме того, мы можем выбрать значение 

Alignment And Spacing и настроить все более детально, отдельно регулируя вы-

равнивание и отступы конкретного объекта. Это поможет нам в дальнейшем на-

строить обтекание изображения текстом, но об этом чуть позже. 

Наконец, последняя из опций, представленных в данном окне, — Insert Page 

Break — позволяет вставить в вашу публикацию разрыв страницы до, после или же 

одновременно до и после изображения, для которого настраивается экспорт. Давай-

те для нашей публикации пока что оставим все значения по умолчанию и зададим 

поведение размера как Fixed. 

Когда мы разобрались с контуром, проделайте те же самые манипуляции со всеми 

остальными графическими элементами, представленными здесь. Однако чтобы  

у нас были примеры для сравнения, для некоторых из них задайте модель поведе-

ния размера изображения как Relative to Page Width. 

Теперь, когда все готово, можете экспортировать полученный документ в ePub, как 

обычно, используя настройки по умолчанию. Как вы видите, на этот раз после экс-

порта все графические элементы присутствуют в полной мере. Кроме того, если вы 

попробуете изменить размеры окна Adobe Digital Editions, обратите внимание, что 

те элементы, для которых мы задавали размер, привязанный к размеру окна, будут 

также меняться в размерах, остальные же будут оставаться статичными. Далее на 

все графические элементы, наряду с текстовыми, действует правило вывода верст-

ки слева направо и сверху вниз. Именно поэтому те элементы, которые стояли ря-

дом в изначальном документе или даже накладывались друг на друга, расположи-

лись в разных местах в экспортированном файле. Для решения этой проблемы про-

сто сгруппируйте эти элементы с помощью команды Object > Group или сочетания 

горячих клавиш <Ctrl>+<G>, после чего задайте опцию Custom Rasterization уже 

для всей группы. Если вы экспортируете документ уже в таком виде, то все сгруп-

пированные элементы будут находиться в тех же местах относительно друг друга, 

что и в исходном файле. 

Наконец, самый важный момент при экспорте сложных документов с вложенными 

изображениями. Если вы хотите, чтобы картинки следовали не отдельно от текста, 

а были внедрены в него, достаточно совершить одну простейшую манипуляцию. 

Выделите требуемое изображение и, используя значок в форме квадрата с полной 

заливкой в правой части верхней грани контейнера изображения, "перетащите", 

взявшись за него, изображение в любое место в тексте. После этого, вместо данного 

значка, появится значок в форме якоря (рис. 2.28), который как раз и будет озна-

чать, что изображение закреплено за данным местом в потоке текста. 

Когда вы проделаете подобные манипуляции со всеми изображениями, вы можете 

экспортировать наш проект в ePub и убедиться, что теперь все изображения нахо-

дятся в тех местах потока текста, которые вы для них определили. Обратите внима-

ние на то, что изображения теперь могут находиться абсолютно в любом месте  
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Рис. 2.28. Иконка, демонстрирующая привязку изображения к определенному месту в тексте 

в пределах рабочей области в InDesign; при этом после экспорта они непременно 

окажутся в тех участках текста, которые были вами указаны. 

Другой методикой работы с графическими элементами является использование па-

литры Articles для настройки опций экспорта изображений. Как вы помните, мы 

можем помещать в данную палитру наряду с текстом и растровыми изображениями 

также и векторную графику. При этом во время экспорта данные элементы также 

попадают в конечный файл и автоматически конвертируются в требуемый формат. 

Здесь, кстати, точно так же действует правило группировки графических элементов 

при желании оставить их на прежних местах относительно друг друга, о котором 

мы говорили выше. Еще одно отличие от предыдущего варианта заключается в том, 

что с помощью палитры Articles мы, как вы помните, можем дополнительно кон-

тролировать и порядок следования разделов, изображений вне текстового потока и 

тех самых векторных элементов. 

После того как вы установили требуемый порядок следования всех элементов вер-

стки, вы имеете возможность настроить параметры конвертации элементов. Для 

этого с нажатой клавишей <Alt> нужно щелкнуть по тому или иному элементу  

в палитре Articles. В результате откроется диалоговое окно Object Export Options 

для данного объекта и даст вам возможность выбрать настройки растеризации 

именно для него. 

Таким образом, взаимодействуя с палитрой Articles и диалоговым окном Object 

Export Options, мы можем достаточно быстро и корректно подготовить ранее не-

доступные для нас векторные элементы для экспорта в ePub. 
 

Создание обложки 

У каждой электронной книги, которую вы собираетесь распространять через Ин-

тернет, обязательно должна быть обложка. Это не только правило визуального вос-

приятия документа и гарантия его узнаваемости, но и зачастую требование, кото- 

рое накладывают на издателей интернет-магазинов электронных книг, таких как 

Amazon или iBookStore. Кроме того, в любое устройство, будь то электронная кни-

га или сложный интернет-планшет, обязательно заложена функция отображения 

обложки. В данном разделе мы разберем большинство требований, которые обяза-
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тельны или желательны при работе с обложками к электронным книгам и, конечно 

же, научимся их создавать средствами Adobe InDesign. 

Для начала работы откройте документ Main_Cover.indd из рабочей папки 

\Подготовка ePub и обратите внимание на его обложку. 

Первое и самое главное правило, действующее в среде ePub, — обложка для книги 

всегда должна быть изображением, причем в формате JPEG. Недопустимо ис-

пользование в них даже текстовых элементов. Если таковые присутствуют, то не 

переживайте, далее мы разберемся, как настроить их конвертацию непосредственно 

при экспорте в ePub. 

Первый вариант создания обложки — при экспорте использовать в качестве нее 

первую страницу. Для этого в разделе General диалогового окна экспорта ePub-

документа EPUB Export Options в группе Setup найдите раскрывающийся список 

Cover и выберите в нем значение Rasterize First Page (рис. 2.29). 
 

 

Рис. 2.29. Настройка источника обложки в диалоговом окне EPUB Export Options 

 

Обратите ваше внимание на то, что эта настройка сохраняет первую страницу 

внутри публикации и, вместе с этим, генерирует отдельный PNG-файл, внедряя 

ссылку на него в требуемое спецификацией ePub место. Таким образом, при попа-
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дании данного файла в интернет-магазин или непосредственно на устройство, про-

граммное обеспечение может безошибочно определить местонахождение обложки. 

В этом же раскрывающемся списке (Cover) вы можете задать полное отсутствие 

обложки — выберите для этого значение None; или же другим вариантом является 

загрузить заранее созданное растровое изображение обложки из файла — для этого 

служит значение Choose Image. 

Если мы выберем все-таки значение Rasterize First Page и экспортируем данный 

документ в ePub как есть, может возникнуть ситуация некорректного отображения 

обложки, обрезки изображений на обложке либо отображения только текста. Веро-

ятней всего, это связано с некоторыми ошибками во внутренних алгоритмах работы 

самого InDesign и для решения этих проблем нужно проделать два шага. Во-

первых, сгруппировать все объекты на обложке. Во-вторых, вновь открыть диало-

говое окно Object Export Options и включить опцию Custom Rasterization. Луч-

шим вариантом для обложки будет указать максимальное разрешение и выбрать  

в графе настройки размера значение Relative to Page Width. После выполнения 

этих действий снова экспортируйте документ в ePub, и вы сможете сами убедиться 

в корректном отображении обложки (рис. 2.30). 

 

Рис. 2.30. Вид итоговой обложки в Adobe Digital Editions 

Наконец, немаловажный момент в работе над обложкой сводится к тому, что прак-

тически все интернет-магазины по продаже электронных книг имеют свои жесткие 

правила по подготовке файлов обложек, причем не только технические. Например, 

в магазине Amazon запрещено на обложке указывать какие-либо ссылки и цену на 
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книгу. Всегда помните, что не будет лишним с самого начала продумывать пути 

распространения своих книг, т. к. только это сможет помочь вам в правильной под-

готовке макетов, в том числе и обложек. 

Более подробно об этих особенностях мы поговорим в следующих разделах, где 

будем обсуждать методики и правила распространения электронных книг. 

Создание внутреннего TOC  
на первой странице издания 

Ранее мы уже обсуждали процесс создания навигационного оглавления с помощью 

стилей InDesign. Однако иногда данного оглавления бывает недостаточно. Напри-

мер, информационная панель в левой части окна Adobe Digital Editions может быть 

скрыта и данную систему навигации вообще не будет видно. В таком случае, необ-

ходимо предусмотреть дополнительное внутреннее интерактивное оглавление, ко-

торое будет доступно пользователю на любом устройстве и будет, по сути, частью 

самого содержимого ePub. В данном разделе мы разберемся с тем, каким образом 

создается и внедряется подобное содержание. 

Для начала работы откройте знакомый нам файл Main_Sample_work_epub_TOC.indd 

из папки \Подготовка ePub нашей рабочей документации. Создание внутреннего 

TOC на первой стадии очень напоминает подобную работу для навигационного ог-

лавления. Мы точно так же должны создать стиль TOC, выполнив команду меню 

Layout > Table of Contetnets Styles, однако после этого нам следует выбрать пункт 

меню Layout > Table of Contents и выбрать в верхней части открывшегося окна 

Table of Contents в раскрывающемся списке TOC Style наш созданный стиль ог-

лавления (рис. 2.31). 

Обратите внимание, что здесь, ниже, аналогично присутствуют настройки для 

управления стилем отображения оглавления. Однако, в случае экспорта в ePub, они 

имеют мало смысла, т. к. строки оглавления все равно будут отображаться как 

ссылки. Именно поэтому, а также потому, что в мире ePub мы имеем дело с пла-

вающей версткой, в группе Style: Subhead в раскрывающемся списке Page Number 

стоит выбрать значение No Page Number. Теперь вы можете нажать кнопку OK и, 

используя курсор мыши, вставить оглавление на одну из первых пустых страниц  

в нашей публикации. Затем давайте попробуем экспортировать данный файл, ис-

пользуя, как обычно, опции по умолчанию. После открытия документа вы увидите, 

что под заголовочной частью теперь располагаются ссылки на соответствующие 

разделы нашего издания и пользователь может, уже не обращаясь к навигационно-

му меню, перейти к нужной ему части (рис. 2.32). 

Предположим, что вместе с традиционным оглавлением вы хотите внедрить в свой 

документ другой тип рубрикатора, например список иллюстраций или что-то в 

этом роде. Для этого нам потребуется создать дополнительный стиль оглавления, 

как мы уже умеем, скажем, для подписей к изображениям или для самих изображе-

ний. Этим мы хотим добиться того, что по нажатию ссылки пользователю будет 

демонстрироваться соответствующее изображение. После создания стиля давайте  
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Рис. 2.31. Вид диалогового окна Table of Contents 

 

Рис. 2.32. Вид итогового окна в Adobe Digital Editions 
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повторим те же шаги, что и раньше, и внедрим второе оглавление поблизости с 

предыдущим. 

После экспорта вы можете видеть, что первое оглавление TOC до сих пор работает 

так же, как и ранее, а тот список иллюстраций, который мы пытались внедрить, вы-

глядит простым текстом и не реагирует на нажатия. В зависимости от версии 

InDesign, которую вы используете, могут возникать и другие ошибки в отображе-

нии. Это происходит из-за того, что, к сожалению, на сегодняшний день InDesign 

поддерживает создание только одного внедренного оглавления на публикацию.  

В случае если вам, как в предыдущем примере, требуется все-таки создание не-

скольких TOC, могу вас порадовать — у нас остается такая возможность при обра-

ботке каждой из ссылок в данном оглавлении вручную. Как вы уже знаете, пере-

крестные ссылки прекрасно поддерживаются в формате ePub. Поэтому, чтобы до-

биться нужного нам результата, нам необходимо вернуться в документ InDesign, 

открыть палитру Hyperlinks и обратиться к ее разделу Cross-References. Однако, 

если мы попробуем выделить ту или иную строку в списке изображений, функции 

создания перекрестных ссылок будут заблокированы. Это происходит из-за того, 

что у нас уже созданы ссылки из данных строк. Исправить это можно вручную, пе-

ренабрав текст или же экспортировать текст из фрейма с помощью команды 

File > Export в формат Rich Text Format и поместив затем с помощью команды 

File > Place этот файл в заново созданный фрейм. По сути, данные фреймы могут 

выглядеть абсолютно одинаково, но только в последнем мы будут иметь дело уже  

с простым текстом, поэтому к нему будут применимы команды по созданию пере-

крестных ссылок. Теперь вы можете поочередно выделить каждую строку в списке 

изображений и, нажав кнопку Create new cross-reference, определить, на какое 

изображение она будет ссылаться. После экспорта данного файла вы увидите, что  

с помощью этой функции мы можем внедрять неограниченное количество различ-

ных интерактивных оглавлений, созданных на основе любого внутреннего стиля 

InDesign. 
 

Добавление метаданных  
перед экспортом в ePub 

Метаданные — это скрытая от глаз обычного пользователя информация о публи-

кации, используемая автоматизированными системами индексации и поиска для 

корректной идентификации итогового файла и расположении его в нужных рубри-

ках в случае использования многораздельных систем распространения. 

К таким данным могут относиться название публикации, дата создания и измене-

ния, краткое описание, тема, автор, издательство и многие другие. Для мира ePub 

правильное использование метаданных в публикации имеет огромное значение. 

Для примера, представьте ситуацию, когда вы ищете в интернет-магазине книгу по 

запросу "Интересный детектив". Единственная информация, которой поисковая 

машина может оперировать, это метаданные, и, если в описании вашей книги не 

будет представлено хоть одно из этих ключевых слов, ваша книга не будет найдена 



140 Глава 2 

и, соответственно, не будет продана. Кроме того, без внедрения некоторых мета-

данных ваш файл даже не сможет пройти валидацию. В InDesign есть инструменты 

для внедрения в итоговый ePub-файл метаданных, в этом разделе мы подробно об-

судим, как это делается. 

Для начала работы давайте откроем любой файл из папки \Подготовка ePub нашей 

рабочей документации и сразу же откроем диалоговое окно экспорта ePub-

документа. В разделе Advanced данного окна найдите группу параметров EPUB 

Metadata, в которой, в первую очередь, нужно обратить внимание на поле Unique 

ID, которое, будучи нетронутым, содержит в себе уникальный номер, автоматиче-

ски сгенерированный InDesign (рис. 2.33). 

 

Рис. 2.33. Вид диалогового окна EPUB Export Options при работе с метаданными 

 

Чаще же всего данная графа служит для внесения в нее номера ISBN. Как многие 

из вас знают, ISBN расшифровывается как International Standard Book Number, или 

международный стандартный книжный номер, и является уникальным номером 

книжного издания, необходимым для распространения книги в торговых сетях и 

автоматизации работы с изданием. 

Следующее поле в данной группе называется Publisher и в нем указывается изда-

тель данной публикации. Если, заполнив две этих графы, мы экспортируем доку-
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мент, то в навигационной панели Adobe Digital Editions вы увидите, что в качестве 

названия публикации взято просто имя файла, ниже будет указано, что автор пуб-

ликации неизвестен. 

Чтобы внести эти метаданные, нам нужно обратиться к другой функции InDesign — 

File Information. Для этого выберите в главном меню пункт File > File Info. Данное 

открывшееся окно предоставляет вам уже куда большую свободу для внедрения 

дополнительных данных (рис. 2.34). Здесь есть поля, определяющие название,  

автора, описание публикации, набор ключевых слов для поиска и многое другое. 

 

Рис. 2.34. Вид диалогового окна File Information for ... 

Давайте внесем сюда необходимую информацию и дополним ее небольшим описа-

нием и несколькими ключевыми словами. Абсолютным минимумом вносимых ме-

таданных является название произведения и имя автора. 

После заполнения полей в данном окне давайте вновь экспортируем наш документ 

и посмотрим, какие изменения произошли в его описательной части (рис. 2.35). Как 

вы видите, сейчас в навигационной панели уже присутствует название книги и имя 

автора. Для поисковой же машины наш файл теперь предельно понятен. 
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Рис. 2.35. Итоговая информация о книге в Adobe Digital Editions 

Еще одно поле, которое всегда должно быть заполнено для удачного прохождения 

валидации, — это дата публикации. И это поле невозможно заполнить где-либо в 

InDesign. Оно создается автоматически и берет информацию из той даты, в кото-

рую был произведен экспорт в ePub. Изменить эти данные возможно, но только 

вручную при корректировке внутренних файлов, содержащихся в архиве ePub. Об 

этом мы обязательно поговорим в следующих разделах этой главы. 

Добавление альтернативного текста 
к изображениям 

Один из немаловажных аспектов при работе над подготовкой ePub-документов,  

о котором нередко забывают, — это решение вопроса внедрения альтернативного 

текста для изображений. Альтернативный текст — это описание графики или фо-

тографий, добавляемое в файл публикации на случай, если данные элементы не бу-

дут корректно отображены. Как и метаданные, эта информация в обычном режиме 

не видна пользователю, но решает три основные задачи. Во-первых, как ясно из ее 

описания, в случае если по тем или иным причинам изображение не сможет быть 

отображено, на его месте появится надпись с описанием того, что было изображено 

на данной картинке. Во-вторых, наличие альтернативного текста для графики по-

зволяет поисковым системам индексировать, т. е. включать в поисковую выкладку 

не только текстовые блоки, но и найденные изображения. И, наконец, самая важная 

задача, которую решает альтернативный текст, — это донесение более полной ин-
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формации до людей с ограниченными возможностями. В отличие от бумажных 

книг, которые находятся вне пределов доступности для людей с отсутствием зре-

ния, электронные книги с помощью современных технологий синтеза голоса могут 

быть "прочитаны" этой группой людей. Наличие же альтернативного текста в изо-

бражениях делает их также доступными для восприятия. В случае если программа 

чтения встречает такой элемент, она озвучивает его примерно так: "Изображение: 

<название изображения>". 

Откроем для примера файл Main_Images.indd из папки \Подготовка ePub нашей ра-

бочей документации. Для того чтобы оснастить любое изображение альтернатив-

ным текстом, вам необходимо выделить его и выбрать пункт меню Object > Object 

Export Options. В данном открывшемся диалоговом окне Object Export Options 

перейдите на вкладку Alt Text и откройте раскрывающийся список Alt Text Source 

(рис. 2.36). 
 

 

Рис. 2.36. Вид диалогового окна Object Export Options с открытой вкладкой Alt Text  
при работе с альтернативным текстом 

 

Как вы видите, здесь можно выбрать, что станет источником для альтернативного 

текста к изображению. Это может быть как одно из полей метаданных, такое как 

название публикации, описание или заголовок, или информация из тега XML,  

определяющего данный элемент, а при выборе значения Custom — заданное вруч-

ную описание. Давайте остановимся на последнем варианте и внедрим для всех 

наших картинок альтернативный текст, поясняющий, что на них изображено. 

После того как работа над созданием альтернативного текста к нашим изображени-

ям закончена, экспортируем документ в ePub. Чтобы убедиться, что информация на 

самом деле внедрена в публикацию, вы можете открыть ее в одном из HTML-

редакторов и, найдя в тексте строку, отвечающую за внедрение изображения, про-

верить, чтобы рядом с ним обязательно шла строка следующего содержания: 

alt="<Созданный вами альтернативный текст>". 
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Если вы хотите проверить, как будут звучать данные альтернативные подписи, вам 
совсем не обязательно приобретать специализированное устройство, просто вклю-
чите функцию Voice Over вашего iPad в программе iBooks, скачайте из Интернета 
специальную программу для чтения голосом или используйте встроенный в вашу 
систему синтезатор. 

Еще один важный момент заключается в том, что если изображения в вашей пуб-
ликации внедрены с помощью ссылок, то вы можете задать для них альтернатив-
ный текст не только в InDesign, но и в любой другой программе по работе с растро-
выми изображениями, такой как Adobe Photoshop. Главное, не забудьте обновить 
ссылки после сохранения изменений в них; на вкладке Alt Text диалогового окна 
Object Export Options в данном случае в раскрывающемся списке Alt Text Source 
следует выбрать значение From XMP:Description. Это бывает удобно, если вы ис-
пользуете одно и то же изображение в нескольких публикациях. 

Как резюме, можно отметить, что внедрение такого рода дополнительной инфор-
мации сможет не только существенно расширить объем перспективных читателей, 
но и будет служить проявлением толерантности и заботы о людях с ограниченными 
способностями. 
 

Обзор дополнительных параметров 
и возможностей экспорта ePub 

До настоящего времени мы достаточно часто обращались к диалоговому окну экс-

порта ePub-документа в пакете InDesign. Однако, за редким исключением, мы ос-
тавляли в нем все установки по умолчанию. В этом разделе мы разберемся с тем, за 

что отвечают настройки в данном диалоговом окне, и научимся подбирать опти-
мальные при экспорте нашего документа в ePub. 

В последней версии Adobe InDesign, а именно CS6, диалоговое окно экспорта ePub-
документа претерпело достаточно существенные изменения. Если раньше, вплоть 

до версии CS5.5, эти настройки были сгруппированы в три больших раздела — 

General, Images и Content, отвечавшие соответственно за основные параметры 
экспорта, настройки экспорта изображений и контента, то в новой версии они не-

сколько изменили свое положение. Кроме того, появился ряд очень полезных но-
вых функций. 

Начнем по порядку — с раздела General, который, как вы уже знаете, отвечает за 

основные настройки экспортируемой публикации (рис. 2.37). 

Первый раскрывающийся список Version, с которым мы сталкиваемся при откры-

тии этого раздела, позволяет нам выбрать версию, в которой будет сохраняться наш 
документ, и здесь у нас есть 3 варианта. Первый — EPUB 2.0.1 — сегодняшний 

стандарт в отрасли, существующий с 2007 года. Данный формат позволяет добить-
ся максимальной совместимости вашего издания со всеми существующими устрой-

ствами и программами для чтения. Следующий — EPUB 3 — является, по сути, 

развитием предыдущего и был внедрен в 2011 году. Он уже поддерживает такие 
функции, как внедрение аудио- и видеофайлов. То же касается и версии этого фор-



Подготовка макетов электронных книг в формате ePub 145 

мата с поддержкой верстки. К сожалению, на сегодняшний день с ним умеют рабо-

тать только узкоспециализированные программы собственной разработки Adobe. 
Об этих двух форматах мы отдельно поговорим немного позже. Пока же давайте 

рассмотрим остальные параметры, присутствующие здесь. 

 

Рис. 2.37. Вид раздела General окна EPUB Export Options 

 

В группе Setup, помимо знакомых нам раскрывающихся списков Cover, ТОС Style 

и Content Order, присутствует также возможность установки принудительных от-

ступов от края экрана или полей. В ранних версиях данная настройка была пред-

ставлена лишь одним значением для всех сторон экрана. Начиная с версии CS6, мы 

получили возможность настраивать данные отступы для каждой стороны, как если 

бы имели дело с настоящей книгой, предназначенной для печати. 

Ниже, в группе Text Options, мы имеем, во-первых, флажок Place Footnote After 

Paragraph, позволяющий перенести все сноски, касающиеся данного параграфа из 

конца публикации в промежуток между данным и следующим за ним параграфом. 

Запомните, что в ePub сноски помещаются не внизу страницы, как мы к этому при-

выкли, а являются просто ссылками на комментарии. Но если мы оставляем дан-

ную опцию выключенной, то все сноски, вне зависимости от главы, к которой они 

относятся, будут помещены в конец книги. 
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Следующий флажок Remove Forced Line Breaks позволяет убрать принудитель-

ные разрывы строк. Этот флажок может быть полезен, если вы работаете с текстом, 

который был подготовлен для печати. В данном случае, в тексте могут встречаться 

подобные переносы. Как вы понимаете, в ePub мы имеем дело с плавающей верст-

кой, поэтому они не имеют никакого смысла и, в большинстве случаев, данная оп-

ция оказывается крайне полезна. 

Если в вашей публикации присутствуют нумерованные или простые списки, то 

раскрывающиеся списки Bullets и Numbers позволяют конвертировать их в сопос-

тавимые списки, но уже с помощью стандарта HTML. Вместе с этим, вы можете 

выбрать для каждого из них значение Convert to Text, которое преобразует при 

экспорте ваши списки в обыкновенный текст. 

Флажок View EPUB after Exporting уже хорошо нам знаком и позволяет открыть 

полученный документ сразу же по завершении процедуры экспорта. 

Теперь давайте поговорим про раздел Image (рис. 2.38). Как вы уже догадываетесь, 

он служит для настройки изображений, внедряемых в вашу публикацию при экс-

порте. О некоторых из них мы говорили с вами в предыдущих разделах, однако 

здесь есть еще несколько немаловажных дополнений. 
 

 

Рис. 2.38. Вид раздела Image диалогового окна EPUB Export Options 
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Самая первая опция — флажок Preserve Appearance from Layout — отвечает за 

сохранение внешнего вида изображений при экспорте. Это означает, что, к приме-
ру, если вы добавили к вашему изображению тень, изменили его размеры, угол по-

ворота и т. д., все эти изменения будут обязательно экспортированы в ePub, чтобы 
максимально сохранить внешнее представление данного визуального объекта та-

ким же, как в InDesign. Если сбросить этот флажок, то изображение будет выгля-
деть ровно так, как если бы оно было только что помещено в InDesign и не подвер-

галось никакой дополнительной обработке. 

Следующие раскрывающиеся списки — Resolution и Image Size — отвечают за 
разрешение и соответственно за размер изображения в итоговом файле. Мы с вами 

уже сталкивались с данными настройками, поэтому не будем задерживаться на них. 
Единственное, на что хочется дополнительно обратить ваше внимание — это на 

необходимость всегда сверять то разрешение, которое вы планируете установить 
здесь и физическое разрешение конечного устройства, на котором ваша публикация 

будет просматриваться. Они, безусловно, должны совпадать, т. к. это является за-
логом прекрасного качества материалов внутри вашей публикации. 

Следующая группа настроек называется Image Alignment and Spacing и отвечает 

за выравнивание изображений относительно листа или экрана устройства. Эта 
группа позволяет позиционировать текст и другие объекты по левому и правому 

краям, а также по центру. Здесь еще присутствует возможность задать минималь-
ные отступы от верхнего и нижнего краев изображения до текстового блока. Эта 

величина может быть задана в двух различных единицах измерения: первая — 
pixels — стационарная, вторая — Ems — относительная. Это означает, что когда 

мы задаем отступы в пикселах, они будут рассчитываться от физических размеров 
пиксела данного конкретного устройства. В случае же использования относитель-

ных единиц, при изменении размера шрифта, отступ будет также меняться и это, 
объективно говоря, лучший вариант для использования при подготовке материалов 

для просмотра с помощью специализированных устройств чтения, таких как элек-

тронные книги. 

В эту же группу включен флажок и соответствующий ему раскрывающийся список 

Insert Page Break, позволяющий внедрить разрыв страницы до, после и, одновре-
менно, до и после всех изображений в публикации. Это может быть крайне удобно, 

если, скажем, каждая глава вашей книги начинается с изображения. Тогда это даст 

вам дополнительный критерий для разделения данных глав, а разбивку по значе-
нию Paragraph Styles можно будет использовать для разделов внутри главы. Это 

лишь одна из возможностей применения данной функции. 

Следующая опция — флажок Settings Apply to Anchored Objects — отвечает за 

применение всех описанных выше настроек не только на отдельно стоящие изо-

бражения, но и на те, что внедрены с помощью якоря внутрь текстового потока. 
Желательно, чтобы данная настройка была всегда включена при экспорте. 

Остальные параметры в этом разделе отвечают за конвертацию изображений во 
время экспорта. Если выбрать в раскрывающемся списке Image Convertion значе-
ние Automatic, все изображения сохранятся в конечном файле в том формате, в ко-
тором они были изначально помещены в InDesign. Здесь мы также можем принуди-
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тельно задать для изображений форматы JPEG, GIF и PNG. Обратите внимание на 
то, что если вы выберете в качестве целевого формата PNG, то все дальнейшие на-
стройки в данном окне будут заблокированы. Это происходит из-за того, что дан-
ный формат сохраняет изображения без потерь и, поэтому не позволяет настраи-
вать сжатие. Для двух остальных форматов для вас будут доступны уже знакомые 
опции качества и метода компрессии, а также типа GIF-палитры. 

Последняя опция, доступная в данном окне, — флажок Ignore Object Export 
Settings — служит для того, чтобы заблокировать настройки, сделанные предвари-
тельно в диалоговом окне EPUB Export Options. Достаточно трудно предполо-
жить, для чего может служить данная установка, но вы должны понимать, что при 
ее включении все параметры, которые вы задавали для каждого изображения, будут 
проигнорированы при экспорте, а в качестве рабочих параметров будут использо-
ваны значения из текущего окна. 

Последний раздел в этом рассматриваемом диалоговом окне — Advanced — отве-
чает за все дополнительные настройки при экспорте ePub (рис. 2.39). Здесь присут-
ствуют уже хорошо знакомые нам группа параметров EPUB Metadata, отвечающая 
за настройки внедрения метаданных в готовую публикацию, и раскрывающийся 
список Split Document, предназначенный для управления разбиением документа по 
различным параметрам. 

 

Рис. 2.39. Вид раздела Advanced окна EPUB Export Options 
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Кроме того, здесь имеются настройки CSS, многие из которых нам знакомы. Оп-
ция, про которую мы еще не успели поговорить — флажок Include Embeddable 

Fonts — позволяет при наличии в исходном документе нескольких шрифтов вне-
дрить их в итоговый ePub-файл для просмотра на устройствах, поддерживающих 
шрифтовую композицию текста в публикациях. Рекомендуется всегда устанавли-
вать данный флажок, т. к. внедряемый шрифт совершенно не увеличивает объем 
итогового файла, но, вместе с тем, существенно расширяет его возможности. 

Область Additional CSS является новинкой Adobe InDesign CS6 и позволяет под-
ключить к вашей публикации неограниченное количество дополнительных стилей 
для описания внешнего представления элементов. Это объясняется достаточно про-
сто. Как вы знаете, все внешнее представление элементов в готовой ePub-
публикации описывается с помощью каскадных таблиц стилей, создающихся авто-
матически в InDesign. Но, в принципе, вы спокойно можете дописать нужные вам 
классы в CSS и просто назначить параграфам соответствующие названия стилей. 
На самом деле, вам даже не обязательно включать стилевые описания из InDesign, 
можно просто сбросить флажок Include Style Definitions и пользоваться только 
лишь внешними стилями. В таком случае, правда, вам придется вручную задать 
классовую принадлежность всех требуемых элементов. К примеру, если вы рабо-
таете над ежемесячным журналом, совсем не обязательно каждый раз создавать и 
настраивать новые стили для однотипных элементов, повторяющихся из номера  
в номер. Нужно просто один раз создать CSS-файл, описывающий все их, и запом-
нить их имена. После этого достаточно загрузить его в эту область, предварительно 
разметив документ InDesign стилями с соответствующими названиями. 

Теперь, когда мы разобрались со всеми настройками для стандарта EPUB 2.0.1, да-
вайте посмотрим, какие дополнительные перспективы дает нам использование 
EPUB 3.0. Как вы уже знаете, помимо стандартных настроек для EPUB 2.0.1, начи-
ная с версии Adobe InDesign CS6, в диалоговом окне экспорта ePub документа по- 
явилась возможность выбрать совершенно новый стандарт — EPUB 3.0. Он пока 
что не стал абсолютным стандартом отрасли и до сих пор не поддерживается 
большинством устройств, однако этот вопрос наверняка решится в течение сле-
дующего года. Теперь разберемся, в чем же его принципиальное отличие от пред-
шественника. Главными нововведениями в версии 3.0 стали возможности по вне-
дрению таких элементов, как видео- и аудиофайлы, поддержка вертикальных 
шрифтов для азиатских стран, использующих иероглифы и некоторые другие не-
значительные инновации. Однако самым важным из новшеств, объективно, стало 
внедрение в стандарт ePub поддержки JavaScript — специализированного языка 
для программного доступа к объектам приложений. Наиболее широкое применение 
данный язык на сегодняшний день находит в браузерах как язык сценариев для 
придания интерактивности web-страницам. Теперь же он доступен и для внедрения 
в наши публикации. Для того чтобы сделать это, необходимо в области JavaScript 

Options выбрать уже готовый протестированный скрипт, который появится внутри 
вашей публикации. 

Все эти инновации, на самом деле, не революционны, однако сделали очень важное 

дело. До момента появления и внедрения EPUB 3.0, возможность размещать инте-

рактивные книги и публикации существовала только в Apple iBookStore и основы-
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валась на закрытом стандарте Apple Web Kit, что существенно замедляло развитие 

данного рынка. Теперь, так как стандарт открыт, любой производитель сможет 

внедрять в свои устройства или программные среды возможности поддержки всех 

интерактивных функций и практически любых мультимедийных файлов. 

Предварительный просмотр публикаций 
в программе iBooks на iPad 

После того, как вы закончите настраивать ваш документ и экспортируете его в 

ePub, в нашем рабочем процессе наступает следующий этап — предварительное 

тестирование. Adobe Digital Editions предоставляет нам для этого большинство ин-

струментов, однако данная операция никогда не сможет сравниться с использова-

нием целевого конечного устройства. В этом разделе мы разберемся, каким обра-

зом необходимо производить тестирование, на примере Apple iPad, и на какие 

принципиальные моменты обязательно следует обратить особое внимание во время 

этого процесса. 

Для начала вам следует проверить, что в вашей системе установлено приложение 

Apple iTunes не меньше версии 9.1. Данное программное обеспечение является 

единственным путем, через который, помимо iBookStore, книга может попасть на 

ваше устройство. Следующим шагом необходимо подключить устройство к ком-

пьютеру. Это можно сделать как с помощью кабельного соединения, так и по бес-

проводному каналу через Wi-Fi. Если все подключено верно, то в разделе Devices в 

левой части окна программы вы увидите ваше устройство. 

Далее, откройте пункт Books из раздела Library той же панели. Здесь хранится вся 

библиотека ваших книг и именно из данного раздела при синхронизации мобиль-

ные устройства, такие как iPhone или iPad, загружают публикации в приложение 

iBooks. Для добавления вашего файла в библиотеку выберите из главного меню 

iTunes пункт File > Add to Library, найдите нужный документ и нажмите кнопку 

Choose (рис. 2.40). Это также можно сделать, "перетащив" ваш файл непосредст-

венно в окно программы. 

Теперь, вновь вернитесь к вашему устройству и, нажав на его значок в левой пане-

ли, выберите в верхней части основного окна программы раздел Books. После этого 

установите флажок Синхронизировать книги (Sync Books) и выберите переклю-

чатель Все книги (All books), если вы хотите поместить на устройство все книги, 

имеющиеся в вашей библиотеке, или Выбранные книги (Selected books), если 

нужно синхронизировать только избранные. В последнем случае не забудьте отме-

тить ниже нашу публикацию. Когда все готово, то можно нажать кнопку Sync  

в правом нижнем углу окна. Через какое-то время, когда синхронизация будет за-

вершена, запустите программу iBooks на вашем iPad — вы увидите, что на нем 

появилась наша публикация. Смело открывайте ее (рис. 2.41). 

Как вы видите, с помощью привычных движений можно перелистывать страницы. 

В правом верхнем углу имеются также кнопки для регулирования размера шрифта 

и управления масштабом просмотра. А теперь давайте отвлечемся от чтения и  
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Рис. 2.40. Перенос итоговой книги на iPad с помощью приложения iTunes 

 

Рис. 2.41. Тестирование полученной книги на iPad 
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посмотрим на то, как выглядят текст и прочие элементы верстки на экране целевого 

устройства. Вы наверняка заметили некоторые отличия. В следующих разделах мы 

будем говорить о том, каким образом можно корректировать их уже после экспор-

та. Сейчас же основная задача — экспериментируя с различными размерами шриф-

та, просто попытаться выявить данные расхождения. 

Позже, когда мы будем вносить правки в нашу книгу и вынуждены будем вновь 

тестировать их, у нас есть два пути. Первый — удалить книгу из iTunes, после чего 

загрузить туда новую версию или же просто каждый раз менять название загру-
жаемой книги, например, прибавляя в конец _1, _2 и т. д. 

Валидация ePub-файла 

Как уже говорилось ранее, до того момента, когда ваша публикация поступит непо-
средственно в канал распространения, обязательно должны быть выполнены неко-

торые операции, одной из которых является валидация файла или его проверка на 
соответствие стандарту ePub и на наличие ошибок, недопустимых для публикации. 

В этом разделе мы научимся осуществлять данную процедуру, а также обратим 
особое внимание на некоторые часто встречающиеся ошибки, приводящие к отказу 

от валидации. Если вас интересует, какие правила используются при валидации, вы 
можете зайти на сайт http://idpf.org/epub/20/spec/OPS_2.0.1_draft.htm и более 

подробно ознакомиться со стандартом, регулирующим данное тестирование. 

Для начала работы нам понадобится файл Main_Validation_not_pass.epub из папки 
\Подготовка ePub нашей рабочей документации. На сегодняшний день существует 

несколько способов осуществления валидации ePub-документов. Прежде всего, это 
может делаться с помощью специальных программ, установленных в вашей систе-

ме, например ePubCheck, которую можно скачать с сайта http://code.google.com/ 

p/epubcheck/, но существует гораздо более удобный способ. Этим способом явля-

ется проверка на соответствие стандарту с помощью онлайн-приложения, доступ-
ного по адресу http://validator.idpf.org. В левой части данной страницы вы найдете 

область с названием EPUB validator, в которой расположен раскрывающийся спи-
сок, где необходимо с помощью кнопки Browse или Выберите файл выбрать файл, 

который нужно проверить. Данный файл мы получили после экспорта со стандарт-

ными настройками открытого в InDesign файла в формат ePub. После того как вы 
укажете нужный файл, нажмите кнопку validate. 

Как вы видите, в ответе с сервера, который мы получили (рис. 2.42), значится сле-

дующее: "The following problems were found in <Название файла>", и это означает, 

что наш файл валидацию не прошел. Давайте разбираться, почему же так произош-

ло. В этом нам может помочь онлайн-среда, в которой проводилось тестирование. 

Под рапортом о непрохождении валидации она любезно сообщает нам о месте,  

в котором обнаружена ошибка. В нашем случае это строка с обозначением в скоб-

ках рядом с именем внутреннего файла, в которой используется некорректная фор-

мулировка адреса гиперссылки. Как вы помните, ePub-файл представляет собой 

архив из нескольких HTML-документов. Под внутренним файлом здесь как раз и 

понимается один из этих документов. Итак, используя HTML-редактор, найдем 
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данный файл в "архиве" ePub и перейдем к 6-й строке. Здесь мы можем увидеть, 

что предупреждение касается незаданного имени автора в метаданных файла. Ис-

правим это и посмотрим, что означает вторая ошибка. Так как InDesign, по опреде-

лению, создает при экспорте файлы, всегда проходящие валидацию, ошибка может 

заключаться только в тех элементах, которые мы определяли сами. И это именно 

такой случай. На самом деле, при создании этого файла в поле Unique ID раздела 

Advanced диалогового окна EPUB Export Options нами не был задан уникальный  
 

 

 

Рис. 2.42. Результат первичной валидации тестового файла 

 

Рис. 2.43. Итоговый результат валидации тестового файла 
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номер публикации. Это как раз и стало причиной ошибки при валидации. Зададим 

этот номер, сохраним все изменения и вновь подвергнем наш файл проверке по уже 

известной нам схеме. Как вы видите, на этот раз получено сообщение, что наш 

файл в порядке и успешно прошел валидацию (рис. 2.43). 

Как резюме, хочется отметить, что валидация является одной из самых главных 

проверок, которые призваны сделать ваши файлы безошибочными и корректно 

отображаемыми на любых устройствах. Игнорировать данный процесс нельзя, да и 

не получится, т. к. без него вы уже не сможете поместить вашу книгу ни в один из 

магазинов для продажи. Кроме того, не бойтесь проверять свой документ часто. На 

самом деле, совсем не обязательно ждать, пока в него будут внесены все необходи-

мые изменения, и даже будет лучше, если вы будете проводить тесты непосредст-

венно после экспорта в ePub и после каждого значимого изменения в вашем файле. 

Только такой подход избавит вас от большинства наследуемых ошибок, а даже при 

их нахождении позволит максимально быстро локализовать и устранить их. 
 

Обзор внутренней структуры "архива" ePub 

После того, как мы провели валидацию нашего ePub-файла сразу же после экспор-

та, начинается процесс его финальной корректировки и подготовки к распростра-

нению. Он производится уже не в среде InDesign, а с помощью непосредственного 

редактирования внутренних файлов "архива" ePub. В данном разделе мы разберем-

ся с тем, из каких файлов и папок состоит данный архив, и поймем предназначение 

каждого из них. 

Как мы уже знаем, по сути, ePub представляет собой архив обыкновенного web-

сайта. Это видно по типам включенных в него файлов и по их взаимному размеще-

нию. Чтобы более наглядно продемонстрировать это, давайте изменим расширение 

любого имеющегося у нас ePub-файла на zip и откроем данный архив. На самом 

деле, существует целый ряд программ, которые прекрасно разархивируют файлы с 

расширением epub, однако, если у вас возникают с этим проблемы, сделайте то, что 

было предложено ранее. 

После того, как папка с содержимым нашего ePub-файла будет открыта, вы увидите 

в ней все файлы, описывающие содержимое и формы его представления, а также 

все дополнительные материалы, такие как изображения и прочие элементы 

(рис. 2.44). Многие из этих файлов вам, скорее всего, никогда не пригодятся, одна-

ко с некоторыми в любом случае придется поработать. Это связано с двумя момен-

тами. Во-первых, если при валидации возникают ошибки, о месте их нахождения 

сообщается, как мы видели, как раз в форме имени файла и номера строки в нем. 

Во-вторых, если у вас возникает ситуация, в которой вы не знаете, как исправить 

какую-либо ошибку или внедрить какой-нибудь элемент, вы можете узнать это на 

специализированных форумах у профессионалов. Здесь также придется опериро-

вать уже понятиями внутренней структуры вашего документа и все советы, кото-

рые вы можете получить, также будут приводиться, в большинстве случаев, на этом 

же уровне. 
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Рис. 2.44. Внутренняя структура ePub-документа 

Итак, приступая к изучению внутренней структуры ePub, первое, на что мы обра-

тим внимание — это те папки и документы, которые находятся на самом верхнем 

уровне вложенности. В нем мы видим две папки — META-INF и OEBPS, а также 

XML-файл mimetype. Давайте с него и начнем наш обзор. Если открыть его каким-

либо специализированным редактором, вы увидите внутри всего лишь одну строку 

следующего вида application/epub+zip. Этот файл описывает тип структуры доку-

мента, для правильной идентификации специализированными программами чте-

ния. Самое важное, что необходимо знать про него — это то, что при разархивации 

и обратной последующей архивации данный файл нельзя подвергать компрессии. 

Именно поэтому мы говорили ранее о том, что при корректировке файлов после 

экспорта крайне желательно использовать не обычные архиваторы, а специальные 

программы, такие как Notepad++ или Text Wrangler, позволяющие производить из-

менения в ePub-документе непосредственно внутри архива. 

Теперь давайте откроем папку META-INF. В ней вы также увидите всего один XML-

файл, который мы практически никогда не будем изменять, т. к. в этом нет никакой 



156 Глава 2 

необходимости. Он показывает устройству или программе для чтения, на котором 

открывается ваш файл, путь к основному содержимому данного документа. Если 

при экспорте ePub из InDesign вы выберете опцию по внедрению шрифтов, о кото-

рой мы говорили ранее, в этой папке появится еще один файл — указатель пути 

к внедренным шрифтам. 

После того как мы разобрались со структурой служебных файлов, давайте обра-

тимся к основной папке нашей публикации — OEBPS, которая содержит в себе все 

содержимое вашего издания. 

Все HTML-файлы, которые вы здесь видите, — это и есть весь текст вашей книги, 

разбитый на главы или разделы, в зависимости от того, какие параметры вы выбра-

ли при экспорте. Ранее, когда мы уже открывали данные файлы, вы видели, что они 

созданы с помощью языка HTML. 

Папка images содержит в себе все внедренные в публикацию изображения. Не сто-

ит менять ее имя или перемещать изображения в какую-либо другую папку, т. к. 

это приведет к тому, что изображения не будут показаны. Это происходит из-за то-

го, что в HTML-файлах путь к изображениям прописывается именно в виде 

src="images/<наименование изображения>". 

Один из наиболее важных элементов, хранящихся в этой папке, называется 

template.css и является каскадной таблицей стилей, описывающей все внешнее 

представление контента внутри ePub, начиная от выравнивания текста в документе 

и заканчивая фоном у ячеек таблиц. Если вы откроете этот файл, то увидите, что он 

организован из классов, созданных согласно тем стилям, которые описывали внеш-

ний вид элементов в InDesign. 

Кроме вышеописанного содержимого, в данной папке у нас осталось два XML-

файла, первый из которых — content.xml — описывает всю структуру ePub-

документа, являясь, по сути, краеугольным камнем или мозгом всей внутренней 

структуры нашего документа. Основное описание происходит в секции <manifest>. 

Кроме того, данный файл в секции <metadata> содержит все метаданные нашего 

издания, которые мы добавляли перед экспортом в InDesign. Наконец, последняя 

обязательная секция <spine> описывает порядок открытия документов при исполь-

зовании кнопок быстрого перехода к следующему разделу. Всегда будьте осторож-

ны при изменении данного файла, т. к. ошибки в нем делают невозможной работу 

всей ePub-публикации и приводят к проблемам при ее валидации. 

Второй файл — toc.ncx — отвечает за навигационное оглавление, которое, как вы 

помните, мы создали в процессе подготовки макета в InDesign. В данном файле 

также происходит связка названий пунктов меню и ссылок на содержимое разде-

лов, соответствующих данным пунктам. 

В этом разделе мы рассмотрели всю структуру ePub-документа. Возможно, она не-

много сложна для изучения дизайнерами из-за обилия технических материалов, 

однако только ее доскональное понимание позволит вам работать над созданием 

ePub-файлов по-настоящему на профессиональном уровне. 
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Обзор дополнительных аспектов 
и возможностей внутренней структуры  
"архива" ePub 

Как мы уже поняли, основная структура, наполнение и оформление итогового 

ePub-документа создаются в пакете InDesign, однако он в текущей версии пока не 

охватывает всех возможностей, которые поддерживает данный стандарт. Поэтому 

часть из них нам нужно будет реализовать вручную. В этом разделе мы как раз 

научимся использовать возможности языка HTML в совокупности с таблицами 

стилей CSS для осуществления этой задачи. 

Начнем мы с изучения того, каким образом можно управлять отступами в тексте, 

уже не с помощью стилей, а используя только средства CSS. Для этого экспорти-

руйте наш знакомый файл Main_Images.indd в ePub. В полученном документе с по-

мощью любого специализированного редактора, о которых мы говорили ранее, от-

кройте одновременно один из файлов глав HTML и файл template.css. Дополни-

тельно откройте тот же самый HTML-документ в вашем интернет-браузере. Это 

позволит нам во время работы просматривать промежуточные результаты без не-

обходимости открывать ePub-файл целиком. Кроме того, если вы работаете в опе-

рационной системе Mac OS на компьютерах Apple, для этого есть еще одна причи-

на. Все дело в том, что браузер Safari и программа iBooks имеют один и тот же ал-

горитм отображения web-содержимого. Поэтому книга, просмотренная в браузере, 

будет предельно похожа на ту, что вы увидите на конечном устройстве. 

Изучая скрытые возможности ePub, давайте обратимся к такому немаловажному 

элементу книжной верстки, как различные врезки и вставки в текст. Для внедрения 

такого элемента в нашу публикацию нам, в первую очередь, нужно, используя 

InDesign, подготовить все элементы, которые нам понадобятся. Во-первых, создай-

те отдельные фреймы для каждой врезки и внедрите их в нужное место вашей пуб-

ликации с помощью якоря. Далее, присвойте заголовку, если такой имеется, и тек-

сту врезки отдельные стили параграфа, а самому фрейму стиль в палитре Object 

Styles. Также, давайте укажем в созданном стиле для данного фрейма какой-нибудь 

цвет заливки. 

После этого экспортируем наш файл в ePub и, как в прошлый раз, откроем файлы 

template.css и один из HTML-файлов в редакторе, и тот же HTML-файл в браузере. 

Как вы видите, результат после экспорта очень похож на то, что мы ожидали уви-

деть. Однако такая возможность появилась только начиная с версии CS6. Если же 

вы работаете в более младшей версии, придется приложить немного усилий, чтобы 

это получилось. Для начала обратимся к HTML-файлу. Если вы найдете в нем то 

место, где должна быть врезка, вы увидите, что она оформлена в виде блока <div>, 

размеченного классом, который вы задали для врезки. Настройки именно этого 

блока и класса и будут влиять на то, как, в итоге, будет отображаться врезка. Да-

вайте вновь перейдем к нашему CSS-файлу и найдем в нем соответствующий 

класс — скорее всего, он будет находиться в самом конце. Для того, чтобы обеспе-
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чить отображение врезки таким образом, как нам это нужно, в описание класса не-

обходимо добавить следующие строки (листинг 2.6): 

Листинг 2.6. Настройка отображения врезки в коде CSS 

border-width: 1px;        //толщина линии обводки 

border-style: solid;      //сплошная линия обводки 

border-color: gray;       //серый цвет линии обводки 

margin: 2em 3em 2em 2em;  //отступы от текста в зависимости от размера 

padding: 0,5em;           //отступы содержимого от границ врезки 

                          //в зависимости от размера 

background-color: blue;   //цвет заливки врезки 

 

Вы можете, добавляя по одной строке из представленных в листинге 2.6 и сохраняя 
файл, смотреть на те изменения, которые будут происходить с врезкой. Теперь, ко-
гда все изменения сделаны, попробуйте поменять размеры окна браузера, в кото-
ром вы просматриваете публикацию. Как вы видите, размер врезки меняется сораз-
мерно тому, какой размер принимает окно. Это происходит вследствие того, что 

все величины, которые мы использовали в CSS-файле, были относительными (em), 
т. е. меняющимися в зависимости от различных параметров. 

Теперь, когда мы разобрались с тем, как устроены врезки, давайте настроим текст в 
основном потоке таким образом, чтобы данная врезка обтекалась им. Если прошлая 
функция появилась, начиная с версии CS6, то возможность обтекания текстом объ-
ектов до сих пор не реализована при экспорте из InDesign. Но, как вы уже понимае-
те, никто не мешает нам сделать это вручную. Для этого давайте изменим значения 
настроек для нашей врезки на следующие (листинг 2.7): 

Листинг 2.7. Настройка обтекания врезки в коде CSS 

border-width: 1px; 

border-style: solid; 

border-color: gray; 

margin: 0 0.75em 0 0; 

padding: 0,5em; 

background-color: blue; 

width: 30%;     //ширина врезки в зависимости от ширины окна 

                //или экрана устройства 

float: left;    //выравнивание блока по левому краю и, как следствие, 

                //обтекание его текстом справа 

 

Когда настройки изменены, сохраните данный файл и посмотрите на результат. 
Текст прекрасно обтекает врезку. Таким образом, если вы хотите, чтобы текст об-
текал какой-либо объект, этот объект должен находиться внутри блока, ограничен-

ного тегами <div>. Если же вы хотите обеспечить ваши изображения данным свой-

ством, просто добавьте к классу, который их описывает, свойство float с парамет-

рами left или right. 
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Как резюме, хочется отметить, что, несмотря на то, что возможности экспорта до-
кументов ePub из InDesign все еще ограничены некоторыми функциями, возможно-
сти последующей их доработки в CSS почти безграничны. К сожалению, описание 
языка каскадных таблиц стилей не входит в данную книгу, однако у вас всегда есть 
возможность изучить эту область самостоятельно и, со знанием всех ее возможно-
стей, вернуться к созданию электронных публикаций в формате ePub уже на каче-
ственно новом уровне. 

Методики публикации электронных книг 

Последний, но при этом, безусловно, один из самых важных этапов при подготовке 
вашей книги — это ее размещение в один из каналов распространения или на соб-
ственном сайте. В данном разделе мы обратим особое внимание на эту процедуру и 
некоторые особенности, связанные с ней, а также научимся готовить макеты для 
формата, отличного от ePub, но не менее распространенного — формата магазина 
Amazone и устройства Kindle, который называется MOBI. 

Для начала работы необходимо перейти по ссылке http://www.amazon.com/gp/ 

feature.html?docId=1000234621. Здесь находится весь инструментарий, который 
понадобится нам для дальнейшей работы. Первое, на что следует обратить внима-
ние и загрузить — это приложение Kindle Gen 2.5, которое работает в фоновом  
режиме и содержит в себе все служебные функции для конвертации. Нам также 
непременно понадобится Kindle Plugin for Adobe InDesign® v0.971 — плагин  
для InDesign, предназначенный для конвертации в формат MOBI. Наконец, для 
просмотра документов в данном формате нам потребуется программа Kindle 
Previewer 2.51, которую также можно скачать по данной ссылке. 

Когда все программы загружены и установлены на вашей системе, можно присту-
пить к подготовке самого макета к конвертации. В первую очередь, нам следует 
обратить внимание на ряд особенностей, которые содержит в себе стандарт MOBI. 

 Обложка должна быть сохранена в формате JPEG размера 600 800 pixel. 

 Публикация должна содержать как навигационное, так и внутреннее оглавление. 

 В обязательном порядке должны быть заполнены поля Author (Creator) и Title 
в метаданных публикации. 

 У всех параграфов принудительно должен быть задан отступ первой строки 
0,25 дюймов и они должны быть выровнены по ширине. 

 В данном формате не поддерживается обтекание текстом объектов, соответст-
венно, отсутствует возможность врезок и буквиц. 

Все остальные требования и особенности формата MOBI точно такие же, как и  
у формата ePub. То есть, как только вы привели всю вашу публикацию по приве-
денной здесь методике к готовности к экспорту в формат ePub и внесли изменения 
согласно требованиям формата MOBI, можно переходить к конвертации. Для этого 
мы можем использовать установленное приложение Kindle Previewer. Запустите его 
и, выбрав в главном меню File > Open Book, выберите ваш подготовленный и экс-
портированный ePub-файл. При этом файл будет автоматически конвертирован в 
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требуемый нам формат и открыт. После этого вы сможете, выбирая в пункте меню 
Devices соответствующее устройство, просмотреть, как на нем будет выглядеть по-
лучившийся файл. Как и во всей нашей предыдущей работе, настоятельно реко-
мендуется проверить весь макет для каждого из ваших целевых устройств на нали-
чие возможных ошибок. 

После этого, по сути, подготовка для устройств или программных оболочек Kindle 

будет завершена, вы можете размещать вашу публикацию в магазине Amazone — 

самом популярном средстве распространения электронных изданий в мире. 

Теперь, когда мы разобрались с подготовкой макетов для любого требуемого фор-

мата, давайте поговорим про то, каким образом происходит непосредственное раз-

мещение электронных публикаций в магазинах или других площадках. 

Первым и самым простым способом для распространения вашей публикации явля-

ется ее размещение на собственном сайте. Однако данный вариант хорошо работа-

ет только уже для состоявшихся авторов или издательств. 

Более действенным способом для этого в последние несколько лет стало использо-

вание специальных платформ, дающих значительно больший объем привлеченных 

читателей. Самыми известными из них являются Amazon, Apple iBooks и 

Barnes&Noble. Давайте разберемся, что требуется для каждого из них при разме-

щении электронной публикации на соответствующем ресурсе. 

Начнем с Amazon — здесь все достаточно просто. Все, что нужно сделать — это 

пройти регистрацию по ссылке https://kdp.amazon.com/self-publishing/signin/, по-

сле чего зайти с использованием созданных логина и пароля и сразу же перейти к 

процедуре публикации издания. В данной книге мы не будем касаться собственно 

действий, которые нужно при этом совершать — они достаточно индивидуальны 

для каждого случая, просты для понимания и не требуют специальной подготовки, 

поэтому остановимся лишь на нескольких особенностях: 

 платные публикации невозможно разместить без Tax ID — американского но-

мера налогоплательщика — он достаточно прост в получении; 

 наличие номера ISBN не является обязательным условием для публикации; 

 автор получает 70% прибыли от продажи книг стоимостью от 2,99 до 9,99$,  

в случае более дорогих или дешевых книг автор получает только 35% прибыли. 

Теперь давайте поговорим об Apple iBookStore и его особенностях при размещении 

на его платформе электронных публикаций. Для начала работы необходимо перей-

ти по адресу https://itunesconnect.apple.com/WebObjects/iTunesConnect.woa/wa/ 

apply и получить детальную инструкцию по тому, каким образом работать с дан-

ным магазином. После этого для непосредственно публикации вам нужно также 

аутентифицироваться, пройдя регистрацию или используя имеющиеся данные об 

учетной записи. Саму процедуру публикации мы также не будем рассматривать. 

Однако касательно данной точки распространения также существует ряд важных 

особенностей, на которых следует обратить внимание. 

 От любого издателя, который планирует размещать свои книги на данной пло-

щадке, потребуется, как и в прошлом случае, Tax ID, но здесь, в дополнение  
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к нему, обязательным условием является наличие счета в американском банке 

(требование EFT only). 

 Индивидуальный номер ISBN в данном случае является обязательным условием 

публикации. 

 Автор или издатель получает 30% прибыли от продажи изданий при любой цене 

(ограничения по цене — от 0 до 99,99$ за публикацию). 

Наконец, для того чтобы начать работу с еще одним известным магазином элек-

тронных книг — Barnes&Noble Nook Store, — необходимо перейти по ссылке 

http://pubit.barnesandnoble.com/. При взаимодействии с данной площадкой обяза-

тельно учитывать следующие условия: 

 помимо требований Tax ID и EFT, которые предъявлялись предыдущим магази-

ном, здесь при регистрации также нужно указывать данные кредитной карты для 

получения денежных средств; 

 наличие номера ISBN не является обязательным условием для публикации; 

 автор получает 65% прибыли от продажи книг стоимостью от 2,99$ до 9,99$,  

в случае более дорогих или дешевых книг автор получает только 35% прибыли. 

Мы рассмотрели, каким образом происходит непосредственное взаимодействие 

между автором или издателем и каналом распространения, однако, если у вас воз-

никают трудности с этим или, например, нет возможности получить американский 

Tax ID или другой номер, всегда есть иной путь для осуществления распростране-

ния публикации. Для этого существуют специальные службы-посредники между 

издателями и интернет-магазинами. Они называются агрегаторами и, зачастую, 

являются частными компаниями, предоставляющими подобный сервис. Для не-

больших издательств или индивидуальных авторов, по сути, использование подоб-

ных сервисов является идеальным вариантом, т. к. они лишаются необходимости в 

получении и постоянном контроле над огромным количеством бумаг, а также мо-

гут получить индивидуальную консультацию специалистов в данной области. Еще 

одним плюсом использования агрегаторов является значительно более широкая 

статистика продаж вашего издания, которая также является частью данного серви-

са. К сожалению, в России пока не существует подобных организаций, т. к. рынок 

еще достаточно слабо развит. В США и Европе наиболее успешными и известными 

компаниями являются Smashwords (http://www.smashwords.com), Lulu (http:// 

www.lulu.com), Bibliocore (http://www.bibliocore.com) и Bookbaby (http://www. 

bookbaby.com). Что касается условий работы с данными организациями, то для 

этого существует две различные модели. Первая предполагает оплату некоторого 

небольшого процента от продаж, в пределах 10—15%. Вторая — оплату фиксиро-

ванной абонентской платы за период времени, в течение которого вы можете без 

ограничений пользоваться услугами. Выбор той или иной системы работы зависит 

только от желания издателя и от потребностей в объемах, выводимых на рынок 

продуктов. 

Мы поговорили с вами об основных методах распространения изданий в современ-

ном мире электронных публикаций. Данный рынок на сегодняшний день развива-
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ется очень бурно и, возможно, на момент выхода этой книги, на нем появится но-

вый сильный игрок, однако модель работы в ближайшие несколько лет, скорее все-

го, не изменится. 

На этом мы заканчиваем наш разговор про подготовку макетов публикаций для 

формата ePub и переходим к изучению наиболее прогрессивной и современной 

платформы для создания и работы с электронными публикациями — Adobe Digital 

Publishing Suite, которая объединяет в себе все плюсы электронных книг и интерак-

тивных возможностей, которые мы рассмотрели в двух предыдущих главах. 

 

 



  

 

 

ГЛАВ А 3 
 
 
 
 

Основы процесса работы  
с Adobe Digital Publishing Suite 

 

Adobe Digital Publishing Suite — это совершенно новый вид программного продукта 

или, можно сказать, онлайн или облачного сервиса, который позволяет создавать 

электронные публикации, журналы, книги, интерактивные презентации и многое 

другое и размещать полученные издания в популярнейших онлайн-магазинах при-

ложений, таких как Apple App Store, Android Market и Blackberry App World, без не-

обходимости программирования. Инструменты и средства, входящие в пакет DPS, 

позволяют организовать процесс работы, серьезно отличающийся от традиционно-

го печатного. Давайте рассмотрим его подробней. 

Первым шагом в работе будет создание содержимого или контента в среде 

InDesign. Под содержимым подразумеваются текст, изображения, векторная графи-

ка, видеоматериал, аудиофайлы, кнопки, ссылки и прочие интерактивные элемен-

ты, такие как панорамы, слайд-шоу и т. д. Для детальной настройки мультимедий-

ных и интерактивных элементов используется контекстно-ориентированная палит-

ра Folio Overlays. Для комбинирования разнообразных объектов в один элемент 

публикации, который называется folio, используется палитра Folio Builder. Folio 

содержит в себе разнообразные разделы вашей публикации. Это могут быть как 

статьи или обложки, так и рекламные модули и среды для изучения онлайн-

ресурсов. Это похоже на то, как если бы мы работали с отдельными рубриками, 

собирая их потом в один журнал. В отличие от традиционной работы над печатным 

изданием, где, чаще всего, все оно целиком создается и верстается в одном 

InDesign-файле, в DPS мы будем создавать наши разделы в разных файлах и лишь 

на завершающем этапе соберем их вместе в один folio. 

Кроме того, для каждого из разделов необходимо будет подготовить два вида маке-

тов для различных ориентаций — портретный или пейзажный, в зависимости от 

того, каким образом пользователь держит свое устройство, вертикально или гори-

зонтально. Это не является обязательным требованием, но, конечно, настоятельно 

рекомендуется все-таки делать подобные макеты, т. к. это серьезно повышает уро-

вень вашего издания в глазах конечного пользователя и создает дополнительное 

удобство при его изучении. 
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После того, как вы заканчиваете работу с публикацией, необходимо создать обо-

лочку для ее просмотра на каждом из профильных устройств, что делается с по- 

мощью сервиса Adobe Viewer Builder. На сегодняшний день поддерживается три  

основных платформы, для которых можно создать подобную среду — Apple iOs для 

iPad, Google Android Tablet и Blackberry Playbook OS. 

Завершающим этапом данного рабочего процесса является распространение гото-

вых публикаций через каналы продаж. К ним можно отнести и саму компанию 

Adobe и также ряд онлайн-магазинов приложений, таких как Apple App Store, 

Android Market и Blackberry App World. Кроме того, сама среда DPS предоставляет 

интересные средства аналитики для отслеживания не только статистики продаж 

ваших изданий, но и того, каким образом ваши конечные пользователи работают  

с вашей публикацией, какие разделы более интересны публике и каким контентом 

она более охотно пользуется. 

Таким образом, программная среда Digital Publishing Suite (DPS) создает возмож-

ности для полного цикла работы над электронным изданием, от его создания через 

внедрение мультимедийных и интерактивных элементов до доставки на устройство 

к конечному пользователю. Несмотря на некоторые технические ограничения, это 

делает DPS революционным продуктом на издательском рынке и открывает перед 

дизайнерами, верстальщиками и публицистами совершенно новый уровень созда-

ния и распространения своей продукции. 

Давайте сравним работу в среде DPS с традиционными печатными изданиями. Во-

первых, печатные публикации статичны и полностью самодостаточны, т. е. изо-

бражение и текст, единожды напечатанные, уже не могут быть изменены. В DPS, 

напротив, как мы вскоре убедимся, возможно внедрять информацию, которая об-

новляется в реальном времени через Интернет. Кроме того, можно создавать внеш-

ние ссылки, дающие возможность пользователю перейти к интересующей его ин-

формации мгновенно. 

Во-вторых, в печатных изданиях интерактивные возможности ограничиваются 

лишь перелистыванием страниц. В DPS же существует целый ряд функций, позво-

ляющих пользователю взаимодействовать с изданием, таких как кнопки, фильмы, 

слайд-шоу и даже некоторое подобие 3d-объектов, которые можно рассматривать  

с разных сторон. Это отличие интересно не только издателям, но, может быть, еще 

в большей степени, рекламодателям, размещающим информацию о своих продук-

тах внутри публикации. 

Следующее отличие касается ценовой политики. Печатные издания и DPS-

публикации стоят на рынке примерно одинаково, чаще всего DPS даже дешевле. 

Однако не стоит забывать, что для просмотра электронных публикаций читателю 

нужно будет приобрести еще и дорогостоящее специализированное оборудова-

ние — планшетный компьютер. Это несколько ограничивает круг читателей элек-

тронных публикаций. Если мы имеем дело с печатной продукцией, она доступна не 

только в продаже, но и обязательно поступает в библиотеки, где любой человек 

может получить к ней бесплатный доступ. В мире DPS такая возможность пока что, 

к сожалению, отсутствует. 
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С другой стороны, в DPS уже заложено решение всех печатных, логистических, 

транспортных, складских и многих других проблем, с которыми ежедневно сталки-

ваются издатели бумажных публикаций. Как только в онлайн-среде DPS нажата 

кнопка Опубликовать, в ту же секунду у всех подписчиков издания появляется 

уведомление о новом номере, и все, что остается сделать — это просто скачать его. 

А теперь давайте сравним две фундаментальные платформы — ePub и DPS. Первое 

и, пожалуй, основное отличие и преимущество ePub перед DPS заключается в воз-

можности просматривать его практически на любом электронном устройстве, на-

чиная от цифровых книг с электронными чернилами до обыкновенного персональ-

ного компьютера. 

С другой стороны, как мы уже знаем, ePub основан на достаточно ограниченном 

языке HTML, что уменьшает его интерактивные возможности. Напротив, DPS по-

зволяет внедрять внутрь публикаций практически все интерактивные и мультиме-

дийные функции, которые существуют. 

Одна из принципиальных позиций, в которых отличаются ePub и DPS, — это вер-

стка. Первой технологии, как вы помните, свойственна плавающая верстка. В DPS 

же мы в абсолютном большинстве случаев имеем дело с фиксированной. Именно  

поэтому для каждого из устройств и платформ дизайнерами создаются отдельные 

макеты. Кроме того, особенностью последнего является то, что пользователь не 

имеет доступа к тексту внутри публикации. Если в ePub мы можем выделить и ско-

пировать часть текста, в DPS этой возможности нет, т. к. все текстовые блоки при 

сохранении folio конвертируются в растровые изображения. 

Наконец, в ePub можно создавать закладки и прочие навигационные подсказки,  

чего, к сожалению, пока не дает делать DPS. 

Ряд отличий касается, конечно же, моделей распространения. В случае ePub, рас-

пространение, как и управление авторскими правами, лежит на вас или доверенном 

вами лице. В мире DPS эти функции осуществляет уже непосредственно дистрибь-

ютор, такой как Apple AppStore, Android Market или Blackberry AppWorld. 

Теперь, когда мы разобрались с идеологией DPS, давайте остановимся на несколь-

ких принципиальных аспектах при разработке дизайн-макета электронной публи-

кации, на которые стоит обратить особое внимание. 

В первую очередь, это двойная ориентация. Как мы уже говорили ранее, необходи-

мо всегда предусматривать два макета одной и той же публикации, соответственно 

для вертикального и горизонтального расположения устройства. Эту же особен-

ность нужно учитывать при именовании наших файлов. Всегда добавляйте _v для 

вертикального макета и _h для горизонтального, например catalog_v и catalog_h. 

Начиная с версии CS6, данную операцию можно автоматизировать с помощью но-

вой функции Alternate Layout. 

Не забывайте, что все размеры в макете обязательно указывать в пикселах, т. к. мы 

работаем с электронными устройствами. При этом, вы всегда должны знать конеч-

ное разрешение экрана того устройства, для которого в настоящий момент разраба-

тываете публикацию, и указывать именно его при создании нового документа. 
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Кстати, при создании нового документа вы можете не указывать ни поля, ни выле-

ты в диалоговом окне, т. к. мы имеем в своем распоряжении всю область экрана.  

И еще один интересный прием — для большинства устройств, применительно  

к которым вы будете создавать макеты, вам даже не потребуется знать разрешение 

и размеры их экранов, т. к. в новой версии InDesign CS6 они уже заложены. Для 

того чтобы воспользоваться ими, при создании документа в диалоговом окне New 

Document, в раскрывающемся списке Intent, выберите значение Digital Publishing. 

В случае выбора этого пункта, в раскрывающемся списке Page Size вы сможете вы-

брать предустановку для пяти наиболее популярных платформ — iPhone, iPad, 

Kindle Fire, Nook и стандартных 10-дюймовых планшетов на основе Android. 

Когда вы создаете дизайн для электронной публикации, то вы также должны пом-

нить, что пользователь взаимодействует с ней совершенно другим образом, нежели 

чем это происходит с обыкновенной печатной продукцией. Во-первых, необходимо 

учитывать, что он может листать и читать каждый раздел в вертикальном положе-

нии, страница за страницей без обрывов и видимых стыков между ними, в горизон-

тальном положении пролистывание будет осуществляться между разделами. Кроме 

того, если принудительно не указано обратное, при листании на каждой из страниц 

будет происходить остановка. В связи с вышеизложенными фактами, важно, чтобы 

дизайн был непрерывным, например, возможно создать какие-либо элементы пере-

ходящими из страницы в страницу. Это, в результате, создаст интересный эффект 

одной сплошной вертикальной страницы, чего нам и следует всегда стараться до-

биться. Вы сможете наблюдать подобный эффект в документах, с которыми мы 

будем работать на протяжении этой главы. 

Наконец, настоятельно рекомендуется тестировать любую вашу публикацию на 

конечном целевом устройстве. Это даст вам уверенность в том, что пользователь, 

изучающий ее, не столкнется с какими-либо проблемами. 

Таким образом, соблюдение этих несложных правил дизайна и верстки позволит 

вашему конечному изданию не только быть насыщенным интерактивными и муль-

тимедийными элементами, а также избежать возможных ошибок, но и стать по-

настоящему клиентоориентированным, доставляя читателям огромное удовольст-

вие от процесса изучения материалов и, конечно же, увеличивая при этом количе-

ство подписчиков. 
 

Настройка инструментов для работы с DPS 

Для корректной работы Adobe Digital Publishing Suite (DPS) у вас на компьютере 

должны быть установлены некоторые необходимые компоненты. В Adobe InDesign 

CS6 для этого необходимо открыть палитру Window > Folio Builder и в появив-

шемся окне нажать на ссылку установки дополнительных компонентов или же за-

грузить их по адресу https://digitalpublishing.acrobat.com/. В нижней левой части 

окна вы найдете поле Updates, в котором находятся все ссылки, по которым вы 

можете скачать эти компоненты для разных версий InDesign и различных плат-

форм. 
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У вас также, обязательно, должна быть учетная запись Adobe с требуемыми Adobe 

ID и паролем. Чтобы получить их, нужно зайти по ссылке https://www.adobe.com/ 

cfusion/membership/index.cfm?nf=1&loc=en_us&nl=1 и нажать кнопку Create an 

Adobe Account в левой части экрана. После этого вам будет предложено заполнить 

несложную форму и на указанную почту будет прислана ссылка для подтвержде-

ния регистрации. Необходимо перейти по ней для завершения. 

Единственное, что нам осталось сделать для начала работы — это настроить наше 

рабочее пространство в самом InDesign. В данной главе мы будем, в основном, ра-

ботать над одной публикацией. Заготовку для нее вы можете найти в файле 

2WheelsGood.indd папки "\Подготовка DPS" нашей рабочей документации. 

Нам также могут понадобиться следующие палитры, которые можно вызвать уже 

знакомым вам способом из главного меню программы Window или Window > 

Interactive: 

 Folio Builder; 

 Folio Overlays; 

 Hyperlinks; 

 Buttons And Forms; 

 Object States; 

 Layers; 

 Color/Swatches; 

 Pages. 

Создание кнопок и управление ими 

Для создания кнопок при работе с документами в среде Digital Publishing Suite вам 

необходимо воспользоваться знаниями, полученными ранее при работе с простыми 

интерактивными документами в InDesign. В данном разделе мы попытаемся дать 

кнопке функционал для перехода на внешнюю интернет-страницу и, кроме того, 

научимся использовать наборы кнопок, которые уже заложены в InDesign. 

В первую очередь, перейдем к шестой странице нашей публикации. После этого 

откроем панель Buttons And Forms и выберем пункт контекстного меню Sample 

Buttons And Forms. 

Перед вами откроется одноименная палитра Sample Buttons And Forms (рис. 3.1) 

выбора различных элементов управления, и здесь вы найдете огромное количество 

уже созданных дизайнов кнопок, как для простых нажатий, так и для сложной сис-

темы навигации. Выберите любую понравившуюся вам кнопку и просто перетащи-

те ее на вашу рабочую область. Затем можете закрыть палитру Sample Buttons And 

Forms. Поместите кнопку в нижней правой части листа и немного увеличьте ее. 

Как вы видите, и события и действия и даже внешний вид для этой кнопки уже на-

строены. Однако абсолютно все эти пункты можно перенастроить под те парамет-

ры, которые вам нужны. 
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Рис. 3.1. Вид палитры Sample Buttons And Forms 

Давайте изменим имя этой кнопки на GoToGoogleMaps. Также удалите действие 
GoToPage и добавьте новое с названием GoToURL. В графе URL появившихся на-
строек давайте зададим, к примеру, ссылку http://maps.google.com, которая послу-
жит адресом, по которому будет осуществляться переход при нажатии на эту кноп-
ку. Итак, мы получили требуемую кнопку, можете проверить ее работоспособность 
с использованием палитры SWF Preview. 

При работе с DPS также возможно настраивать кнопки для работы с Multi-State 

objects. Для того чтобы понять, как это делается, перейдите к седьмой странице 
публикации. 

В левой части листа представлен ряд изображений и подписей к ним. Уже извест-
ным вам способом конвертируйте их в объект с множественными состояниями.  
В правой же части листа, на карте, превратите выделенные области в кнопки.  
Теперь, если вы выберете для каждой из кнопок действие GoToState и привяжете 
его к соответствующему состоянию в созданном нами multi-state object, у нас полу-
чится настоящая интерактивная карта (рис. 3.2). 

Если теперь открыть панель SWF Preview и запустить просмотр нашего проекта, то 
нажатия на области карты будут приводить к открытию соответствующих фото-
графий и описаний к ним. 
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Рис. 3.2. Вид палитр Object States и Buttons And Forms при создании интерактивной карты 

Как вы увидели, манипуляции с кнопками в среде DPS не сильно отличаются от 

подобной работы при создании обыкновенных интерактивных документов, кото-

рые сохраняются в форматах Flash и PDF. Однако стоит помнить, что далеко не все 

действия можно применять при сохранении в файлах Folio. Допустимыми считают-

ся следующие: 

 GoToFirstPage; 

 GoToLastPage; 

 GoToURL; 

 GoToPage; 

 GoToState; 

 GoToNextState; 

 GoToPreviousState 

Все остальные действия, предписываемые кнопкам, не будут корректно работать в 

среде DPS. Также обратите внимание на следующий факт — если вы создаете элек-

тронное издание для планшетных устройств, таких как iPad, нельзя использовать 

для кнопок такие события, как On Roll Over или On Roll Off, т. к. они, за счет осо-

бенностей сенсорной платформы, не будут обрабатываться. 
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Работа с гиперссылками и внешними ссылками 
внутри публикации DPS 

В данном разделе мы научимся работать с гиперссылками в среде DPS. Так же как 

и с кнопками, настройки гиперссылок примерно соответствуют тому, что мы дела-

ли, работая ранее над нашей интерактивной публикацией. Попробуем разработать 

ссылочную структуру для этого документа. Как всегда, определим наши задачи. 

Давайте сделаем ссылку с обложки нашего издания на последнюю страницу, где 

находится разработанная нами ранее интерактивная карта. 

Для начала, откройте последнюю страницу и отобразите палитру Hyperlinks.  

В контекстном меню этой палитры выберите знакомый вам пункт New Hyperlink 

Destination. В открывшемся одноименном диалоговом окне, т. к. у нас ничего не 

было выделено, отображается весьма ограниченное количество настроек. Все они 

вам хорошо знакомы. Однако стоит отметить, что в раскрывающемся списке Zoom 

Settings для DPS нельзя выбирать ничего кроме Fixed, т. к. публикации открывают-

ся на мобильных устройствах в полный экран, и у пользователя нет возможности 

как-то дополнительно корректировать их размер. 

В раскрывающемся списке Type, в случае, когда не выбран текст, кроме значения 

Page можно выбрать только лишь URL. Еще один тип пунктов назначения, знако-

мый вам — текстовый якорь, также поддерживается в среде DPS и его можно на-

строить, просто выделив текстовый фрагмент и выбрав в контекстном меню палит-

ры Hyperlinks пункт New Hyperlink Destination. Сейчас, однако, нас интересует 

именно пункт, выбранный по умолчанию, так что давайте назовем этот пункт на-

значения MapPage и нажмем кнопку OK. 

Теперь можно перейти на первую страницу публикации и, выбрав блок текста в 

правом нижнем углу страницы, в палитре Hyperlinks создать новую ссылку. Выбе-

рите в раскрывающемся списке Link To значение Shared Destination, а в списке 

Name — MapPage, созданный нами ранее пункт назначения. Не забывайте, что 

именно здесь можно задать ссылки не только внутри документа, но и на любые 

внешние ресурсы. Для этого просто выберите его в раскрывающемся списке 

Document. Здесь мы также можем применить заранее созданный стиль, описываю-

щий, как будет выглядеть текст нашей ссылки. Данные стили, если вы помните, 

задаются в палитре Character Style. 

Обратите внимание, что при работе с DPS не следует вносить никаких изменений  

в группе управляющих элементов Appearance данного диалогового окна, т. к. это 

может привести к сбою при последующей работе на устройствах. 

Как только основное поведение ссылки настроено, нам необходимо понять, как она 

будет выглядеть внутри DPS-публикации. Для подобных операций в InDesign  

существует палитра Folio Overlays, которую можно вызвать с помощью меню 

Window > Folio Overlays. 

Данная палитра относится к так называемым контекстным палитрам. Это означа-

ет, что, в зависимости от того, к какому типу относится выделенный элемент, соот-
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ветствующую форму будет принимать и эта палитра. К примеру, выделите кнопку, 

которую мы создали в одном из прошлых разделов — в палитре Folio Overlays ав-

томатически отображается раздел Hyperlink (рис. 3.3). Раз уж мы попали в этот 

раздел, давайте сразу же поговорим о нем подробней. 
 

 

Рис. 3.3. Вид палитры Folio Overlays при работе с гиперссылками 

 

Здесь мы видим два различных варианта того, как будет отображаться открываю-

щаяся ссылка. Первый — Open in Folio — после выбора одноименного переключа-

теля указывает устройству, на котором публикация будет отображаться, что ссылку 

необходимо загрузить непосредственно в среде публикации. Если же выбрать пере-

ключатель Open in Device Browser, после нажатия на ссылку публикация будет,  

в зависимости от типа устройства, либо закрыта, либо свернута, а вместо нее бу- 

дет открыт web-браузер, в адресную строку которого уже будет загружена наша 

ссылка. 

Каким же образом решить, какой из вариантов выбрать. Это достаточно просто. 

Если вы знаете, что пользователь проведет на сайте по ссылке короткое время и 

данный сайт не содержит в себе сложных программных компонентов, смело уста-

навливайте первый вариант. В противном случае, а также, если вы уверены, что на 

сайте существуют элементы, которые могут быть некорректно отображены в среде 

вашей публикации, например мобильные библиотеки jQuery, то следует выбрать 

второй вариант. Также, если вы выберете второй вариант, станет доступна опция 

Ask First, означающая, что устройство, перед тем как перейти по ссылке и открыть 

браузер, запросит у пользователя, уверен ли он, что хочет покинуть среду публика-

ции и перейти по внешней ссылке. Давайте включим эту настройку и нажмем в ле-

вом нижнем углу кнопку Preview для просмотра уже не средствами InDesign, а с 

помощью специальной программы просмотра folio-файлов Adobe Content Viewer 

(рис. 3.4). Рядом с ней, кстати, вы увидите маленький значок со стрелкой, который 

позволяет выбирать, каким образом производить предварительный просмотр — 

с помощью Adobe Content Viewer или непосредственно на подключенном к компь-

ютеру устройстве с запущенным приложением Adobe Viewer. О тестировании на-

шей публикации на целевых устройствах мы поговорим чуть позже, а пока обра-

тимся вновь к нашему изданию. 
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Рис. 3.4. Вид окна программы просмотра Adobe Content Viewer 

Когда оно загружено, сначала нажмите на созданную нами ссылку на обложке для 

перехода на последнюю страницу. 

Не пугайтесь, что в среде Adobe Content Viewer не работает колесо прокрутки мы-

ши. Это сделано умышленно для создания полной иллюзии взаимодействия с мо-

бильным устройством с сенсорным управлением. 

Вернитесь на шестую страницу и щелкните по нашей кнопке для того, чтобы по-

смотреть, как будет работать внешняя ссылка. Как видите, нам задан вопрос, уве-

рены ли мы, что хотим покинуть это приложение и перейти к просмотру страницы 

в браузере — нажмем кнопку OK. Страница открылась в браузере, установленном 

по умолчанию в вашей системе. 

Теперь закроем это окно и вновь вернемся в InDesign. Давайте изменим настройки 

открытия ссылки на Open in Folio и еще раз нажмем кнопку Preview. Теперь, как 

видите, заданный сайт открывается в среде нашей DPS-публикации. Когда вы за-

кончили просматривать его содержимое, то можно нажать на кнопку Done в левом 

верхнем углу приложения. 

Те возможности, которые мы рассмотрели в этом разделе — один из самых глав-

ных плюсов Adobe Digital Publishing Suite, т. к. позволяют просматривать содержи-

мое внешних ресурсов так, как если бы они были встроены внутрь структуры наше-

го издания, конечно, при наличии подключения к Интернету. В следующих разде-

лах мы продолжим развивать наши навыки в этой области и узнаем, как внедрять  

в публикацию части web-ресурсов, при этом сохраняя внутреннюю верстку из- 

дания. 
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Обзор объекта multi-stаte object при 
использовании в DPS-публикации 

В данном разделе мы научимся применять уже знакомый нам по методикам работы 
с интерактивными документами объект multi-state object, или иначе объект с мно-
жественными состояниями. Мы подробно рассматривали этот объект, когда рабо-
тали в одном из предыдущих разделов. Тогда мы привязывали появление каждого 
из состояний к щелчку на определенные участки карты, заранее конвертированные 
в кнопки. Однако есть еще одна методика работы с multi-state objects, позволяющая 
преобразовывать их в полноценные слайд-шоу, запускаемые одним прикосновени-
ем пользователя. Их-то мы и научимся создавать. 

Для начала работы перейдите на пятую страницу проекта, над которым мы работа-
ем, и обратите внимание на группу изображений в левой части листа. С помощью 
любого удобного для вас способа выделите все изображения и, используя функции 
палитры Object States, конвертируйте их в один объект с множественными состоя-
ниями. Назовем наш объект SlideShow. 

Теперь, чтобы сделать из multi-state object слайд-шоу, нам понадобится палитра 
Folio Overlays. Если в данный момент вновь созданный multi-state object еще не 
выделен, то сделайте это. Вы увидите, что палитра преобразовалась для работы  
в режиме Slideshow. Рассмотрим настройки данного раздела подробней (рис. 3.5). 

 

Рис. 3.5. Вид палитры Folio Overlays при работе со слайд-шоу 
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Первая опция — флажок Auto Play в активном состоянии указывает, что необхо-

димо запустить слайд-шоу сразу же при открытии страницы. Вторая опция — фла-

жок Tap to Play/Pause включает режим, при котором нажатия пользователя на об-

ласть слайд-шоу приводят к его последовательному запуску и остановке. Выберем 

именно эту опцию. Изменяя значения в списке Interval, мы можем корректировать 

время, которое будет воспроизводиться каждое изображение слайд-шоу. Оставим 

это значение равным 2 секундам. Флажок Loop позволяет демонстрировать слайд-

шоу циклично, т. е. отображать первый кадр после завершения последнего. 

Следующая опция — флажок Cross Fade позволяет с помощью списка Speed на-

строить время плавного перехода от одной картинки к другой. В случае если этот 

флажок сброшен, то переключение будет происходить мгновенно. Оставим здесь 

также все без изменений, т. е. 0,5 секунды. Флажок Swipe to Change Image позво-

ляет пользователю, используя на своем сенсорном дисплее жест перелистывания, 

переходить к следующему слайду. 

Флажок Hide Before Playing требует более детального рассмотрения. Все дело  

в том, что все объекты, настроенные с помощью палитры Folio Overlays, автомати-

чески помещаются на верхний слой над всеми остальными элементами. И если,  

к примеру, мы захотим отобразить поверх слайд-шоу, скажем, инструкцию для 

пользователя или какое-либо описание, то при загрузке оно будет скрыто под  

нашим элементом. Именно для таких моментов и создана эта опция. Давайте по-

пробуем ее в деле. 

 

Рис. 3.6. Вид значка "Нажмите для просмотра" в пределах рабочей области 

 

Для этого давайте обратим внимание на значок "Нажмите для просмотра", кото-

рый отображается над изображениями. После этого нам необходимо поместить над 

нашим слайд-шоу некую заглушку, которая будет демонстрироваться до того мо-

мента, пока оно не будет запущено. В качестве заглушки просто используем первое 

изображение из слайд-шоу. Скопируем его внутри state и вставим поверх нашей 

картинки. Не забудьте после этого поднять на верхний уровень нашу подсказку для 

пользователя. 

Наконец, все готово для просмотра — запустите его с помощью кнопки в левом 

нижнем углу палитры Folio Overlays. Перейдите на пятую страницу и щелкните по 

области созданного слайд-шоу. Как вы видите, нажатие приводит к тому, что под-

сказка для пользователя скрывается и начинается проигрывание слайд-шоу. 

Давайте вернемся в InDesign и рассмотрим остальные настройки, которые нам 

предлагаются в этой палитре. 
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Списки Delay и Play становятся активны, если установить флажок Auto Play, и от-

вечают за то, с какой задержкой от момента открытия страницы будет запущено 

слайд-шоу и сколько раз оно будет проиграно (если, конечно, не установлен фла-

жок Loop). 

Флажок Stop at Last Image включает режим, при котором воспроизведение слайд-

шоу приостанавливается на последнем изображении, а флажок Stop at First and 

Last Image и на последнем, и на первом изображении соответственно. 

И наконец, флажок Play in Reverse устанавливает обратный порядок проигрывания 

слайд-шоу, т. е. после третьей картинки будет показана вторая и т. д. 

Обзор возможностей Image Sequence 

Одна из интереснейших функций, которую позволяет внедрять Digital Publishing 

Suite, — это Image Sequence или последовательность изображений. Данный объект 

представляет собой собрание последовательных кадров, которое позволяет пользо-

вателю перемещаться между ними так, как будто это происходит по временной 

шкале видеофайла. Звучит довольно запутано, но не пугайтесь, все работает доста-

точно просто, и для того, чтобы понять это, давайте вновь обратимся к примеру. 

На самом деле, говоря про Image Sequence, мы имеем дело с простейшим набором 

последовательно снятых из разных положений кадров одного и того же объекта,  

в некоторые из которых с помощью растрового редактора могут быть добавлены 

блоки с дополнительной информацией. 

Данная функция в DPS-публикациях дает нам удивительную возможность реализо-

вать непревзойденные дизайнерские решения. К примеру, мы можем делать видео-

инструкции, в которых пользователь сможет с точностью до кадра выбрать интере-

сующую его область и внимательно ее рассмотреть. Спектр возможностей, как все-

гда, ограничен только лишь нашей фантазией. 

Итак, давайте разберемся, каким образом данный объект создается и настраивается. 

В первую очередь, нам необходимо подготовить последовательность изображений. 

Это могут быть покадровые изображения из видеофайлов, объекты, снятые по кру-

гу с помощью камеры, или же "облеты", сделанные с помощью 3d-редакторов. Для 

примера, в папке \Подготовка DPS\links\Links находится папка HUBBike_360, внутри 

которой расположены изображения велосипеда c разных сторон в количестве 

150 штук, т. е. примерно по одному изображению на каждые два с половиной гра-

дуса поворота объекта. Как мы уже обсудили ранее, абсолютно не важно, каким 

способом получены данные изображения. Главное — то, каким образом в их име-

нах идет нумерация. Важно запомнить, что то, в какой последовательности идет 

нумерация файлов в папке, из которой мы берем изображения, учитывается при 

построении последовательности изображений (Image Sequence), и именно этот фак-

тор является определяющим в том, в какой последовательности будут демонстри-

роваться изображения. 

Следующим шагом в создании последовательности изображений является выбор 

фрейма, в котором он будет отображаться. Выберите изображение велосипеда на 
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третьей странице нашей публикации и обратите внимание на палитру Folio 

Overlays. Здесь нам предоставляется выбор того, с какой из возможностей мы бу-

дем работать; следует открыть раздел Image Sequence (рис. 3.7). Именно здесь мы 

будем настраивать все параметры нашей будущей последовательности. 
 

 

Рис. 3.7. Вид рабочей области при подготовке Image Sequence 

 

Сначала, в первом поле Load Images выберите папку с вашими изображениями.  

В случае нашего примера, это HUBBike_360. Во-вторых, как вы видите, после за-

грузки изображений в нашем фрейме не отображается ни одно из них. Для того 

чтобы включить эту функцию, установите флажок Show First Image Initially. Все 

остальные настройки, расположенные ниже, знакомы нам по предыдущему разде-

лу; давайте оставим установленным лишь флажок Swipe to Change Image. Обра-

тить внимание стоит на единственный момент — если вы устанавливаете флажок 

Auto Play (ставите здесь "галочку"), то всегда помните о том, что необходимо про-

контролировать и, при необходимости, откорректировать настройки задержки, ско-

рости и количества проигрываний вновь созданной последовательности. Кстати, 

если указать достаточно большой показатель скорости (Speed), а он задается в ве-

личине fps, т. е. frames per second (кадры в секунду), можно создать имитацию  

видеофрагмента. 

Затем, как все настройки сделаны, вы можете нажать кнопку Preview и проверить, 

как все работает. Если вы щелкнете по изображению велосипеда, то у вас появится 

возможность вращать его вокруг своей оси, тем самым создавая эффект работы  

с 3d-объектом. Кроме того, в случае поворота в определенные положения, также 

отображаются различные комментарии относительно тех или иных деталей велоси-

педа. 
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Обзор возможностей создания  
панорамных изображений 

Одна из интересных возможностей, которые представляет нам пакет Digital 

Publishing Suite, — создание панорамных изображений. В этом разделе мы научим-

ся создавать их и настраивать различные параметры их отображения. 

Для того чтобы поместить изображение такого типа в среду InDesign, оно предва-

рительно должно быть специальным образом подготовлено. Лучшим инструментом 

для такого рода подготовки может служить Adobe Photoshop CS6. В нем есть спе-

циальные инструменты для создания круговых панорам. Обратите внимание, что 

всегда следует сверять левый и правый край изображения. Чем ближе они друг  

к другу по тону и чем более четко подготовлен сам стык, тем более органично бу-

дет выглядеть результат, и будет значительно менее заметно место склейки. 

Когда вся визуальная подготовка проведена, нам требуется специальным образом 

разметить наши изображения. Для этого прекрасно подойдет такое небольшое при-

ложение, как Pano2VR. Именно эта программа, кстати, рекомендована в документа-

ции к DPS. Она является платной, и для коммерческого использования необходимо 

приобрести лицензию, однако для учебных целей нам вполне подойдет trial-версия. 

В первую очередь, сохраните полученный документ в формате TIFF, а затем пере-

несите его с помощью мыши из папки на схему с надписью Drop your panorama 

here. В папке \Подготовка DPS\linfs\Links вы можете найти уже готовый файл, кото-

рый называется Beach_Pano.tif. После его открытия нам становятся доступны неко-

торые параметры. Pano2VR является контекстно-ориентированным приложением и 

само определяет, что в случае с данным изображением мы имеем дело с цилиндри-

ческой панорамой (без возможности просмотра вверх и вниз), о чем и сообщает нам 

в верхней левой части окна. 

Если мы хотим настроить параметры просмотра, то это можно сделать в разделе 

Viewing Parameters, нажав кнопку Modify. Как вы видите, над и под макетом изо-

бражения мы можем установить пределы просмотра, т. е. те углы, выше и ниже ко-

торых, соответственно, не будет перемещаться изображение. Рядом с графой указа-

ны значения стартовой точки, определенные с помощью угловых размеров изобра-

жения. С нее и будет начинаться просмотр панорамы. Для того чтобы использовать 

данные углы в качестве пределов просмотра, просто нажмите кнопку Set, располо-

женную тут же. Также существуют пределы по левому и правому краю, но т. к. мы 

имеем дело с горизонтальной или цилиндрической панорамой, в настоящий момент 

они не доступны. Мы можем лишь, перемещая с помощью мыши изображение в 

окне просмотра, задать стартовую позицию для просмотра. После того, как вы вы-

брали начальную точку просмотра, нажмите кнопку Set в левом верхнем секторе 

данного окна для того, чтобы зафиксировать выбранные параметры в качестве ис-

пользующихся по умолчанию. После этого нажмите кнопку OK для окончательной 

фиксации настроек. Следующим шагом, давайте настроим параметры экспорта го-

тового панорамного изображения. Для этого необходимо нажать кнопку Convert 

Input в главном окне программы. В качестве формата сохранения файла давайте 
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выберем JPEG в раскрывающемся списке Format. Далее для типа экспорта в списке 

Type выберем значение Cube Faces. Выбрав это значение, мы указываем програм-

ме, что необходимо создать 6 изображений, каждое из которых описывало бы па-

нораму из разной плоскости, тем самым создав иллюзию 360º просмотра. Именно 

данный тип панорамного изображения для корректной работы требует от нас 

InDesign. После того, как вы выбрали все необходимые значения, нажмите кнопку 

Convert. Так как мы сделали все необходимые настройки, можно нажать кнопку 

Create All для получения итоговых файлов панорамного изображения. Если же на 

вашем компьютере по тем или иным причинам невозможно установить требуемое 

ПО, не отчаивайтесь, вы сможете использовать готовые файлы, хранящиеся в папке 

\Подготовка DPS\linfs\Links\Beach_Pano. 

После того как мы получили готовые файлы с помощью Pano2VR, вернемся  

в InDesign и используем фрейм на странице восемь нашей рабочей публикации для 

создания некоего контейнера для просмотра панорамного изображения, как мы  

видели в примере. Для этого нам вновь понадобится палитра Folio Overlays, на 

этот раз в режиме Panorama (рис. 3.8). 
 

 

Рис. 3.8. Вид рабочей области при подготовке панорамы 

В первую очередь нам нужно загрузить в InDesign те изображения, которые мы 

создали в программе Pano2VR. Для этого щелкнем по значку папки , расположен-

ному над полем Load Images, и просто выберем папку, в которой находятся наши 

изображения. Как вы видите, изображения открываются в максимальном масштабе. 

Для того чтобы это исправить, измените в палитре настроек в верхней части экрана 

значение масштаба на 30% как для горизонтального, так и для вертикального раз-

мера. После этого просто выровняйте фрейм и изображение в нем по форме и раз-
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мерам таким образом, чтобы он занимал верхнюю часть листа. Напоминаю вам, что 

при необходимости изменять размеры и положение изображения, независимо от 

характеристик фрейма, вы можете воспользовавшись Content Grabber — полупро-

зрачной окружностью внутри фрейма. 

После того как изображение масштабировано и выровнено, давайте разберемся  

с настройками, которые нам предлагает палитра Folio Overlays, когда мы работаем 

с панорамами. 

Первая группа настроек описывает начальное внешнее состояние панорамы, мас-

штаб указывается в поле Initial Zoom, поля Vertical и Horizontal задают стартовый 

угол просмотра изображений. Установим значение масштаба, равное 70, и вспом-

ним значения, которые мы видели ранее в программе Pano2VR для начальных уг-

лов — 0 по вертикали и –41 по горизонтали. В этой же палитре мы также можем 

установить пределы по углам отклонения в вертикальной и горизонтальной плос-

кости — давайте для вертикали выберем –1 и 1 соответственно, а опцию горизон-

тального предела оставим выключенной. Это позволит пользователю просматри-

вать изображение на 360º по горизонтали и не позволит двигать его вверх и вниз, 

т. к. мы, как вы помните, работаем с цилиндрической панорамой. 

Когда мы выставили все параметры, давайте посмотрим, что у нас получилось. Как 

вы видите, при активации панорамы перед нами открывается так называемый плеер 

Panorama Player, позволяющий просматривать специально подготовленные для 

этого изображения. В нем с помощью мыши вы можете изменять угол обзора, при 

специальной настройке это можно делать в двух плоскостях, т. е. перемещать изо-

бражение вверх и вниз. Здесь также имеется возможность увеличивать или умень-

шать масштаб просмотра, как с помощью мыши в Adobe Content Viewer, так и 

с помощью жестов Multi-touch на мобильных устройствах. 

Обратите внимание на то, что если вы хотите, чтобы не было видно черных по-

верхностей снизу и сверху при просмотре, вы можете либо установить другие зна-

чения для масштаба, либо попробовать сделать фотографию, охватывающую пол-

ный угол не только в горизонтальной плоскости, но и в вертикальной. Тогда вы  

будете наслаждаться уже не цилиндрической панорамой, а сферической, что, без-

условно, выведет вашу публикацию на совершенно другой визуально-комму-

никативный уровень. 
 

Внедрение в публикацию аудиофайлов 

В данном разделе мы научимся работать с аудиофайлами при внедрении их в нашу 

DPS-публикацию. Рабочий процесс и методика здесь во многом близки тому, что 

мы делали при разработке интерактивных изданий, но, как и везде, имеют несколь-

ко немаловажных нюансов. 

Так же, как при работе с интерактивными презентациями, первый шаг во внедре-

нии аудиофайла в публикацию — его вставка с помощью команды File > Place. 

Здесь, как и ранее, поддерживаются аудиофайлы только в формате MP3. 
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Однако взаимодействие с настройками при работе с аудиофайлами в структуре 

DPS-публикаций осуществляется уже не в палитре Media, а с помощью Folio 

Overlays. После того как файл вставлен, откройте данную палитру и вы увидите, 

что она настроена на работу в разделе Audio & Video. Первым делом необходимо 

разобраться с тем, что такое Controller Files. По сути, в данном поле указывается 

адрес папки, в которой находятся изображения управляющих кнопок для аудио-

файла в различные моменты времени. Если вы откроете пример данных изображе-

ний в папке Links > Audio_Controllers, то увидите, что они представляют собой 

последовательную структуру из парных файлов в формате PNG с префиксами _Play 

и _Pause, соответственно отвечающих за начало и остановку проигрывания музыки 

(рис. 3.9). 
 

 

Рис. 3.9. Внешний вид аудиоконтроллеров 

Кроме того, в каждом следующем объекте данной последовательности элементы 

изменяются так, как если бы это происходило с ходом времени в процессе проиг-

рывания музыки. На самом деле, так и происходит. Данные файлы изначально соз-

даны в Adobe Illustrator и экспортированы в PNG-формат. При загрузке в InDesign 

происходит своего рода привязка последовательности файлов к временной шкале, 

причем, в зависимости от того, сколько подобных файлов создано в последователь-

ности, на столько участков разбивается временная шкала. Количество файлов в по-

следовательности ничем не ограничено. Для примера, в нашей публикации создано 

5 наборов файлов. Обратите внимание на то, что именно наличие префиксов дает 

InDesign информацию, к какому из действий стоит привязывать то или иное изо-

бражение. 

После того как вы загрузили картинки в палитру Folio Overlays (рис. 3.10), можно 

нажать кнопку Preview и оценить результат. Как вы можете увидеть, при нажатии 

на кнопку Play начинается проигрывание музыки, сопровождаемое изменением 

внешнего вида данной кнопки с течением времени. При нажатии же кнопки Pause 

происходит временная остановка проигрывания и, соответственно, смена на дру-

гую кнопку. 

Вот таким, своеобразным, на первый взгляд, способом происходит работа с управ-

ляющими элементами, контролирующими поведение звуковых файлов в DPS-

публикациях. Несмотря на некоторую сложность в первичном понимании процесса 
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работы с ними, эта методика снимает с дизайнера многие ограничения и открывает 

для него возможность создать элементы управления именно такими, какие нужны 

для каждой конкретной ситуации при работе с разнообразными макетами элек-

тронных публикаций. 

 

Рис. 3.10. Вид рабочей области при внедрении аудиофайлов 

Внедрение в публикацию видеофайлов 

Одно из преимуществ цифровых издательских технологий, таких как DPS — это 

уникальная возможность внедрять видеофайлы в свою публикацию. В этом разделе 

мы с вами познакомимся с тем, как это делается и какие настройки существуют при 

работе с подобными файлами в DPS-среде. 

Первое, на чем стоит заострить внимание — это то, какие типы файлов мы можем 

использовать в DPS-издании. На сегодняшний день абсолютно совместимым явля-

ется формат MP4 с кодировкой H.264. Это обусловлено поддержкой устройства 

iPad от Apple, которое работает только с этим типом файлов. Если вы разрабаты-

ваете публикации для других устройств, вполне можно экспериментировать с дру-

гими форматами, однако если вы желаете получить универсальный продукт,  

подходящий для любых устройств, настоятельно рекомендуется выбирать имен- 

но MP4. 
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Чтобы вставить видеофайл в нашу публикацию, давайте перейдем на четвертую 
страницу, выделим в нижнем правом углу специальный фрейм, подготовленный 
для него, и с помощью знакомой нам команды File > Place поместим в него видео. 
Как вы видите, ничего не произошло. 

Дело в том, что здесь, как и в случае с работой с обычным интерактивным доку-
ментом, обязательно необходимо принудительно задавать изображение-заглушку, 
которая отображалась бы в те моменты времени, когда видео не проигрывается. 
Это делается уже известным вам способом с использованием палитры Media. Кста-
ти, это единственное действие, которое нужно сделать здесь. Все остальные мани-
пуляции мы будем проводить при помощи палитры Folio Overlays (рис. 3.11). 

 

Рис. 3.11. Вид рабочей области при внедрении видеофайлов 

Если мы откроем ее, вы увидите, что она работает сейчас в режиме Audio & Video, 
но для изменения доступны настройки из нижней части этой палитры, касающиеся 
как раз видеофайлов. 

Первая опция — флажок Auto Play — дает нам возможность автоматически запус-
тить проигрывание видео при открытии страницы и, также, с помощью списка 
Delay задать некоторую отсрочку этого воспроизведения. Следующая опция — 
флажок Play Full Screen — настраивает полноэкранный режим просмотра видео по 
умолчанию при старте. Давайте установим этот флажок для нашей публикации. 
Последняя опция — флажок Tap to View Controller — включает функцию отобра-
жения управляющих элементов для видео по нажатию в области его действия. 

Теперь, когда все параметры настроены, давайте просмотрим, что у нас получи-

лось. Перейдя на страницу, с которой мы работали, и щелкнув по области с видео, 
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автоматически включается полноэкранный режим и фильм начинает показываться. 

Также обратите внимание на то, что по щелчку в любом месте листа проявляются 

управляющие элементы для управления проигрыванием. Если мы отключим опцию 

Play Full Screen, фильм будет демонстрироваться только в пределах фрейма, в ко-

торый он изначально был помещен. Кроме того, в принципе будет отключена воз-

можность развернуть его в полноэкранный режим. 

Как вы видите, возможность внедрения видео в электронную публикацию — это 

очередной уникальный инструмент для дизайнеров, работающих с электронными 

изданиями, позволяющий им не только разнообразить визуальный ряд для конеч-

ного пользователя, но и предоставить ему значительно больший объем информа-

ции, чем это возможно было бы сделать с помощью простого текста. 
 

Обзор возможностей внедрения Web Viewer 

Одно из самых значимых отличий создания простого интерактивного документа от 

DPS заключается в том, что последний создан, в большей степени, для работы на 

мобильных устройствах. Вы также знаете, что данные устройства, в своем абсо-

лютном большинстве, имеют постоянный беспроводной доступ к сети Интернет. 

Два этих ключевых момента легли в основу одной из самых интересных функций  

в среде Digital Publishing Suite — это Web Viewer, или иначе просмотрщик интер-

нет-контента. 

Этот инструмент дает не просто возможность загрузить внутрь среды публикации 

переменные данные, в реальном времени подгружающиеся из Интернета, но и  

позволяет с помощью стилей регулировать то, как данный контент будет отобра-

жаться. 

В данном разделе мы создадим два различных вида Web Viewer — первый будет 

загружать с помощью скрипта записи из Twitter и отображать их в нужном нам 

стиле. Второй же будет показывать целиком интернет-страницу с контактными 

данными. 

Сразу же отметим несколько ограничений, которые существуют при работе с по-

добными объектами. Во-первых, любое содержимое, которое мы хотим продемон-

стрировать с помощью DPS, загрузив его внутрь публикации, должно свободно 

отображаться в простом браузере и вне публикации на нашем целевом устройстве 

или устройствах. Ну и, конечно же, вы должны понимать, что для просмотра со-

держимого такого типа пользователь обязательно должен быть подключен к Ин-

тернету. Если же этого не происходит, то вместо содержимого читатель увидит 

просто пустое поле. 

Для создания web viewer нам понадобится заготовка в виде фрейма, расположенно-

го в правой части третьей страницы нашей рабочей публикации. С помощью нее 

мы создадим просмотрщик, который будет отображать информацию с использова-

нием локальных стилей. В качестве информации мы возьмем загружаемую из Ин-

тернета Twitter-ленту (рис. 3.12). 
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Рис. 3.12. Вид рабочей области при внедрении интернет-содержимого 

Для начала работы, выделите фрейм-заготовку и откройте палитру Folio Overlays, 

после чего перейдите в режим Web Content. В поле URL or File, в нашем случае, 
следует выбрать локально расположенный HTML-файл, содержащий скрипт для 

загрузки сообщений из Twitter. Вы можете найти его в папке \Подготовка DPS\ 

links\Links\html. Если внутри HTML-файла содержатся ссылки на какие-либо допол-

нительные документы, такие как изображения, PDF-документы и т. д., они обяза-
тельно должны также локально храниться в этой же папке. Кроме того, еще раз об-

ращаю ваше внимание на то, что любой контент, который вы желаете внедрить в 
публикацию, должен быть предварительно протестирован на совместимость с уст-

ройствами, для которых создается данная публикация. Это означает, что если,  
к примеру, вы захотите использовать в качестве Web Content Flash-файлы, данное 

содержимое не будет отображаться на устройствах iPad, хотя на планшетах на базе 

Android и Blackberry OS все будет работать прекрасно. Именно поэтому наш тесто-
вый файл представляет собой простейший HTML-документ, содержащий JavaScript 

для динамической загрузки ленты из Twitter. 

Выравнивание содержимого в фрейме всегда основывается на его левом верхнем 

углу. Это очень важно, т. к. когда вы разрабатываете HTML-содержимое, вы може-
те сделать его масштабируемым в зависимости от размера экрана устройства, на 

котором будет происходить просмотр. Кстати, чтобы включить подобный режим 

масштабирования, следует выбрать в палитре Folio Overlays опцию Scale Content 

to Fit. Этот режим информирует загрузчик онлайн-содержимого о том, что необхо-
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димо убедиться в том, что размер экрана точно соответствует размеру фрейма.  

В противном случае может возникнуть ситуация, когда левый верхний угол, отно-
сительно которого выравнивается весь текст, будет просто скрыт от нас за преде-

лом экрана устройства. 

Если включить опцию Allow User Interaction, пользователь сможет взаимодей- 

ствовать с онлайн-содержимым, например, пролистывать его, использовать раз- 

личные кнопки, ссылки и т. д. Данная опция, кстати, всегда включена по умол- 

чанию. 

Еще одна важная настройка — Transparent Background — позволяет сделать про-

зрачным фон у загружаемой интернет-страницы или же у ее содержимого. Это дает 

возможность придумывать достаточно интересные дизайнерские решения, при ко-

торых внешний контент органично вливается в общую концепцию публикации, за-

даваемую фоном каждой страницы. Опция Auto Play уже хорошо вам знакома  

и выполняет всю ту же функцию автоматической загрузки онлайн-содержимого 

при открытии страницы. После завершения всех настроек вы сможете увидеть ди-

намически загружаемое из сети Интернет содержимое внутри своей публикации 

(рис. 3.13). 
 

 

Рис. 3.13. Вид интернет-содержимого в полученном folio-документе 
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Мы разобрались, как работать с web-страницами, которые загружаются из локаль-

ного HTML-файла. Теперь давайте научимся работать с полностью удаленными 

ресурсами. 

Для этого откройте последнюю страницу публикации, так же выделите фрейм, но 

теперь в разделе Web Content палитры Folio Overlays мы укажем не расположение 

файла, а адрес ресурса, который нужно отобразить. Вы можете набрать здесь URL 

любого известного вам сайта. Настройки остались прежними, и мы не будем вно-

сить в них никаких изменений. 

Когда все будет готово, нажмите кнопку Preview. Сначала перейдем на третью 

страницу публикации и щелкнем по фрейму для загрузки его содержимого. Как ви-

дите, мы можем перемещаться по ленте с помощью мыши и использовать ссылки 

внутри текста. Вы, наверняка, задаетесь вопросом, почему текст так органично 

влился в дизайн публикации. К примеру, почему ссылки, линии-разделители и даты 

окрашены в тот же цвет, что и дизайнерские элементы в издании. Все дело в том, 

что данные для этого берутся из самого HTML-файла, а именно из CSS-таблиц,  

в нашем примере внедренных в сам файл. Они-то и описывают внешний вид каж-

дого из элементов. Далее приведен фрагмент кода (листинг 3.1), предписывающий, 

как должен выглядеть блок с записью из Twitter внутри него. Здесь может указы-

ваться цвет, ширина, поведение и многие другие параметры. 

Листинг 3.1. Фрагмент CSS-кода,  

описывающий внешний вид блока Twitter-ленты 

#twitter_div { 

 background: #eee; 

 width:  255px; 

 overflow: scroll; 

} 

 

Теперь обратимся к последней странице, где мы реализовали загрузку содержимого 

в контейнер из внешнего источника. Если щелкнуть по этой странице, то содержи-

мое загрузится и станет активным. Мы также можем пользоваться ссылками и пе-

реходить прямо здесь в другие разделы сайта. 

Как вы видите, загрузка web-содержимого существенно увеличивает возможности 

для внедрения в нашу публикацию самого разнообразного материала. Однако ни-

когда не забывайте, что, во-первых, необходимо тестировать все содержимое, как  

с локальных, так и с удаленных источников, перед тем, как внедрять его; и, во-

вторых, помните, что web-контент всегда зависит от наличия подключения к Ин-

тернету и корректной работы его поставщика, т. е. портала, с которого данное со-

держимое загружается. При нарушении хотя бы одного из этих условий у вашего 

конечного пользователя могут возникнуть проблемы с просмотром данного содер-

жимого. 
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Обзор функций pan & zoom 

Когда мы занимаемся подготовкой макетов традиционных печатных изданий, мы 

зачастую обрезаем их, т. к. они не помещаются в печатную область. Это лишает 

конечного потребителя данного продукта достаточно большого пласта инфор- 

мации. 

Для мира электронных публикаций эта проблема, как и многие другие, решена.  

И сделано это с помощью еще одной интересной функции в рамках палитры Folio 

Overlays, которая называется Pan and Zoom. 

Давайте научимся создавать и настраивать этот тип объектов. Когда вы работаете 

над pan & zoom, вы должны подумать о нескольких важных вещах. Во-первых, раз-

решение изображения, которое вы планируете внедрить, и будет определять  

максимальный масштаб, в котором возможно его рассмотреть. Pan & zoom, по  

определению, может увеличить изображение только до его 100%-го размера, опре-

деляемого разрешением. Во-вторых, ваше изображение не должно превышать 

2000 пикселов по ширине и столько же по высоте. И наконец, объекты pan & zoom 

не работают с изображениями, в которых присутствуют прозрачные пикселы.  

Никогда не забывайте об этих трех аспектах при работе. Давайте приступим, собст-

венно, к созданию нашего объекта. 

Для начала перейдем к шестой странице публикации, выделим специально приго-

товленный для работы фрейм и с помощью команды File > Place поместим в него 

заведомо большее изображение. Как вы видите, изображение было вставлено в 

100%-м масштабе и автоматически создало "заглушку" по форме фрейма. Мы мо-

жем менять ее положение и масштаб с помощью знакомого нам Content grabber. 

То, как будет выглядеть изображение в этом фрейме, станет также стартовой пози-

цией для его просмотра в режиме pan & zoom. Кстати, если вы хотите выровнять 

размер изображения по размеру фрейма, то можно щелкнуть по нему правой кноп-

кой мыши и из появившегося контекстного меню выбрать Fitting > Fill Frame 

Proportionally. 

После перейдем в палитру Folio Overlays и выберем раздел Pan & Zoom 

(рис. 3.14). Все, что мы можем здесь настроить — это просто выбрать, будет ли 

данная функция активна. После выбора, давайте нажмем на кнопку Preview и по-

смотрим на результат. Как вы видите, все работает. Кроме того, вы наверняка обра-

тили внимание на то, что после щелчка и активации pan & zoom исчезла подсказка, 

находившаяся сверху. Это произошло по той же причине, что и ранее — объекты, 

созданные в Folio Overlays всегда находятся поверх всех остальных. 

Как вы видите, данная функция является очень естественной для электронных пуб-

ликаций и снимает достаточно значительное ограничение, которое зачастую накла-

дывают на нас печатные издания. Для дизайнеров этот инструмент станет очень 

приятным дополнением ко всем широчайшим интерактивным возможностям, кото-

рые предоставляет пакет Adobe Digital Publication Suite. 
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Рис. 3.14. Вид рабочей области и палитры Folio Overlays  
при работе с Pan & Zoom 

Создание и конфигурация элемента  
Scrollable Frame 

В данном разделе мы подробно рассмотрим еще одну немаловажную функцию при 

работе с пакетом Adobe Digital Publishing Suite — Scrollable Frame или создание 

блоков с прокручивающимся или перелистывающимся контентом. Данные блоки 

бывают крайне полезны, когда мы имеем дело с большим количеством текстового 

материала и не хотим разделять его на несколько страниц. С помощью Scrollable 

Frame это становится возможно. 

Для начала работы перейдите на десятую страницу нашей публикации и внима-

тельно изучите ее содержимое. Здесь мы имеем некоторую заготовку, представ-

ляющую из себя заголовочный и обычный текст, изображения и подписи к ним, а 

также фрейм, в который требуется поместить основной текст статьи. Для начала 

нам нужно привести контейнер, в который будет помещено содержимое, в соответ-

ствие с горизонтальным размером самого содержимого, и даже, желательно, сде-

лать этот размер на несколько пикселов больше с одного края для реализации панели 

прокрутки. После этого с помощью палитры Align, которую можно вызвать с ис-

пользованием пункта главного меню Window > Object&Layout > Align, необходи-

мо выровнять содержимое относительно контейнера по верхнему левому краю. За-

тем выделите текстовый блок, который представляет содержимое, вырежьте его  

с помощью команды главного меню Edit > Cut, после чего, выделив контейнер, 

куда вы планируете поместить содержимое, выберите пункт главного меню 
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Edit > Paste Into. Все, что осталось сделать — это открыть раздел Scrollable Frame 

палитры Folio Overlays и настроить поведение прокрутки (рис. 3.15). 

Здесь существует всего три основных настройки. Первая — раскрывающийся спи-

сок Scroll Direction — определяет направление прокрутки. Можно выбрать автома-

тическое определение направления, горизонтальное, вертикальное или оба направ-

ления одновременно, а также и вовсе отключить прокрутку. Следующая опция 

здесь — флажок Hide в группе Scroll Indicators позволяет отключить индикаторы 

прокрутки в итоговой публикации. Под индикаторами понимаются маленькие се-

рые полоски слева и снизу у контейнера, которые показывают место, до которого 

осуществлена прокрутка относительно всего размера помещенного объекта. Нако-

нец, последняя группа настроек раздела Scrollable Frame палитры Folio 

Overlays — это группа переключателей Initial Content Position — отвечает за на-

чальное положение содержимого в контейнере. При выборе переключателя Upper 

Left содержимое будет всегда изначально выравниваться по левому верхнему углу. 

В случае выбора переключателя Use Document Position в качестве начального по-

ложения содержимого в контейнере будет принято текущее взаимное расположе-

ние этих элементов. 

 

Рис. 3.15. Вид рабочей области и палитры Folio Overlays при работе со Scrollable Frame 

Давайте оставим все настройки установленными по умолчанию и посмотрим, на-

жав на кнопку Preview, что у нас получилось. Как вы видите, теперь содержимое 

полученного фрейма не статично, а реагирует на движения мыши, позволяя про-
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кручивать его относительно контейнера, размер и положение которого, вместе 

с тем, остаются неизменными. 

Несмотря на то, что в данном примере мы поместили в контейнер текстовый фраг-

мент, на самом деле, содержимое абсолютно не обязательно ограничено только 

текстом — начиная с версии CS6 это могут быть также изображения, гиперссылки 

и даже кнопки. Так что теперь фантазия дизайнеров в реализации прокручиваю-

щихся объектов практически ничем не ограничена. 

Обзор палитры Folio Builder 

Как мы уже знаем, любая DPS публикация состоит из разделов, объединенных в 

folio, которое, в свою очередь, конвертируется для каждого конкретного устройст-

ва. В данном разделе мы начнем знакомиться с тем, как это делается, и рассмотрим 

несколько важных нюансов, на которые обязательно нужно обращать внимание. 

Для того чтобы начать работу, откройте палитру Folio Builder (рис. 3.16) с по- 

мощью меню Window > Folio Builder. 

 

Рис. 3.16. Вид палитры Folio Builder при первом запуске 

Когда вы впервые попадаете на эту палитру, единственная возможность, которую 

она предоставляет, — это нажать на ссылку Sign In или зарегистрироваться Sign 

Up. Это происходит в связи с тем, что DPS, по сути — онлайн-сервис, а палитра 

Folio Builder является лишь связующим звеном между этим сервисом и пользова-

телем. В случае если вы не приобрели лицензию на работу в DPS, вам предоставля-
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ется возможность работы единовременно только с одним folio, причем без возмож-

ности его размещения на публичных площадках. После того как вы нажмете ссыл-

ку Sign In, программа предложит вам, используя свою учетную запись Adobe ID, 

войти в систему. Если у вас до сих пор нет своей учетной записи, самое время ее 

получить. Это можно сделать на сайте www.Adobe.com. 

 

Рис. 3.17. Вид окна регистрации палитры Folio Builder 

Как только вы зарегистрировались, в палитре Folio Builder будут отображаться все 

folio-документы, с которыми вы работаете. Если до этого момента вы не создали ни 

одного, палитра будет пуста. Для создания нового folio следует нажать кнопку New 

в нижней части палитры либо воспользоваться соответствующим пунктом контек-

стного меню. В процессе создания нового folio вам будет предложено совершить 

определенные настройки для него (рис. 3.18). Во-первых, необходимо задать ему 

имя. Во-вторых, следует определиться с размерами. По умолчанию размер folio  

устанавливается на основе размеров вашего рабочего документа в настоящий мо-

мент. Мы работали с публикацией для iPad, поэтому и выбран был размер экрана 

этого устройства, а именно 1024 768. Кстати, в iPad третьего поколения разреше-

ние уже увеличено до 2048 1536, так что если вы ориентируетесь на людей с дан-

ными устройствами, вы должны понимать, что при установке меньшего разреше-

ния мы заведомо получаем худшее качество, которое будет обязательно заметно 

пользователю. Если же вы откроете раскрывающийся список, то увидите ряд дру-

гих размеров для иных устройств, соответственно. 

Обязательно уточняйте, какое разрешение поддерживают ваши целевые устройст-

ва, и подбирайте соответственно этому вариант в списке Size. Еще один момент, на 

который следует обратить внимание — все изображения и прочие материалы, ко-

торые присутствуют в ваших разделах, вне зависимости от того, с каким разреше-

нием они были импортированы в публикацию, в конечном folio-файле будут пре-

образованы в то разрешение, которое вы укажете в этом списке. 

В этом же диалоговом окне в раскрывающемся списке Default Format вы можете 

выбрать формат изображений, в котором они будут храниться в публикации.  

В случае если вы выберете JPEG, folio будет занимать меньше памяти, однако ка- 
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Рис. 3.18. Вид окна создания нового folio 

 

 

чество изображений ухудшится. PNG даст хорошие показатели качества при доста-

точно большом объеме файла. Что касается PDF, то он нужен, чаще всего для дос-

тижения требований совместимости и для прочих служебных задач. Самый пра-

вильный выбор, который позволит максимально уменьшить объем файла, сохранив 

при этом превосходное качество — Automatic. В следующем раскрывающемся 

списке Default JPEG Quality вы также можете настроить уровень компрессионного 

сжатия изображений. Кроме того, здесь же предусмотрена настройка ориентации 

(Orientation) готового издания. Она может быть вертикальной, горизонтальной и 

содержать одновременно обе ориентации. Так как в нашем издании были преду-

смотрены одновременно и горизонтальная и вертикальная версии, выберем соот-

ветствующую настройку. Последняя опция, представленная здесь — флажок 

Create Local Folio — отвечает за создание локального документа, не предназна-

ченного для последующего экспорта на устройства. 

После того как все настройки будут выполнены, вы можете нажать кнопку OK для 

подтверждения создания folio. Теперь, в верхней части палитры, мы видим, что на-

ходимся внутри нашего folio и готовы приступить к добавлению в него разделов 

нашей публикации. 

В папке ваших рабочих документов \Подготовка DPS\links\Additional Articles, в кото-

рой лежат несколько уже подготовленных разделов. Вы, при желании, можете ис-

пользовать любые свои разделы. Обратите внимание на то, что для каждого раздела 

в его папке в обязательном порядке должны храниться шрифты и ссылки на файлы, 

внедренные в публикацию, такие как изображения, аудио, видео и т. д. 
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Наш порядок следования разделов будет следующим — Cover в качестве обложки, 

University Ad в качестве рекламного блока и 2WheelsGood, являющийся, как бы, 

одной из журнальных статей. 

Существует два вида импорта документов в folio — загрузка уже открытых доку-

ментов и импорт с использованием палитры Folio Builder. Начнем с последнего. 

Для того чтобы импортировать раздел в ваш folio, используйте пункт контекстного 

меню Import. При этом не забывайте, что вы должны находиться внутри вашей 

публикации (об этом свидетельствует надпись Articles в верхней части палитры) 

(рис. 3.19). 

 

Рис. 3.19. Вид окна импорта раздела в folio 

Когда открывается диалоговое окно импорта, первое, что нам нужно сделать — это 

задать разделу имя. Дадим имена соответственно названиям разделов, т. е. первый 

будет называться Cover. Далее следуют уже знакомые нам опции выбора формата 

внутренних изображений и уровня компрессии. Самое последнее поле (Location) 

служит для указания места расположения исходных файлов раздела. Укажем здесь 

папку Cover. Обязательно обратите внимание на то, что в данном случае, когда мы 

загружаем уже готовое содержимое, вертикальная и горизонтальная верстки долж-

ны быть сохранены в разных файлах. При этом один и тот же раздел для верти-

кального и горизонтального расположения обязательно должен называться одина-

ково и отличаться только префиксом в конце названия — _h (horizontal) и _v 

(vertical). Это даст InDesign понять, что он имеет дело с одним и тем же файлом, но 

для разных расположений целевого устройства. На самом деле, наличие двух фай-

лов не обязательно, т. к. при отсутствии одного из них или одной из версток в па-

литре Alternate Layout можно будет изучать публикацию только в одной плоско-
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сти. Кроме вышеперечисленных опций, здесь можно указать Import Multiple 

Articles и указать папку, где расположено сразу же несколько разделов одновре-

менно. Раскрывающийся список Smooth Scrolling позволяет настроить для каждого 

из разделов, будет ли перемещение между страницами плавным и независимым от 

габаритов страницы или же отображение будет привязано к ним. Установите для 

нескольких разделов вашей публикации различные настройки, и, просматривая 

публикацию на конечном устройстве, вы сможете понять, в чем заключается осо-

бенность каждой из них. 

После нажатия кнопки OK палитра Folio Builder отправляет на сервер DPS все ис-

ходные документы, а в обратном пакете получает скомпилированный folio-файл. 

После того как процесс загрузки завершен, мы можем посмотреть на содержимое 

вновь созданного раздела. Как вы видите, InDesign автоматически распознал гори-

зонтальную и вертикальную версии раздела и присвоил им соответствующие име-

на — Landscape Layout и Portrait Layout. 

Второй способ несколько отличается от первого, и если вы имеете все альтернатив-

ные верстки в одном файле, то для вас он будет значительно удобней. Для его реа-

лизации откройте ваш файл в InDesign, как обычный документ, после чего нажмите 

кнопку New — новый раздел будет создаваться на базе открытого в настоящий мо-

мент документа (рис. 3.20). 
 

 

Рис. 3.20. Вид диалогового окна New Article раздела в folio 

 

В открытом диалоговом окне, кроме имени и прочих настроек для раздела, в рас-

крывающихся списках Portrait Layout и Landscape Layout можно указать соответ-

ствующие верстки для горизонтального и вертикального расположения устройства.  
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Рис. 3.21. Вид палитры Folio Builder в процессе загрузки документа 

После нажатия на кнопку ОK и загрузки публикации откройте новый раздел в па-

литре Folio Builder (рис. 3.21). 

Теперь, когда все разделы загружены, вы можете просмотреть каждый из них, вы-

брав его и нажав кнопку Preview. Вы также можете просмотреть всю публикацию, 

перейдя в главный раздел палитры Folio Builder и нажав кнопку Preview. Перелис-

тывая с помощью мыши в левую и правую стороны, мы можем перемещаться меж-

ду разделами. Движения вверх и вниз позволяют нам осуществлять просмотр от-

дельно взятого раздела. Если публикация открылась в слишком большом масштабе 

и не помещается на экране, то с помощью команды главного меню Открыть > 

Уменьшить масштаб программы Adobe Content Viewer мы можем скорректиро-

вать его размеры. Также у нас есть возможность проверить различные ориентации 

публикации с помощью сочетания горячих клавиш <Ctrl>+<R>. 

Еще раз обратите внимание на то, что если у вас приобретен пакет услуг DPS, вы 

сможете создавать больше, чем одну публикацию с помощью палитры Folio 

Builder. В случае же бесплатного использования DPS, количество folio будет огра-

ничено одним, кроме того, вы не сможете использовать их в коммерческих целях, 

т. е. размещать публикации для скачивания или продажи. 

Еще один момент, о котором позже мы поговорим подробней — как только вы соз-

дали конечное folio, и оно появилось у вас в палитре Folio Builder, оно также 

должно автоматически появиться и на вашем устройстве в случае, если у вас уста-

новлено специальное ПО, и вы осуществили вход в него с использованием того же 

Adobe ID, что и в палитре. 
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Возможные настройки folio-документа 

В палитре Folio Builder, с которой мы начали знакомство, существует ряд настроек 

для folio-файла, с которым вы работаете в текущий момент. Для того чтобы разо-

браться с ними, убедитесь в том, что вы находитесь в разделе Folios палитры Folio 

Builder, и после этого выберите из контекстного меню палитры пункт Properties.  

В открывшемся диалоговом окне Folio Properties имеется ряд принципиальных 

настроек (рис. 3.22). Давайте рассмотрим их по порядку. 

 

Рис. 3.22. Вид диалогового окна Folio Properties палитры Folio Builder 

Во-первых, поле Publication Name позволяет нам задать имя для публикации не 

folio-документа, что мы уже сделали ранее, а именно публикации. Это название 

будет появляться как имя всего издания в Adobe Content Viewer на вашем мобиль-

ном устройстве или компьютере. Можете дать вашему журналу любое понравив-

шееся имя. Позже мы сможем увидеть, где оно появится. 

В нижней части данного окна нам предоставляется возможность добавления знач-

ков предварительного просмотра. На самом деле — это единственное место, где 

есть возможность создать данные изображения для того, чтобы вы могли различать 

folio на устройстве не только по наименованию публикации, но и по таким прият-

ным визуальным элементам. Для того чтобы загрузить вертикальное или горизон-

тальное изображение, просто щелкните по значку в виде папки  рядом с панелью 

просмотра в нижней части данного диалогового окна. В папке \Подготовка 

DPS\links\Icons наших рабочих материалов есть некоторые заготовки, в том числе 

предназначенные и для внедрения в этот раздел. Вы можете воспользоваться ими 
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или же подготовить свои. Для примера вертикального расположения можно ис-

пользовать изображение Splash_ios_v.png. Давайте таким же образом загрузим го-

ризонтальное изображение. Для подготовки подобных изображений вы можете как 

сохранить обложку из InDesign, так и создать любое другое изображение. Если же 

вам не понравилось загруженное изображение, его можно удалить, нажав значок  

в форме мусорной корзины , после чего загрузить другое. Флажок Right Edge 

Binding также доступен в данном окне и позволяет добиться в итоговой публика-

ции такого эффекта, как если бы журнал был сброшюрован с правого края. Вы мо-

жете проверить это, нажав кнопку Preview. Перемещение между разделами, как вы 

видите, теперь происходит перелистыванием в другую сторону. После того, как вы 

сделали все требуемые настройки, можно нажать кнопку ОK. 

Если же вы хотите поделиться данным folio с другим человеком, то вы также може-

те сделать это с помощью контекстного меню палитры, на этот раз выбрав пункт 

Share. 

 

Рис. 3.23. Вид диалогового окна Share палитры Folio Builder 

В первой графе открывшегося диалогового окна Share (рис. 3.23) вы можете ука-

зать любой e-mail человека или нескольких лиц, с которым(и) желаете поделиться 

данным folio. У данного адресата, тем не менее, обязательно должен быть свой 

Adobe ID, привязанный именно к данному адресу e-mail, чтобы посмотреть при-

сланную ему публикацию. Кроме того, на устройстве, на котором он планирует 

просматривать данное folio, у него обязательно должен быть установлен Adobe 

Viewer. Данное программное обеспечение имеет полное название Adobe Content 

Viewer и доступно для свободного скачивания с Apple App Store, Android Market и 

Blackberry App World. В нижних графах данного окна вы можете также добавить 

тему и личное сообщение с комментариями. Это очень удобный способ для того, 
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чтобы, скажем, продемонстрировать работу клиенту без необходимости публико-

вать все издание. Как только адресат откроет на своем устройстве Adobe Content 

Viewer, он увидит публикацию, доступную для скачивания и сможет просмот- 

реть ее. 

После того, как мы нажали на кнопку Share, значок рядом с названием folio поме-

нялся на индикатор того, что данная публикация теперь доступна для просмотра 

другому пользователю (рис. 3.24). 
 

 

Рис. 3.24. Вид иконки Shared палитры Folio Builder 

 

Если вы хотите удалить ваш folio-файл, то это можно сделать с помощью пункта 

контекстного меню палитры, который называется Delete, либо же путем нажатия на 

кнопку в виде мусорного ведра в правом нижнем углу палитры. 

Наконец, в этом же контекстном меню вы имеете возможность с помощью пункта 

Rename переименовать folio-файл. Обратите внимание на то, что данное переиме-

нование никаким образом не коснется имени вашей публикации, а просто изменит 

имя пункта в палитре Folio Builder. 
 

Настройки,  
применимые для разделов folio-документа 

Для разделов folio-документа так же, как и для него самого, возможен ряд настроек. 

Для того чтобы начать с ними работать, просто перейдите в раздел Articles палит-

ры Folio Builder. Здесь, так же как и ранее, выделив один из разделов, выберем из 

контекстного меню палитры пункт Properties. В нем мы имеем возможность задать 

так называемые метаданные для каждого из разделов публикации — Title для на-

звания, Description — для краткого описания, Byline — для подписи автора и 

Kicker — для привязки раздела к какой-либо теме, например кулинария или путе-

шествия. Все эти поля крайне желательно всегда заполнять для каждого из разде-

лов. Во-первых, это позволит поисковым машинам быстрее и четче находить ваше 

издание по запросам пользователя. Во-вторых, вся эта информация автоматически 

добавляется в оглавление публикации. А самое главное — данное описание позво-

лит пользователю сразу же определиться, ту ли информацию он нашел. Кроме того, 

аккуратно и полностью заполненные метаданные складывают у потребителя ощу-

щение солидности и достоверности издания. 
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Рис. 3.25. Вид диалогового окна Article Properties палитры Folio Builder 

 

В этом же диалоговом окне (рис. 3.25) вы можете загрузить значок предваритель-

ного просмотра, которая будет появляться рядом с названием раздела в оглавлении 

публикации. 

C помощью раскрывающегося списка Smooth Scrolling можно настроить различ-

ные варианты пролистывания страниц для каждого раздела отдельно. Это может 

быть привязка к каждой странице либо же плавный переход между содержимым. 

Данные варианты можно также по отдельности привязать к горизонтальной или 

вертикальной прокрутке. Если вы хотите ограничить пользователя и оставить толь-

ко горизонтальную прокрутку, то установите флажок Horizontal Swipe Only. 

Здесь есть еще одна крайне полезная опция, которая называется Advertisement.  

Если она выбрана, то данный раздел будет считаться рекламной информацией и не 

будет добавлен в оглавление публикации. Однако если сбросить флажок (снять "га-

лочку" ) Hide From TOC, то в навигационном оглавлении данный раздел все-таки 

появится. Давайте пометим наш раздел University AD, как рекламный. 

Кроме вышесказанного, если мы внесли какие-либо изменения в текущий раздел и 

хотим обновить folio, чтобы сохранить в нем эти изменения, необходимо выбрать 

пункт Update из контекстного меню палитры. Это автоматически загрузит изме-

ненный раздел на сервер DPS, внесет там изменения в folio и сохранит в палитре 

Folio Builder уже измененный файл. Здесь мы также имеем возможность переиме-
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новать и удалить наш раздел. Также тут присутствует еще одна опция — Import,  

о которой мы поговорим немного позже. 
 

Использование онлайн-панели Folio Producer 

Помимо уже хорошо знакомой нам палитры Folio Builder, в состав Adobe Digital 

Publishing Suite входит также онлайн-панель DPS Dashboard, дающая нам несколь-

ко примечательных возможностей. Для ее отображения используется сервис он-

лайн-панели, который называется Folio Producer. В этом разделе мы разберемся, 

как он функционирует и какие возможности нам дает. 

Для того чтобы начать работать с онлайн-панелью, вам потребуется набрать в ад-

ресной строке вашего браузера адрес https://digitalpublishing.acrobat.com/ либо же 

выбрать пункт Folio Producer в контекстном меню палитры Folio Builder. После 

этого следует ввести свой Adobe ID и пароль (рис. 3.26). 

 

Рис. 3.26. Процесс регистрации в системе Digital Publishing Suite 

После открытия DASHBOARD (рис. 3.27) выберите в левой части палитры кнопку 

Folio Producer. Перед вами откроется таблица со всеми вашими folio, а также до-

кументами, которыми с вами поделились с помощью функции Share, предостав-

ляющая, к тому же, некоторые дополнительные возможности. Во-первых, вы може-

те блокировать определенные документы, т. е. запретить вносить в них изменения. 
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Для этого поставьте "галочку" в столбце Locked и строке с нужным folio. В основ-

ном, это нужно, если вы работаете в группе и не хотите, чтобы кто-то другой из 

этой группы вносил изменения в ваш документ. 

 

Рис. 3.27. Главное окно Digital Publishing Suite 

Во-вторых, вы можете опубликовать folio, тем самым включив его в программу 
просмотра, которая находится на устройствах у конечных пользователей. Если оп-
ция Published отключена, внутри программы у пользователей данного folio видно 
не будет. Для того чтобы включить ее, заполните все поля, помеченные в данном 
окне символом * (Folio Name, Publication Name и пр.), и нажмите на кнопку 
Publish в правой части экрана (рис. 3.28). 

Если вы работаете с бесплатной версией DPS, то вы сможете опубликовать ваше 
издание только в статусе Private, т. е. только для личного пользования (рис. 3.29). 
В случае же покупки вами лицензии на использование Digital Publishing Suite, вы 
сможете в раскрывающемся списке Status указать значение Public, тем самым 
обеспечив доступ к изданию всем пользователям, предварительно загрузившим 
приложение. Кроме того, здесь вы можете определить цену для вашего издания, по 
которой пользователи смогут приобрести данный выпуск. Обязательным условием 
публикации является также индивидуальный номер издания — это может быть 
ISBN либо любой другой уникальный номер. Давайте нажмем кнопку Publish и 
после этого в раскрывающемся списке Organizer View (рис. 3.30), расположенном 
в левой верхней части экрана, выберем значение Publish Requests. 

В этой области вы сможете видеть, на какой стадии находится процесс публикации 
вашего издания. Как только он будет завершен, в столбце Status появится сообще-
ние Completed. Это будет означать, что у всех ваших пользователей на их устрой-
ствах теперь есть ссылка для скачивания данной публикации. 
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Рис. 3.28. Главное окно DPS Folio Producer 

 

 

Рис. 3.29. Диалоговое окно Publish Folio в среде DPS Folio Producer 
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Рис. 3.30. Область Publish Requests в среде DPS Folio Producer 

Теперь вернемся обратно в раздел All Folios. Если вы хотите просмотреть содер-

жимое folio-файла, то выделите его и нажмите кнопку Open в верхней части пане-

ли. Как вы видите, теперь можно просмотреть все разделы, входящие в folio 

(рис. 3.31). 

 

Рис. 3.31. Область Editor в среде DPS Folio Producer 

При наведении мышью на каждый раздел мы можем видеть отображающийся блок 

с метаданными, где присутствуют уже знакомые нам поля, такие как Title, Byline, 

Kicker и т. д. (см. рис. 3.31). Чтобы откорректировать данные, щелкните по любому 

из разделов, и в правой части панели вы увидите поля, которые можно исправить. 

Все пункты здесь нам хорошо знакомы по предыдущему разделу, поэтому мы не 

будем на них останавливаться. Для того чтобы удалить folio из списка в Folio 

Producer, выделите его и, щелкнув по маленькому треугольнику в верхней правой 

его части, выберите из раскрывающегося списка значение Delete. 

Здесь же, в левом верхнем углу, вы можете нажать кнопку Add, которая позволяет 

добавлять разделы из другого folio-файла, если он имеется. Это удобно, когда нуж-

но скопировать, скажем, рекламный модуль из прошлого номера журнала. Также 

это может быть использовано в случае, когда непосредственно рекламные агентст-
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ва или дизайнеры делятся с вами своими наработками с помощью функции Share. 

Здесь вы можете их использовать для внедрения в свою публикацию. 

Если вы хотите посмотреть, как ваша публикация будет выглядеть в разных ориен-

тациях, используйте кнопки горизонтального и вертикального просмотра в верхней 

части панели. Дополнительно вы можете изменять размер миниатюр, представлен-

ных здесь с помощью ползунка Thumbnail size. 

Чтобы изменить порядок следования статей или разделов внутри одного folio, вам 

необходимо переключиться в табличный режим просмотра и в самом первом 

столбце с названием Order (рис. 3.32), корректируя цифры, изменить эту последо-

вательность. На самом деле, вы также можете делать это в режиме миниатюр про-

стым перетаскиванием изображений разделов в разные места публикации. 

 

Рис. 3.32. Табличный режим области Editor в среде DPS Folio Producer 

После того как вы сделали какие-либо изменения, вы можете открыть на вашем 

устройстве программу Adobe Content Viewer. Как только вы это сделаете, он неза-

медлительно уведомит вас, что публикация изменена и необходимо скачать новую 

версию. Вы можете загрузить ее и убедиться, что все изменения вступили в силу. 

Именно таким образом работает online-сервис Folio Producer, входящий в состав 

Adobe Digital Publishing Suite. 

Использование панели Viewer Builder 

После того как вы завершили работу над своим folio и опубликовали его, вам нуж-

но подготовить платформу или оболочку для просмотра всего созданного контента. 

Это нужно для того, чтобы пользователь не скачивал Adobe Content Viewer, а имел 
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доступ к "брендированному" приложению, которое бы выглядело для него так, как 

будто это специально написанная программа, представляющая электронную вер-

сию именно вашего журнала. Данная платформа называется Viewer и создается  

с помощью программы, входящей в состав пакета Adobe DPS — Viewer Builder. Ее 

можно загрузить на сайте https://digitalpublishing.acrobat.com/, зайдя с использо-

ванием своего Adobe ID и пароля и щелкнув затем по кнопке Viewer Builder в ле-

вой части открывшегося окна. 

После установки, открытия и повторного введения персональных данных учетной 

записи перед вами откроется окно программы Viewer Builder (рис. 3.33). 

 

Рис. 3.33. Вид окна программы Viewer Builder 

Вы увидите таблицу DPS Viewer Builder, которая предназначена для того, чтобы 

отображать и настраивать все созданные для разных устройств оболочки. Для того 

чтобы создать новый Viewer, нажмите на кнопку New, расположенную в нижнем 

правом углу окна. 

Для создания нового просмотрщика вам в поле Viewer Name (рис. 3.34) потребует-

ся указать его имя, а в поле Exported Folio путь к folio-файлу. Все остальные опции 

являются необязательными. Как вы понимаете, получить данный файл можно толь-

ко в том случае, если вы используете платные услуги сервиса DPS. По-другому по-

лучить данный файл, к сожалению, не удастся. Среди необязательных опций при- 
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Рис. 3.34. Создание нового просмотрщика в программе Viewer Builder 

 

Рис. 3.35. Вторая ступень создания нового просмотрщика в программе Viewer Builder 
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сутствуют настройки внедренных языков публикации, возможности добавления 

доступных элементов управления и некоторые другие. Если вы нажмете кнопку 

Next, то попадете в раздел формирования визуального представления вашего изда-

ния (рис. 3.35). 

Здесь необходимо указать ряд иконок для правильного отображения нашей публи-

кации в среде онлайн-магазинов — распространителей данной продукции. Обрати-

те внимание, что необходимо создавать значки как для iPad версии 1 и 2, так и 

значки с большим разрешением для версии HD. Все, что нам теперь осталось сде-

лать — это нажать кнопку Next и заполнить всю информацию об учетной записи 

Apple App Store. После этого Viewer будет создан и через какое-то время появится 

в магазине App Store. После создания просмотрщика для iPad вы сможете, проделав 

подобные шаги, создать версии для прочих устройств на базе таких платформ, как 

Android и Blackberry OS. 
 

Тестирование folio-файла на платформах iPad, 
Android и Blackberry 

Несмотря на то, что локальное тестирование позволяет выявить большинство про-

блем, которые могут возникать в вашей публикации, наилучшим вариантом для 

пробного просмотра является, конечно, использование целевого устройства, в на-

шем случае планшетного компьютера на платформах iPad, Android или Blackberry. 

В данном разделе давайте остановимся на ряде особенностей, присущих тестирова-

нию DPS-публикации на каждом из этих устройств. Начнем, пожалуй, с самого 

распространенного в мире — iPad. 

Для начала работы необходимо загрузить из Apple App Store бесплатно распростра-

няемую программу Adobe Content Viewer. Когда программа загружена и установле-

на, нажмите кнопку Sign In в левом верхнем углу экрана и введите свои данные 

Adobe ID. После обновления и загрузки библиотеки вы получите сообщение о том, 

что ваш журнал стал доступным для скачивания. Нажмите кнопку ОK, после чего 

щелкните по кнопке Download рядом с миниатюрой обложки журнала. Обратите 

внимание, что здесь представлено два варианта одного и того же журнала. Тот, что 

помечен маленькой голубой лентой с молнией, предоставлен DPS-сервисом. Этого 

можно добиться, опубликовав folio через панель Folio Producer, с которой мы по-

знакомились ранее. Второй же — это тот вариант, с которым мы работаем локально 

на компьютере. Его-то нам и нужно загрузить. После некоторого времени, которое 

потребуется на загрузку контента, станет доступной кнопка View, нажав которую 

вы сможете просмотреть вашу публикацию уже именно такой, какой ее будет ви-

деть конечный пользователь. Здесь, безусловно, присутствуют все возможности по 

перелистыванию, взаимодействию с интерактивными элементами и, конечно же, 

возможность просмотра как в горизонтальном, так и в вертикальном положении, 

конечно, в случае, если данная функция была предусмотрена вами на этапе разра-

ботки издания. Начиная с версии Adobe InDesign CS6, существует еще более про-

стой способ осуществить данное тестирование — просто нажмите на маленький 
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треугольник рядом с кнопкой Preview в палитре Folio Builer и выберите не при-

вычный для нас пункт Preview on Desktop, а пункт Preview on Device. В случае 

если данный пункт не отображается в вашей палитре, то просто подключите ваш 

iPad к компьютеру проводным способом. 

Чтобы протестировать вашу публикацию на устройстве, работающем на Android, 

вам нужно приобрести то же самое приложение Adobe Content Viewer, но уже на 

Android Market. Все функции и расположение управляющих элементов в ней абсо-

лютно такое же, как для iPad. Если вы создавали публикацию в размере 1024×768 

для iPad, то обратите внимание на возможные черные поля в верхней и нижней час-

ти экрана. Это происходит как раз потому, что разрешение и габаритные размеры 

экрана отличного от iPad устройства и самой публикации могут не совпадать. Об-

ратите внимание, что на Android-устройствах видео всегда воспроизводится  

в полноэкранном режиме. Для того чтобы выйти из него, требуется нажать кнопку 

"<", всегда расположенную в левом нижнем углу экрана устройства. 

Аналогично нашей прошлой работе, как с интерактивными документами, так и  

с ePub-публикациями, всегда проверяйте работоспособность абсолютно всех функ-

ций, желательно несколько раз. При тестировании попробуйте представить себя 

конечным пользователем и смоделировать все возможные варианты его взаимодей-

ствия с вашим продуктом, даже самые непредсказуемые. Только это позволит вам 

быть на 99% уверенными в том, что в вашей работе не осталось ни одной ошибки. 

Оставшийся процент можно получить, только позволив еще нескольким людям, не 

знакомым с вашим изданием, поработать с ним на целевом устройстве. Запомните, 

что только такой глубокий и осознанный подход к тестированию позволяет свести 

вероятность технических проблем в публикации к нулю, и, чем серьезней вы будете 

к нему относиться, тем большее удовлетворение получат ваши читатели. 

Как только вы закончили тестирование, публикация считается полностью готовой, 

и вы можете опубликовать ее уже для широкой аудитории через Folio Producer. 

 

 

 



  

 

 

 

 

Заключение 
 

Завершив изучение методик и средств подготовки макетов электронных публика-

ций, хочется подвести черту и напоследок поговорить про настоящее и будущее в 

становлении электронных издательских технологий. 

Компания Adobe Systems представила в 2012 году свою новейшую систему Adobe 
InDesign CS6, которая совершила очередной прорыв в мире электронного издатель-

ского бизнеса. Были добавлены удивительные функции для работы с интерактив-

ными элементами и формами, новейшие разработки в области плавающей верстки 
для разнообразных мобильных устройств. Был существенно переработан интер-

фейс экспорта и инструменты подготовки электронных книг в формате ePub, а так-
же внедрены экспериментальные новейшие форматы, такие как ePub 3 и ePub 3  

с поддержкой фиксированной верстки. Последняя версия решения Digital Publishing 
Suite, сохранив прежний функционал, обрела интереснейшие возможности для соз-

дания и доставки фирменных инновационных приложений, направленных как на 
упрощение доступа к информации для конечного пользователя, так и на реализа-

цию гибкой модели продаж и получения исчерпывающей аналитической отчет- 
ности. 

Благодаря InDesign CS6, формату PDF, Flash HTML5 и решению Digital Publishing 

Suite издательства смогут еще эффективнее создавать контент с фиксированной 
или адаптивной версткой, обеспечивать более высокий уровень интерактивности 

непосредственно из пакета InDesign, тиражировать и продавать цифровые версии 
своих изданий и оптимизировать материалы и рекламу на всех этапах цифровой 

издательской деятельности. 

Одновременно со всеми издательскими инновациями, которые мы уже успели изу-
чить, корпорация Adobe представила в этом году сервис под названием Adobe 

Creative Cloud, который не только позволяет сделать приложения, которые вы ис-
пользуете в своей повседневной работе, более доступными, как с точки зрения лич-

ной работы, так и с финансовой стороны, но и совершила "тихую" революцию, по 
сути, переместив креативный рабочий процесс с жестких дисков персональных 

компьютеров в глобальное креативное пространство. 

Будем надеяться, что все это послужит очередным мощным толчком к дальнейше-
му развитию дизайнерских идей и технологий, в том числе и в издательских систе-

мах, а новые решения помогут сотрудникам рационализировать рабочие процессы 
и позволят создавать высококачественный контент, обеспечивая новые возмож- 

ности для еще более тесного взаимодействия и продуктивной командной работы  
в современных динамичных условиях ведения этого увлекательнейшего бизнеса. 
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ПРИЛОЖЕНИЕ  
 
 
 
 

Описание электронного архива 
 

Электронный архив к книге выложен на FTP-сервер издательства по адресу: 

ftp://ftp.bhv.ru/9785977508605.zip. Ссылка доступна и со страницы книги на сайте 

www.bhv.ru издательства «БХВ-Петербург». 

Структура архива представлена в табл. П.1. 

Таблица П.1. Структура электронного архива 

Папка Описание 

Интерактивность Все материалы, иллюстрации, аудио-, видеофайлы и макеты, на которые 
есть ссылки в главе 1 

Подготовка ePub Все материалы, макеты, иллюстрации и скрипты, к которым есть ссылки 
в главе 2 

Подготовка DPS Все материалы, иллюстрации, аудио-, видеофайлы и макеты, на которые 
есть ссылки в главе 3 
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